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What’s new
in Persuasion 3.0

Persuasion 3.0 is easier to learn and use

• Run the online tutorial to view Persuasion’s features and functions in action.
• Add text and charts to slides using prompt text and placeholders.
• Use icons, buttons, and menus to navigate more quickly between slides and

views.
• Find features more easily using the restructured menus.
• Use context-sensitive online Help whenever you need more information.

Persuasion 3.0 has been redesigned to make you more productive

• Manipulate text and graphics using floating palettes.
• Precisely align objects using ruler guides and nudge controls.
• Kern letter pairs automatically.
• Edit and customize arrowheads and other endcaps.
• Add notes and sketches to Player files during a presentation.
• Edit text, graphics, and spreadsheets in your presentations using the

applications they were created in (OLE).
• Check your spelling beyond standard English with multiple dictionaries,

including legal and medical English (Power Macintosh only; dictionaries sold
separately).

• Work with colors in six different color systems (standard (RGB), grayscale,
inverse grayscale, black-and-white, NTSC video, PAL video).

• Import color palettes from other presentations.
• Choose from a variety of professionally-designed AutoTemplates.
• Enhance your presentations with selections from over 500 pieces of clip art.
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Persuasion 3.0 has powerful charting and table capabilities

Persuasion 3.0 turns on-screen presentations into multimedia experiences

Persuasion 3.0 offers a true multiplatform environment

• Create and format charts and tables using Adobe Chart and Adobe Table,
and OLE-embed them in Persuasion.

• Present your data in 2d and true 3d charts.
• Get the exact look you want by using 3-axis rotation and movement,

zooming, panning, and perspective control.
• Choose from among approximately 80 chart types and preview the types

before you select one.
• Assign value labels to pie charts.
• Use dashed or dotted lines in line charts.

• Set timing and transition effects for each layer and slide individually.
• Incorporate sound, animation, and video into your presentations.
• Jump from one slide to another, from one presentation to another, and

even from a presentation to another application.
• Apply automatic highlighting and layering to text and organization charts.
• Use the Player to take your multimedia presentations on the road.

• Move easily between the Macintosh and Windows environments.
• Transfer presentations and AutoTemplates (including all masters) between

the Macintosh and Windows.
• Save QuickTime movies and sounds in a Player file and replay them on any

computer with the Player and QuickTime installed.
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Before you install Persuasion 3.0:
• Record your serial number and, if

you’re installing Persuasion for the
first time, send in your registration
card to take advantage of Adobe’s
technical support services and to
receive advance notice about
upgrades.

• Make backup copies of your
installation disks. Name each
backup disk the same name as the
original, copying capitalization,
spelling, and spacing exactly.

Where to find your serial number.
If you’ve purchased Persuasion for
the first time, your serial number is
on the bottom of the Persuasion box

For more information
Installing Persuasion 3.0 ........................ 8

If you’re upgrading ................................ 6

Before you install
Persuasion 3.0

or on installation disk 2. You’ll also
find serial number stickers on your
registration card. If you’re upgrading
to Persuasion 3.0, your serial number
is the same as it was for the earliest
version you purchased.

If your computer is connected to a
local-area network, the ReadMe file
has essential information about
Network Copy Detection (NCD) and
special installation instructions. Do
not attempt to install and use the
program on a network computer
before reading the ReadMe file.

Insert a blank, high-density disk in
any drive on your computer, and
then choose “Eject Disk” from
the Special menu.

Insert a program disk and drag its
disk icon over the icon of the
blank backup disk.

Insert disks as requested.

Repeat steps 1 through 3 for each
installation disk.

Note: Your backup disks must have the same names and contents as the
original Persuasion disks.

To make backup copies of your installation disks
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Hardware and software requirements

Component Macintosh Power Macintosh

Computer 68030-based + (Macintosh SE 30 or higher) Any Power Macintosh

Hard disk approximately 11-33 MB1 approximately 11-33 MB1

Disk drives high density high density

Available RAM 5 MB + 16 MB + (virtual memory off)

Operating system System 72 System 7.1.2 or later

Output device driver at least one Chooser driver (for example: at least one Chooser driver (for
LaserWriter, film recorder) example: LaserWriter, film recorder)

Other software QuickTime, Adobe Type Manager, QuickTime, Adobe Type Manager,
or TrueType fonts or TrueType fonts

1Depending on what you install.
2Persuasion 3.0 runs under System 6 (version 6.0.4 or higher) on computers with at least 5MB of RAM, but OLE, Adobe Chart, and
Adobe Table are not supported. Animation, video, and sound work on all color Quickdraw computers (the Macintosh SE, Classic,
Plus, and Powerbook 100 are not color Quickdraw computers).
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If you’re upgrading

If you’re upgrading from an earlier
version of Persuasion, there are some
things to consider before installing
version 3.0.

You’ll need a serial number to
install Persuasion 3.0. The serial
number for your new version is the
same as the serial number for the
earliest version you purchased. Look
for the serial number on the bottom
of the box the earliest version of your
software came in.

If you frequently use a default
AutoTemplate you designed in an
earlier version of Persuasion, you may
want to continue using it after you
install Persuasion 3.0.

If you keep earlier versions of
Persuasion on your hard disk:
• Keep separate folders for each

version and give them different
names.

• Leave the “Aldus folder” folder in
your System folder because it
contains the default AutoTemplate
and dictionary files that your
earlier version of Persuasion uses.

• Replace the Persuasion 3.0
spelling dictionary with spelling
dictionaries you customized in
earlier versions (not available with
Power Macintosh).

• Save disk space by deleting clip art
and presentations you no longer
need.

If you remove earlier versions of
Persuasion from your hard disk:
• Install Persuasion 3.0 before you

remove the earlier version.
• Copy to another folder or floppy

disk any AutoTemplates, clip art,
presentations, or customized
spelling dictionaries you want to
keep.

• Discard the Persuasion application
folder for the earlier version.

• Discard the “Aldus folder” folder
from the System folder (do not
discard the “Aldus” folder since
other Adobe applications use it).

For more information
Before you install Persuasion 3.0 ........... 4

Converting files created in previous
versions ............................................... 10

Installing Persuasion 3.0 ........................ 8

Save Persuasion 3.0 files as
earlier versions .................................... 11



CHAPTER 1: GETTING STARTED WITH PERSUASION 3.0 7

Find the file called “Persuasion Prefs” in
the “Aldus folder” folder in the System
folder and rename it “Default
AutoTemplate.”

Move the renamed file into the
Persuasion Support folder in the
Persuasion 3.0 application folder and, in
the message box, click “OK” to replace
the Persuasion 3.0 default AutoTemplate.

In Persuasion 3.0, open “Default
AutoTemplate” to convert it to a
Persuasion 3.0 AutoTemplate, and
then save it as an AutoTemplate.

Tip: To keep both the earlier and the Persuasion 3.0 default AutoTemplates, name the earlier file something other than
“Default AutoTemplate” before moving it into the Persuasion Support folder in the Persuasion 3.0 application folder.

To replace the Persuasion 3.0 dictionary with an earlier customized one (not available with Power Mac)

Move the “user1” file from the Persuasion Dictionaries folder
in the “Aldus folder” folder in the System folder into the
Spelling folder inside the Persuasion Support folder in the
Persuasion 3.0 application folder.

To use the default AutoTemplate from an earlier version

In the message box, click “OK.”
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For more information
Before you install Persuasion 3.0 ........... 4

Decide how new presentations
will look .............................................. 42

If you’re upgrading ................................ 6

AutoTemplate Guide

Installing Persuasion 3.0

To ensure that there are no conflicts
with any extensions when you install
Persuasion, you should restart your
computer with extensions off, as
described in step 1 on the following
page. It’s also a good idea to turn off
any virus protection utilities. (Remem-
ber to turn these utilities back on
after you complete installation.)

During installation, you have the
option to install all components or
install a certain selection:
• You can have the Persuasion 3

Installer/Utility automatically install
everything (Complete).

• You can have the Persuasion 3
Installer/Utility automatically install
the basic components you need to
run Persuasion and create tables
and charts (Basic).

• You can select which components
you want to install.

The number of components you
choose depends upon how much
hard disk space you have, and how
you intend to use Persuasion 3.0.

Persuasion 3.0 installation components

Option Hard disk requirements Files Installed

Complete approximately 33 MB Persuasion 3.0
Player*
Adobe Chart
Adobe Table
all AutoTemplates
clip art
Tutorial
Spelling dictionaries

Basic approximately 11 MB Persuasion 3.0
Player*
Adobe Chart
Adobe Table
three AutoTemplates
Tutorial
Spelling dictionaries

Custom variable Any combination you check from
the components listed separately.

*The Persuasion 3 Installer/Utility installs the Player for the Macintosh. In addition,
disk versions of both the Players for the Macintosh and Windows are included with
your Persuasion 3.0 software.
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To install Persuasion 3.0

Insert disk 1 into any floppy drive, and
double-click the Persuasion 3 Installer/
Utility icon.

While restarting your computer, press
and hold down the Shift key until you
see your Macintosh say “Extensions
off.”

Select the components of Persuasion
you want to install, then follow the
instructions on the screen.

When installation is complete, you must
rebuild your desktop in order for Persuasion
to run.  To rebuild the desktop, hold down
the Command and Option keys as you
restart your computer.
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Converting files created in
previous versions

In Persuasion 3.0, when you open
presentations and AutoTemplates
created in earlier versions of
Persuasion, you convert them to 3.0
files. A converted file is untitled. Save
it under a new name to keep a copy
of the file in its original version.

If you remove earlier versions of
Persuasion from your hard disk, files
created in these versions will appear
as generic documents. You won’t be
able to open them by double-clicking
their icons, but you can open them
from within Persuasion 3.0 or by
dragging them onto the Persuasion
3.0 icon.

When you convert a file, most of its
features won’t change. For example,
colors and the names of slide masters
stay the same. Charts and tables also
look the same as they did in earlier
versions until you modify them within
Persuasion 3.0.

When you click a converted table to
modify it:
• The data sheet, which is no longer

necessary, is lost, but the table
data is retained.

• Table appearance may change as
the table converts to Adobe Table
format.

When you click a converted chart to
modify it:
• The chart type, size, and colors

stay the same.
• The data used in the chart

converts to an Adobe Chart data
sheet.

• Overlays convert to the same chart
type as the rest of the chart.

• You may need to reapply or
reformat the chart title and
legends.

For more information
Adding a chart to your slide ................. 94

Adding a table to a slide .................... 110

If you’re upgrading ................................ 6
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For more information
If you’re upgrading ................................ 6

Save Persuasion 3.0 files as
earlier versions

You can save Persuasion 3.0 presen-
tations and AutoTemplates so they
can be opened in any earlier version.

Because Persuasion 3.0 includes
features not available in earlier
versions, when you save your files to
an earlier version, these features are
not retained:
• Autojumps, automated high-

lighted layers, animation, and
transition sounds

• Ruler guides and zero point
settings to anything other than
the upper left corner

• Custom line endcaps and hairline
rules

• Auto kerning
• Graduated fills other than top to

bottom, left to right, and radial,
and some patterns

• Title, page numbers, and any slide
thumbnails beyond six on handout
masters

• Text and object shadow offsets
and some text shadow colors and
object shadow patterns and
backgrounds

• Custom slide and layer transition
times and custom layer visual
effects

• Chart data sheets and placehold-
ers (charts and tables are con-
verted to PICT graphics)

• Links to the source applications of
OLE-embedded objects

• Color systems other than standard
(RGB). All color systems convert to
standard for display and output.

Locate the folder or disk where
you want to save your file, select
either “Presentation” or
“AutoTemplate,” type a name for
your file, and click “Save.”

In the dialog box, select the
version of Persuasion in which you
want your file saved in the
“Format” popup menu.

Choose “Save as…” from the File
menu.

To save Persuasion 3.0 files as earlier versions:
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Three steps to a
presentation

Step 2 Enter content

Step 3 Proof and save

Decide what your final output will be (for
example, 35mm slides or an on-screen
presentation) and how you want your
presentation to look.

Step 1 Choose your final output and design

Next, add text and graphics to your slides.

Save your work frequently, and when
you’ve finished your presentation, proof it
to make sure the content and the design
are accurate.

Click here for titleClick here for title
Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

          Commodo consequat

          Duis Autem vel

     Nimbus

          Caelum Aether

          Iriure dolor in hendrerit

          Velit esse consequat

          Dignissim qui praesent

     Reipublicae forma

          Praefectus

               Rector

               Eques

     

4    

5    

   

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Presentation • Outline

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Presentation • Sorter
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To choose your final output and design

In the open dialog box, locate and
open the AutoTemplates folder in the
Persuasion 3.0 application folder, and
then open the folder for the final
output you want.

Choose your final output
and design

Check “Show” to preview the
AutoTemplates, and then click “Open”
to open a copy of the AutoTemplate
you select.

If you choose 35mm slides as your
final output, you need to select a film
recorder as the output device in the
Chooser and/or enter custom slide
dimensions in the “Presentation setup”
dialog box.

For more information
Design and format with
AutoTemplates .................................... 40

Setting up for 35mm output ............. 204

AutoTemplate Guide

Your output choices are overheads,
35mm slides, or screen (on a
computer monitor or projector). Your
design choices are unlimited.

Whenever possible, choose your final
output before you design your slides.
Since output determines slide
dimensions, if you design your slides
first and then change your output,
you may have to rearrange your
content to accomodate a larger or
smaller slide size.

By providing you with a variety of
AutoTemplates, Persuasion makes it
easy to choose a design suited to
your final output. Each AutoTemplate
is formatted for a particular output
and comes with design decisions
(such as text formatting and place-
ment) already made.

Double-click the Persuasion 3.0 icon,
and then click the “Open presenta-
tion...” button on the Persuasion 3.0
startup screen.
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Enter content

To enter text on a slide

Click the prompt text and type the
title, subtitle, and body text on your
slide.

Note: To turn off prompt text, choose
“Placeholder” from the Show menu,
and then uncheck “Prompt text” and
“Boundaries” in the submenu. Even
when prompt text is visible on your
slides, it doesn’t show up during a
slide show.

For more information
Adding a chart to your slide ................. 94

Adding a table to a slide .................... 110

Drawing basics .................................... 80

Enter text in the outline or on slides ..... 48

Outline your presentation to
save time ............................................. 62

Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

Nimb

Tip: The fastest way to enter text is
to use Persuasion’s outline. Text

you type in the outline appears as
title, subtitle, and body text on

your slides formatted as defined on
slide masters. To enter text in the

outline, click the outline icon in the
upper-right corner of the slide.

To add a new slide

Display the slide you want the
new slide to follow.

Click the “New slide” button in
the lower-left corner of the
window.
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To put a graphic on your slide

Choose “Import” from the File menu,
and then choose “Graphics…” from
the submenu.

Tip: You can also use Persuasion’s
drawing tools and color palette to
create your own graphics.

In the dialog box, select the graphic you
want to import and click “Import.”

Click the Chart tool in the tool palette,
and then draw a rectangle on your slide
the size you want your chart to be.

In the new chart dialog box, click the
chart type you want from the Standard
gallery, and then click “OK.”

In the Adobe Chart window, click the
data sheet button in the control
palette.

In the data sheet, enter your data over the sample data, clear
any extra sample data, and then choose “Edit chart” from the
Edit menu.

Choose “Quit and return to untitled Adobe chart…” from the
File menu to exit Adobe Chart, and then click “Update” in the
alert box to view the chart on your Persuasion slide.

AdvolareAdvolare

To put a chart on your slide

AdvolareAdvolare



18 ADOBE PERSUASION 3.0 USER MANUAL

Proof and save

Proof your design and slide order

• View thumbnails of your slides.

• See both slide content and design.

• Rearrange and delete slides easily.

• Apply different slide masters.

By proofing your presentation, you
can discover errors in spelling,
punctuation, and syntax, organiza-
tion, and design. Persuasion offers
you three ways to proof. Each way
gives you a different perspective on
your presentation.

For more information
Checking your spelling ........................ 61

Edit your presentation in the
slide sorter .......................................... 38

Outline your presentation
to save time ........................................ 62

Preparing your on-screen
presentation ...................................... 178

“Save and proof” in Online Help

Go Fly a Kite

Go Fly a Kite Go Fly a Kite Go Fly a Kite

Go Fly a Kite

Tip: If you want Persuasion to
remind you to save, choose

“Preferences” from the File menu,
check “Save reminder” in the
“Preferences” dialog box, and
specify the number of minutes

between reminders.



CHAPTER 2: THREE STEPS TO PREPARING A PRESENTATION 19

Proof your content and organization

Preview your on-screen presentation

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• View and edit your presentation text.

• Edit and reorganize the content of
your whole presentation or an indi-
vidual slide.

• Add or delete slides easily.

• View your on-screen presentation as
your audience will.

• See animation, autojumps, layering,
movies, sounds, and transition effects
in action.
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Chapter 3: Working on the Slide Level
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Picturing Persuasion

How information gets on a slide

a Slide: Where you enter content and
what your audience actually sees.

b Slide master: Define the formatting
and placement for text and charts that
appear on slides.

c Outline: Quickly enter and edit text
that appears on slides.

d Background: Design backdrops for
your presentation.

Persuasion presentations are collec-
tions of slides that are viewed as
overheads, 35mm slides, or on-screen
slide shows. Each slide that the
audience sees is actually a composite
of information, not all of which exists
on the slide itself.

For example, you define design and
formatting information on back-
grounds and slide masters rather than
on individual slides. This allows you to
do time-consuming work only once
and then repeat the results through-
out your presentation.

You can enter your presentation
content on slides or in an outline. If
you prefer to work visually, enter your
content on slides where you’ll
immediately see how your presenta-
tion will look. If you prefer to focus
first on what you want to say, enter
text into the outline and look at your
slides when you’re ready to concen-
trate on design.
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•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.

                    

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.
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• Dignissim qui praesent
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a

b

c

d

For more information
Format slide content with
placeholders ........................................ 28

Outline your presentation
to save time ........................................ 62

Understanding the parts of a slide ....... 25

Working with slide masters and
backgrounds ....................................... 26
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Backgrounds and slide masters

Give your presentation a consistent look
by assigning a background to several slide
masters.

Outlines, slide masters, and slides

Text you type in the outline takes on the
formatting defined by the slide master
when it appears on your slides.

Slide masters and slides

This is a Title PlaceholderThis is a Title Placeholder This is a Title 
Placeholder
This is a Title 
Placeholder

This is a Title PlaceholderThis is a Title Placeholder This is a Title PlaceholderThis is a Title Placeholder

This is a Title Placeholder
This is a Title Placeholder

This is a Subtitle Placeholder
This is a Subtitle Placeholder

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.

                    •  S
lides will follow…

                         
 in kind.

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.

                    •  S
lides will follow…

                         
 in kind.

Go Fly a Kite Go Fly a KiteGo Fly a Kite

Go Fly a Kite Go Fly a KiteGo Fly a Kite

Go Fly a Kite Go Fly a KiteGo Fly a Kite
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Define once on a slide master how text
and organization charts will be formatted
and assign the slide master to one or
many slides to repeat the formatting
throughout your presentation.
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AutoTemplates are collections of backgrounds and slide masters

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
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Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Presentation • Sorter

The slide sorter is Persuasion’s light table

Rearrange, copy and paste, or delete slides, and assign slide masters to them.

Slides reflect the design from the background and the formatting from the slide master.

This is a Subtitle Placeholder
This is a Subtitle Placeholder

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.
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This is a Title Placeholder
This is a Title Placeholder

Title PlaceTitle Place
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Background

Slide master

For more information
Design and format with
AutoTemplates .................................... 40

Edit your presentation in the
slide sorter .......................................... 38

Understanding the parts of a slide ....... 25

Working with slide masters and
backgrounds ....................................... 26

AutoTemplate Guide

From slides to
presentations

When you’re entering the content of
your presentation, you work with one
slide at a time. At some point,
however, you’ll need to bring all of
your slides together to form a
cohesive presentation. Use an
AutoTemplate to give all of your
slides a consistent look. Use
Persuasion’s slide sorter to view and
work with all or several of your slides
at once.
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Anatomy of a slide

A Identifies what you’re seeing on the
screen.

B Displays a particular slide, your notes
about a slide, your presentation as an
outline,  or miniatures of all of your
slides at once.

C Formats text you type according to
the style defined on the slide master.

D Tools for choosing line thickness and
for choosing and editing endcaps
(display by choosing “Lines” from
the Show menu).

E Tools for moving objects, text, and
shadows incrementally (display by
choosing “Nudge” from the Show
menu).

F Popup menu for placing selected
text and graphics on different layers
and assigning transition effects and
sounds.

G Lists the slide masters you can assign
to the slide.

H Creates a new slide formatted like
the slide displayed.

I Displays the next or previous slide.

J Tools for adding color and patterns
to text and graphics.

K Tools for typing text, drawing graph-
ics, or putting charts or tables on
slides.

L Tools for formatting text and con-
trolling alignment and spacing be-
tween paragraphs.

C

D

E

FGHI

K

J

AL

Understanding the parts
of a slide

When you open an AutoTemplate
that comes with Persuasion or create
a new presentation, the first thing
you see is a slide. Use the slide’s tools
and menus to add text, graphics,
special effects, and transitions.

For more information
Layering slides ................................... 156

Picturing Persuasion ............................ 22

Transition effects for slides
and slide layers .................................. 164

Working with slide masters and
backgrounds ....................................... 26

B
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Working with slide masters
and backgrounds

Each presentation you develop can
use multiple slide masters and
backgrounds. The AutoTemplates
that come with Persuasion 3.0 each
have one background and several
slide masters. You can modify the
background or design additional
backgrounds to create several
backdrops within one presentation.

Each slide master in the
AutoTemplates that come with
Persuasion is designed for different
content.
• Use the title slide master, for

example, to create a title slide for
your presentation.

• Assign the text slide master to
slides containing the main body
of text.

• Assign the chart slide master to
slides containing charts.

If none of the slide masters suits your
particular slide content, you can
modify an existing one, create a new
one from scratch, or bring one in
from another presentation or
AutoTemplate.

To display a slide master or background

Choose “Slide master” or “Back-
ground” from the View menu, and
then choose a slide master or
background from the submenu.

Tip: To view thumbnails of your slide
masters before you assign them,
choose “Gallery…” from the master
menu at the bottom of the window.

To assign a new background to a slide master

Choose the background you want to
assign from the background menu at
the bottom of the window.

Display the slide master whose
background you want to change.

Note: The background orientation (tall or wide) controls the orientation of the
slide master. When a new background changes the slide master’s orientation,

the “Adjust graphics” dialog box is displayed so you can move or scale elements
on the slide master to fit the new shape.

This is a Title Placeholder.This is a Title Placeholder.

• This is a text placeholder.
• Change the font and style for each level.

• Resize and reposition the box.
• Change tabs and indents

• Slides will follow...
• in kind.

• This is a text placeholder.
• Change the font and style for each level.

• Resize and reposition the box.
• Change tabs and indents

• Slides will follow...
• in kind.

This is a Subtitle Placeholder.This is a Subtitle Placeholder.

For more information
Creating new slide masters and
backgrounds ....................................... 34

Creating tall slides ............................... 36

Design and format with
AutoTemplates .................................... 40

Outline a presentation to save time ..... 62

Using slide masters from other
presentations ...................................... 30
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To assign a new slide master to a slide

Tip: To assign a slide master to several
slides at once, work in the outline or
slide sorter where you can select more
than one slide at a time.

Display a slide master or background,
and then choose “Define masters…”
from the Master menu.

In the “Define masters” dialog box, select
a slide master or background to rename
or remove.

Type a new name or click “Remove,”
and then click “OK.”

To rename or remove a slide master or background

Choose the slide master you want to
assign from the middle popup menu at
the bottom of the window.

Display the slide whose slide master
you want to change.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
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• This is a text placeholder.
• Change the font and style for each level.

• Resize and reposition the box.
• Change tabs and indents

• Slides will follow...
• in kind.

• This is a text placeholder.
• Change the font and style for each level.

• Resize and reposition the box.
• Change tabs and indents

• Slides will follow...
• in kind.

This is a Subtitle Placeholder.This is a Subtitle Placeholder.
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Format slide content with
placeholders

Placeholders on slide masters create formatted prompt text on slides

Text you type in the outline is formatted and positioned by placeholders on slide
masters and replaces the prompt text on your slides.

You put placeholders on slide masters
to define the position, style, size, and
color of text and organization charts
on your slides. You also use place-
holders to define the position and
size of charts. Placeholders add con-
sistency to your presentation because
text and organization charts format-
ted according to placeholders carry
the same formatting throughout the
presentation and charts appear in the
same location on each slide.

You can put several different
placeholders (such as title, body text,
and chart) on one slide master, but
you can add only one placeholder of
each type. For example, you can add
only one body text placeholder per
slide master. (Each body text place-
holder allows for six heading levels
and each heading can be formatted
independently.)

Page number placeholders can be
added either to slide masters or
backgrounds.
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Outline text

Placeholder text

For more information
Adding an organization chart ............ 106

Controlling the direction of text flow ... 58

Entering text in the outline .................. 64

Format slide text on the slide master .... 50



CHAPTER 3: WORKING ON THE SLIDE LEVEL 29

To modify a placeholder on a slide master

To add a placeholder to a slide master

Choose “Slide master” from the View
menu, and then choose a slide master
from the submenu.

To reposition a placeholder, select it
and then drag it to a new location.

To resize a placeholder, select it and
then drag a handle in or out.

To change a placeholder’s font,
style, shadow, or color, select the
placeholder or the specific text you
want to change, and then select the
options you need from the text and
color palettes.

Tip: Only add placeholders from the
Master menu. If you copy a placeholder
from one slide master and paste it on
another, it becomes a block of
independent text.

Choose a placeholder from the Master
menu.

This is a Title Placeholder.This is a Title Placeholder.

This is a Subtitle Placeholder.This is a Subtitle Placeholder.

This is a Subtitle Placeholder.This is a Subtitle Placeholder.

This is a Title Placeholder.This is a Title Placeholder.

This is a Subtitle Placeholder.This is a Subtitle Placeholder. This is a Subtitle Placeholder.This is a Subtitle Placeholder.

This is a Title Placeholder.
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Using slide masters from
other presentations

When you add slide masters with the
same names as your current ones,
Persuasion renames the slide masters
you’re adding by including an
extension (such as Text.0). Adding
slide masters doesn’t replace a
presentation’s color scheme or slide
shape. Instead, the added masters’

color scheme approximates their
original color scheme and their slide
shape becomes the slide shape of the
presentation they’re added to.

Imported slide masters carry their
backgrounds with them. Give unique
names to backgrounds you want to
preserve before you replace a
presentation’s slide masters.

You may have a slide master or set of
masters in another presentation or
AutoTemplate that would be ideal in
the one you’re working on. In this
situation, import the slide masters
instead of creating new ones.

You can replace a presentation’s slide
masters with those from another
presentation or AutoTemplate; or,
you can add one or more slide
masters to the current ones.

When you replace slide masters, only
those with names that match the
imported ones will be replaced. To
preserve a slide master you’ve
customized, give it a unique name
before you import the new ones.
When you replace a presentation’s
slide masters, you also replace its
color scheme, slide shape, prefer-
ences options and Show menu
options (except the color system and
floating palette settings.)

Bringing in slide masters of a different shape

C
D

To replace or add a set of slide masters

Choose “Change design” from the File
menu, then choose “Replace mas-
ters…” or “Add masters…” from the
submenu.

In the dialog box, select the presenta-
tion or AutoTemplate with the slide
masters you want to use, and then click
“Import.”

Check options A, B, C, and D so that background colors, patterns, and graphics will
fit properly in the new slide shape.

B

A

For more information
Creating a new color scheme ............ 126
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To add one or several slide masters

Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite

If the slide masters you’re bringing in
are not the same shape as your current
ones, use the “Adjust graphics” dialog
box to move or scale objects to fit into
the new slide shape.

Delete the extra slides you added in (the
slide masters assigned to the slides
remain) and assign the current back-
ground to the new slide masters.

Open the presentation you want to add
the slide masters to, choose “Slide
sorter” from the View menu, and then
choose “Paste” from the Edit menu.

In the slide sorter, select slides that use
the slide masters you want to add, and
then choose “Copy” from the Edit menu.

Open the file you want to copy the
slide masters from, and then choose
“Slide sorter” from the View menu.

Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Tip: If you scale objects to fit into a
new slide shape, review the scaled
slide masters in actual size to make
sure all objects are correctly placed.
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Model a slide master after
a slide you like

The “Choose master elements” dialog box

A The slide you want to model a slide
master after.

B Creates a slide master from the dis-
played slide.

C Lists the slides you can model a slide
master after.

D When checked, the new slide master
is assigned to the listed slide.

E Models a placeholder after selected
text.

F Shows what status is assigned to
which object.

G Hides objects that won’t appear on
your new slide master.

H Prevents a selected object from ap-
pearing on the new slide master.

If you design a slide you particularly
like, you can repeat its design on
other slides by modeling a slide
master after it.

When Persuasion creates a slide
master from a slide, it replicates the
slide’s background fill and pattern on
the slide master. You can select
graphics and independent text from
the slide and copy them onto the
slide master. You can also convert the
placeholder and independent text
from the slide into slide master
placeholders.

F

E

G

H
D

A

B
C

For more information
Creating new slide masters and
backgrounds ....................................... 34

Working with slide masters and
backgrounds ....................................... 26
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To create a slide master from a slide

In the preview box, select the text you want for the Title
placeholder, and then click “Title.” Repeat for each place-
holder or object you want to add to your slide master.

In the “Choose master elements” dialog box, select the slide
to model the slide master after, and then click “Create master
from this slide.”

Choose “Slide master” from the View menu, and then choose
“New…” from the submenu. In the “New slide master” dialog
box, name your new slide master, choose the slide master you
want to base it on, and then click “OK.”

Choose “Re-create from slide…” from the Master menu.

Use the “Show” buttons and the “Hide ignored items” button
to see how your slide master will look, and when you’re
satisfied, click “OK.”

Select each object you do not want on your slide master, and
click “Ignore.”
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Creating new slide masters
and backgrounds

A When checked, the slide master
takes its background fill from the
background.

B Applies a solid color or a pattern to
the background fill.

C Applies color to the black part of the
pattern.

D Applies color to the white part of the
pattern.

C

B
A

D

Assigning background fill

To create a copy of a slide master or background to modify

Choose “Slide master” or “Back-
ground” from the View menu, and
then choose “New…” from the
submenu.

In the “New slide master” or “New
background” dialog box, choose the
slide master or background you want
to modify from the “Based on” popup
menu.

To design a new AutoTemplate, or to
customize a presentation (for
example, by making some of your
slides tall rather than wide), you may
need to create new slide masters and
backgrounds. To create new slide
masters or backgrounds, you can
either modify existing ones or create
new ones from scratch.

Modify existing slide masters and
backgrounds by adding text, drawing
or importing graphics, assigning a
different background fill, or adding,
deleting, or editing placeholders. If
you modify the original slide master
or background, you’ll also modify all
the slides to which the originals are
assigned. To avoid modifying slides,
make a copy of a slide master or
background before you modify it.

Type a name for the copy of your slide master or background, and click “OK.”

For more information
Creating tall slides ............................... 36

Designing new AutoTemplates ............ 44

Use a layout grid for
precise alignment ................................ 92

Working with slide masters and
backgrounds ....................................... 26

Tip: To easily line up objects on
separate slides in the same position,
drag guides onto a new background

you create. If the guides aren’t
visible, choose “Guides” from the

Show menu, and then check “Show
guides” on the submenu.
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To create a new slide master

To create a new background

Choose “Slide background fill…” from the Master menu,
choose the patterns and colors for your background fill, and
click “OK.”

In the “New background” dialog box, type a name, choose
“None” or an existing background in the “Based on” popup
menu, select an orientation, and click “OK.”

Choose “Background” from the View menu, and then choose
“New…” from the submenu.

Choose “Add page number” from the Master menu if you
want to number your slides, and then add graphics, text, and
guides to your background.

Assign a background from the popup
menu at the bottom of the window
and add placeholders from the Master
menu.

In the “New slide master” dialog box,
name your new slide master, choose
“None” or another slide master in the
“Based on” popup menu, and click “OK.”

Choose “Slide master” from the View
menu, and then choose “New…” from
the submenu.
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The orientation of backgrounds determines the orientation of slides

Creating tall slides

Backgrounds determine the orientation of slide masters and of the slides to which the
slide masters are assigned.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

VenturaeVenturae
• Aura levis
• Secundus adversus
• Procella crassus

• Aura levis
• Secundus adversus
• Procella crassus

A Check options that need adjusting.

B Check to move all objects into the
center of the new slide shape.

C Check to scale objects to fit on the
new slide shape.

D Check to scale text sizes to fit on the
new slide shape.

E Check to scale all objects while
maintaining their original propor-
tions.

Note: If you adjust text and graphics on
many slides, save your file before you
use the “Adjust graphics” dialog box. If
the adjustments don’t work well, you
can return to the saved file by choosing
“Revert” from the File menu.

Move or scale objects on slides

D
E

B
C

A

For more information
Creating new slide masters and
backgrounds ....................................... 34

Picturing Persuasion ............................ 22

Understanding the parts of a slide ....... 25

Working with slide masters and
backgrounds ....................................... 26

Although most of the AutoTemplates
that come with Persuasion have a
wide orientation, you can easily
create tall slides in any AutoTemplate.
Tall slides are useful when your
presentation includes information
such as a flow chart that needs to be
displayed vertically or if you need to
reformat your presentation into a
printed report.

You change a slide’s orientation on a
background. Changing the orienta-
tion of a background changes the
orientation of all the slide masters
and slides to which the background is
assigned. When you re-orient a slide
from wide to tall, you may need to
move or scale objects to fit into the
new slide shape.

To avoid changing the orientation of
existing slides, create a new back-
ground and slide master and then
assign them to slides whose orienta-
tion you want to change.
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To create a tall slide

Tip: To change the orientation of an existing background from
wide to tall, choose “Background” from the View menu, and
then choose the background you want to change from the
submenu. Choose “Tall orientation” from the Master menu.

Assign the new slide master to existing slides (and adjust your
content accordingly) or to new slides you create.

VenturaeVenturae
• Aura levis
• Secundus adversus
• Procella crassus

• Aura levis
• Secundus adversus
• Procella crassus

In the “New background” dialog box,
name the new background, make a
selection from the “Based on” popup
menu, select “Tall,” and then click “OK.”

Choose “Slide master” from the View
menu, and then choose “New…” from
the submenu.

Choose “Background” from the View
menu, and then choose “New…” from
the submenu.

In the “New slide master” dialog box,
name the new master, choose the slide
master to base it on from the “Based
on” popup menu, and then click “OK.”

Choose “Background” from the
background menu at the bottom of the
window, and then choose the name of
the tall background from the submenu.

In the “Adjust graphics” dialog box,
select options for moving or scaling
objects on the slide master to fit the
new tall shape.
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Edit your presentation in
the slide sorter

To rearrange slides

Slide sorter

Tip: Color slides will display faster in
the slide sorter if you choose “Color
system” from the Show menu, and
then choose “Black and white.”

A Displays all or several of your slides in
the slide sorter.

B Smaller magnifications display more
slides at once.

To view all or several of your slides at
once, use the slide sorter, Persuasion’s
light table. Seeing your slides side-by-
side makes it easy to proof the design
and overall content of your presenta-
tion and to rearrange slides.

The slide sorter is also useful when
you want to assign slide masters or
transitions to one or several slides or
when you want to copy and paste
slides from one presentation to
another. Pasted slides take on the
color scheme and slide shape of the
presentation they are pasted into.

Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite

Click a slide to select it or select more
than one slide by holding down Shift
and then clicking each slide.

Drag the slides until the vertical bar is
where you want them moved.

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite

A

For more information
Creating a new color scheme ............ 126

From slides to presentations ................ 24

Proof and save .................................... 18

Transition effects for slides and slide
layers ................................................ 164

Using slide masters from other
presentations ...................................... 30

B
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To assign a slide master or a transition

te Go Fly a Kite

e Go Fly a Kite

Go Fly a Kite

To copy slides from another presentation

Note: If no slide is selected, pasted slides from the source presentation are added
after the last slide in the destination presentation.

In slide sorter in the source presenta-
tion, select the slides you want to copy,
and then choose “Copy” from the Edit
menu.

In slide sorter in the destination presenta-
tion, select the slide you want the new
slides to follow, and then choose “Paste”
from the Edit menu.

If the  “Adjust graphics” dialog box
appears because the pasted slide’s
shape changed, select options for
moving or scaling objects on the slide.

Go Fly a Kite

Go Fly a Kite

Go Fly a Kite

Go Fly a Kite

ite Go Fly a Kite

te Go Fly a Kite

Go Fly a Kite

Choose “Slide master” from the master
menu at the bottom of the window, or
choose “First visual effect” or “First
sound effect” from the transition menu
at the bottom of the window.

Click a slide to select it or select more
than one slide by holding down Shift
and then clicking each slide.

Choose the slide master or visual or
sound transition you want to assign.
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Design and format with
AutoTemplates

Note: If you didn’t install the
AutoTemplates that come with
Persuasion 3.0 when you installed the
software, you can install them now.
Double-click the Persuasion 3 Installer/
Utility on installation disk 1, deselect
all options except “AutoTemplates,”
and then insert disks as prompted.

An AutoTemplate is a collection of
slide masters and backgrounds that
provides a common design for slides
in a presentation. You can prepare
presentations faster by using
AutoTemplates because you don’t
have to create everything from
scratch.

You have several sources for
AutoTemplates:
• You can save presentations you

like as AutoTemplates.
• You can develop AutoTemplates

from scratch.
• You can install the AutoTemplates

that come with Persuasion 3.0.
• You can convert AutoTemplates

from previous versions of
Persuasion.

You can save any presentation as an
AutoTemplate. (Delete the content
first, if you don’t want to include it in
the AutoTemplate.) AutoTemplates
differ from presentations only in how
they open. When you open an
AutoTemplate, an untitled copy,
rather than the original, is displayed.

For more information
Converting files created in previous
versions ............................................... 10

Designing new AutoTemplates ............ 44

AutoTemplate Guide

AutoTemplates are collections of design and formatting decisions

In AutoTemplates, time-consuming decisions, such as what color scheme and design to
use or how to format text, have already been made.

This is a Title Placeholder.
This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Title Placeholder.
This is a Title Placeholder.

• This is a text placeholder.

– Change the font and style for each level.

• Resize and reposition the box.

• Change tabs and indents

• Slides will follow...

• in kind.

• This is a text placeholder.

– Change the font and style for each level.

• Resize and reposition the box.

• Change tabs and indents

• Slides will follow...

• in kind.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Title Placeholder.
This is a Title Placeholder.

  

  

  

  
  

  
  

  

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.This is a Title Placeholder.

This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Chart Placeholder.

 Anchor and resize the box.

 Slides will follow in kind.

This is a Title Placeholder.
This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Chart 

Placeholder.

 Anchor and resize the box.

 Slides will follow in kind.

• This is a Body Text placeholder.

• Change font for each level.  

• Anchor and resize the box.

• Set  tabs, indents and  

alignment

• Slides will  

follow...

• in kind.

• This is a Body Text placeholder.

• Change font for each level.  

• Anchor and resize the box.

• Set  tabs, indents and  

alignment

• Slides will  

follow...

• in kind.
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To open an AutoTemplate

To save a presentation as an AutoTemplate

Choose “Open presentation…” from the Persuasion startup
screen or from the File menu.

In the dialog box, check “Show” to preview the
AutoTemplates, locate the AutoTemplate you want, and then
click “Open.”

Tip: Since the output device selected in the Chooser and the slide shape selected in the “Presentation setup” dialog box
affect the shape of the slides in an AutoTemplate, make appropriate selections before you design your slides.

With the presentation open, choose “Save as…” from the File
menu.

In the dialog box, type a name for the AutoTemplate, select
“AutoTemplate,” and then click “Save.”
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Decide how new
presentations will look

Persuasion Startup ScreenEach time you choose “Create
presentation” from the Persuasion
startup screen or from the File menu,
you open a copy of “Default
AutoTemplate.” This file provides the
formatting for new presentations you
start from scratch.

During installation, you can decide
whether you want “Default
AutoTemplate” to be sized for 35mm
slides, overheads, or onscreen slide
shows. At any time, you can replace
or modify the “Default
AutoTemplate” file.

For more information
Design and format with
AutoTemplates .................................... 40

How to install Persuasion 3.0 ................. 8

AutoTemplate Guide

A

B

C

A Opens a copy of “Default
AutoTemplate.”

B Opens an existing presentation or a
copy of an AutoTemplate.

C Opens an untitled AutoTemplate
with only one slide master and one
background. Design a new
AutoTemplate by creating slide
masters and background design.

Tip: If you replace or modify the default AutoTemplate and then decide
you want to use the default AutoTemplate originally installed by

Persuasion, open the AutoTemplate called GradLn35, GradLnOH, or
GradLnSC, depending upon which media you chose as your default.
Then, follow the procedure for replacing the default AutoTemplate.
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To replace the default AutoTemplate

Make any changes you want to the
AutoTemplate’s settings, open the view
(slide, outline, or slide sorter) that you
want the AutoTemplate to open in, and
then choose “Save as...” from the File
menu.

Choose “Open presentation...” from
the Persuasion 3.0 startup screen, and
then locate and open the
AutoTemplate you want as your
default.

In the list box, double-click your
Persuasion application folder, and then
double-click the “Persuasion Support”
folder.

To modify the default
AutoTemplate choose “Create
presentation...” from the Persuasion
3.0 startup screen, and then follow
Steps 2 through 5 to replace the
original default AutoTemplate with the
modified one.

Tip: To change any colored AutoTemplate to black and white, choose “Color system” from
the Show menu, and then choose “Black and white” from the submenu.

In the text box, type Default
AutoTemplate, with exactly that
spelling, capitalization, and spacing.
Select the “AutoTemplate” option, and
then click “Save.”

In the message box, click “Replace” to
replace the existing “Default
AutoTemplate” file. If you don’t see the
message box, the Default AutoTemplate
won’t be replaced.
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Designing new
AutoTemplates

Starting from scratch
You can design an AutoTemplate
either by starting from scratch or by
modifying an existing AutoTemplate
or presentation. If you modify one of
the AutoTemplates that comes with
Persuasion, you can edit its slide
masters and backgrounds, delete
them, or add new ones.

Each type of presentation—
overheads, 35mm slides, or on-screen
slide shows—has a different slide
shape so when you design
AutoTemplates, you need to set them
up for the specific type of output
you’ll be producing.

The AutoTemplate you open when
you choose “Design AutoTemplate”
from the startup screen is set up for
overheads. If you change the setup to
be appropriate for either 35mm slides
or on-screen slide shows, you need to
adjust graphics and text to fit onto
the new slide shape.

Setting up AutoTemplates for specific output

Type of presentation In the Chooser select In the “Presentation
setup” dialog box select

Overheads Printer Overhead

On-screen slide shows — Screen

35mm slides Film recorder or printer 35mm slide or custom
slide dimensions*

* Consult your film recorder documentation or your service provider for the specific
requirements for setting up an AutoTemplate to produce 35mm slides.

When you choose “Design AutoTemplate” from the startup screen, you open a black-
and-white AutoTemplate with one slide master and one background. Add as many slide
masters and backgrounds as you need and name them so they are convenient to use.

This is a Title Placeholder.
This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

Placeholder.Placeholder.

This is a Title Placeholder.
This is a Title Placeholder.

This is a Title Placeholder.
This is a Title Placeholder.

  

  

  

  
  

  
  

  This is a Title Placeholder.
This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Chart Placeholder.

 Anchor and resize the box.

 Slides will follow in kind.

This is a Title Placeholder.
This is a Title Placeholder.

This is a Subtitle Placeholder.
This is a Subtitle Placeholder.

This is a Chart

Placeholder.

Anchor and resize the box.

Slides will follow in kind.

For more information
Creating new slide masters and
backgrounds ....................................... 34

Printing overheads and
support materials .............................. 202

Preparing your on-screen
presentation ...................................... 178

Setting up for 35mm output ............. 204
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To design and set up an AutoTemplate

Choose “Design AutoTemplate” from
the Persuasion 3.0 startup screen.

Design backgrounds and slide masters,
adding placeholders as needed. Choose
“Save as…” from the File menu, and
then in the dialog box, type a name,
choose “AutoTemplate,” and
click “Save.”

In the “Presentation setup” dialog box,
select a slide shape or select “Custom”
and enter slide dimensions, and then
click “OK.”

To modify an existing AutoTemplate

Choose “Open presentation…” from
the Persuasion startup screen, and
then open the AutoTemplate you
want to modify. Add, delete, or edit
the AutoTemplate’s slide masters and
backgrounds and then save the
modified version under a new name.
Be sure to select “AutoTemplate” in
the dialog box.

If the “Adjust graphics” dialog box
appears, select options for moving and
scaling objects to fit in the new slide
shape, and then click “OK.”

If necessary, in the Chooser, select the
output device for the final output you’ll
produce.

Choose “Page setup…” from the File
menu, and then click “OK.”
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Enter text in the outline or
on slides

Text you enter in placeholders flows to the outline

Manipulating text blocks

Text you enter outside placeholders is independent text

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat

• Iriure dolor in hendrerit
• Velit esse consequat

CONFIDENTIALCONFIDENTIAL

CONFIDENTIAL

On slides, when you type text into the
placeholder prompt area, your text re-
places the prompt text. The text adopts
the formatting of the placeholder and ap-
pears unformatted in the outline.

Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

Nimbus

          

     Nimbus

          

     

4    

5    

   

1 2 3 4 5 6 7 8

Not all text needs placeholder formatting
nor does it need to flow into the outline.
For example, you might want to add the
word “Confidential” to one slide. Add
this independent text outside text place-
holder boundaries.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat

• Iriure dolor in hendrerit
• Velit esse consequat

CONFIDENTIAL

Both independent text and placeholder
text are contained in text blocks. You can
move a text block by selecting it with the
pointer tool, and then dragging it to the
desired location. Text blocks are automati-
cally resized vertically to fit the text you
enter.

With Persuasion 3.0, you can enter
text directly on slides or in the
outline, whichever suits your working
style. Enter text on slides to get a
sense of how much text fits on the
slide and how it works with the other
slide elements. Enter text in the
outline when you want to concen-
trate on content and view the text for
all slides in a presentation at a glance.

On slides, you can enter text by
typing over the placeholder prompt
text or by typing independent text
outside the boundaries of placehold-
ers. After you’ve typed text into a
placeholder, the placeholder shrinks
or expands to fit the text.

You can also import text from other
applications directly into the outline
or to slides.

For more information
Change the indents in a body
text placeholder .................................. 56

Format slide content with placeholders ... 28

Outline your presentation to save time ... 62

“Import text” in Online Help

“Importing text on the slide” in Online Help
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Working with text placeholders

Tip: To hide the text ruler, uncheck
“Text ruler” on the Text menu.

How to enter text within a placeholder prompt area

To… Do this…

Type text. Click an insertion point within the placeholder and type.

Start a new paragraph. Press Return.

Force a line break. Press Shift + Return.

Create a new indent. Press Tab at the beginning of a line.

Return to a previous indent level. Click an insertion point at the beginning of the line and press Shift + Tab.

A

B

A The text ruler is displayed whenever
you select the text tool and click an
insertion point on the slide.

B Prompt text shows you where to en-
ter text within a placeholder. The
text you enter automatically replaces
the prompt text.



50 ADOBE PERSUASION 3.0 USER MANUAL

Format slide text on the
slide master

To format text, select either a text
placeholder on the slide master or an
independent text block on a slide,
and then select the options you want
from the text palette.

Formatting options on the text
palette are also available on the Text
menu. For example, you can assign a
precise line-spacing value using the
“Line spacing…” command on the
Text menu.

Selecting a font size that your audience can read

For more information
Adding colors and fills ....................... 120

Changing bullet style ........................... 52

Format slide content with
placeholders ........................................ 28

Projected font size is relative to the depth of your seating area. One way to achieve the
appropriate projected font size is to set up the last row of the audience no further away
than eight times the height of your projected presentation. Also, the first row should
only be as close as two times the height of the projected presentation.

A
 B
 C

A
 B
 C

A
 B
 C

1 foot
8 feet

2 feet

16 feet

3 feet

24 feet

2 feet

4 feet

6 feet

Tip: To ensure that the audience
can read your slides, set your
type size within the range of

24 to 60 points.
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Use the text palette to format text

FEDBA

Tip: Persuasion converts inch and
foot marks to typographer’s quotes

automatically. To show an inch
mark, choose “Preferences” from
the File menu and then uncheck

“Use typographer’s quotes”
 in the “Preferences” dialog box

before you type.

C HG I

E The text-alignment buttons align text
left, right, centered, or justified in rela-
tion to the text-block margins.

F The line spacing buttons determine
where space is increased or decreased
between selected lines or paragraphs.
The first button affects line spacing,
the second affects paragraph space
above, and the third affects paragraph
space below.

G These nudge buttons increase or de-
crease line or paragraph spacing ac-
cording to what spacing button is
selected.

H The bullet button shows and hides
bullets.

I The “Apply format” popup menu
lists user-defined formats you can
use to override a placeholder format.

A The font popup menu.

B The point size popup menu.

C These nudge buttons increase or
decrease the font point size.

D Type styles. Choose from Plain,
Bold, Italic, Underline, and Shadow.
Apply outline style, superscript, or
subscript from the “Style” submenu
on the Text menu.
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Changing bullet style

The “Define bullets” dialog boxPersuasion adds a bullet to each
indent level in text placeholders, and
to independent text blocks you
create. You can change the character
or color used for bullets in place-
holder text on the slide master. Or,
you can hide the bullets.

Tip: Select “Key Caps” from the menu to find symbols and
characters that can be produced using the Shift, Option, and

Command keys. Then, type the desired character in the appropriate
“Level” box in the “Define bullet marks” dialog box.

For more information
Color basics ....................................... 118

Format slide text on the slide master .... 50

Format slide content with placeholders .. 28

“Changing bullet style” in Online Help

“Defining bullets in a body text placeholder”
in Online Help

A Lists the fonts available for bullets.

B Opens the working set of the color
palette.

C Changes bullets at all levels in the
text placeholder.

D Corresponds to indent levels in the
body text placeholder.

D

C

B

A
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To change bullet color or symbol

Display the slide master, and then
choose “Define bullets...” from the
Master menu.

In the “Define bullets” dialog box, select
the level of text for the bullet you want to
change, or check “Apply to all bullets.”

Select a font and/or color. Enter the
bullet symbol for each level you want to
change.

✔ Caelum nimbus
◆ Caelum nimbus

◆ Caelum nimbus
✔ Caelum nimbus

◆ Caelum nimbus

◆ Caelum nimbus

To hide or remove bullets

To hide bullets on individual slides,
select the text block, and then click the
bullet button on the text palette. This
removes all bullets from the text block.

To remove bullets from a body text
placeholder, display the slide master,
and then choose “Define bullets...”
from the Master menu. Select the level
of text from which you want to delete
the bullet, and then press Delete.

Tip: If you remove bullets from a text
placeholder using the “Define bullets”
dialog box, return to the slide master to
add them again.

☛ Caelum nimbus

Caelum nimbus

☛ Caelum nimbus

Caelum nimbus
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Defining reusable text
formats

Use text formats to emphasize words

Use text formats throughout several slide masters

Apply a consistent style to all words you want to emphasize within placeholders by
creating a format named “Emphasis.” Then, apply the Emphasis format on individual
words to override the placeholder style.

Repeat a text format throughout several slide masters by applying it to the placeholder
text of each slide master.

ReipublicaeReipublicae

NimbusNimbus

CaelumCaelum

• Iriure dolor  in hendrerit

• Velit  esse consequat

• Dignissim qui  praesent

• Iriure dolor  in hendrerit

• Velit  esse consequat

• Dignissim qui  praesent

Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

Click here for titleClick here for title

Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

Click here for titleClick here for title

Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

Click here for titleClick here for title

Use the Persuasion text formats as a
shortcut for assigning text attributes
to independent text blocks or to
individual words you want to
emphasize with placeholders.

For example, you can create text
formats to override placeholder styles
or to repeat text styles among several
slide masters. Then, you apply the
format by selecting it from the
“Apply format” popup menu on the
text palette.

Text formats are similar to stylesheets
in word-processing programs;
however, changes to them do not
affect text already typed. For
example, if you apply a text format to
a word, and then change the style of
the text format (from bold to italics),
you need to reapply the text format
to the word.
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To create a text format

To apply a text format

Select the text or text block you want to
format.

Caelum nimbusCaelum nimbusCaelum nimbusCaelum nimbus

Tip: If you edit a text format, always
reapply it to your text, Also, if you
change a placeholder format in which
you also have a text format, reapply the
text format after you make changes to
the placeholder.

Click the “Apply format” button on the
text palette, and then select the format
you want from the list.

In the “Text format” dialog box, enter
the format attributes, and then click “OK.”

In the “Define text formats” dialog
box, enter a name for the format, and
then click “OK.”

Choose “Define formats…” from the
Text menu, and then click “New” in
the “Define text formats” dialog box.
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Change the indents in a
body text placeholder

Indent markers position text in a body text placeholderPersuasion gives you six indent levels
in the body text placeholder. Each
indent level corresponds to a sub-
ordinate heading in the outline.
When you want to change the indent
space for any of the levels, move the
corresponding marker on the text ruler.

To maintain consistent indent spaces
across many slides, set the body text
indent levels on the slide master. You
can override master settings on
individual slides if necessary.

When you set indent positions, you
are setting the position of the text,
not the position of the bullets. Bullets
always maintain a fixed distance to
the left of text.

Each pair of indent markers (top and
bottom) governs one indent level in
the body text placeholder. When you
drag the top marker, both upper and
lower indent markers move.

A Top indent marker

B Bottom indent marker

C Indent levels in the body text
placeholder

Tip: Apply paragraph alignment to
your text after changing indents to
maintain readability of your text.

For more information
“Adjusting indents” in Online Help

“Aligning text and directing text flow” in
Online Help

C

A
B
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To… Do this…

View the text ruler With the text tool, select a body text
placeholder. Make sure that “Text ruler”
is checked on the Text menu.

Set an indent level Click the top half of the indent marker,
and then drag it where you want to set
the indent.

Create a hanging indent Drag the top indent marker to where
you want the first indent line to start.
Drag the bottom indent marker to where
you want the rest of the paragraph to align.

Remove an indent marker Drag the indent marker to the left
until it covers another one.
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Controlling the direction
of text flow

Anchor text to avoid overlapping objects

Lorem ipsum dolor sit amet, consectetuer adipiscing 
elit, sed diam nonummy nibh euismod tincidunt ut 
laoreet dolore magna aliquam erat volutpat.  Ut wisi 
enim ad minim veniam, quis nostrud exerci tation 
ullamcorper suscipit.

After you position placeholders, you
may find that when you enter text,
the placeholder expands to accom-
modate the text. The direction in
which the placeholder expands is
determined by how the placeholder is
anchored.

You may need to change the
direction in which the placeholder
expands when you have several
objects in your slide design that
should not overlap. You change the
direction in which the placeholder
expands by changing the anchor of
the placeholder. Placeholders can
be anchored both vertically and
horizontally.

If you position a text placeholder above a graphic, anchor the placeholder so that it
expands upward and does not overlap the graphic.

Lorem ipsum dolor sit amet, 
consectetuer adipiscing elit, 
sed diam nonummy nibh 
euismod tincidunt ut laoreet 
dolore magna aliquam erat 
volutpat.  Ut wisi enim ad 
minim veniam, quis nostrud 
exerci tation ullamcorper 
suscipit.

Anchoring is independent of paragraph alignment. For example, left-aligned text can be
anchored at the lower-right corner of the placeholder. The text flows up and from the
right corner into a left-aligned position within the text block.

For more information
Format slide text on the slide master ...... 50

“Aligning text and directing text flow”
in Online Help

“Placeholder versus independent text”
in Online Help
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The “Anchor content to placeholder” dialog box

To anchor text placeholders

On the slide master, select the
placeholder with the pointer tool.

Choose “Anchor placeholder…” from
the Master menu.

Set both a horizontal and vertical
anchor, and then click “OK.”

A Anchors the placeholder vertically on
the slide using the top, center, or
bottom as the anchor point.

B Anchors the placeholder horizontally
on the slide using the left, right, or
center as the anchor point.

This is a Title Placeholder.This is a Title Placeholder.

•  This is a text placeholder.
     •  Change the font and style
         for each level.
          •  Resize and reposition the box.
               •  Change tabs and indents.
                    •  Slides will follow…
                          in kind.

•  This is a text placeholder.
     •  Change the font and style
         for each level.
          •  Resize and reposition the box.
               •  Change tabs and indents.
                    •  Slides will follow…
                          in kind.

A

B
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Creating multicolumn text

To add, move, or delete tab stops

With the text tool, select the place-
holder or independent text block in
which you want to create a table.

For more information
Adding a table to a slide .................... 110

Using tables from other applications ... 112

“Create a table” in Adobe Table
Online Help

Table columns can be aligned left or to a decimal point.

Use the text ruler to set columns

Pennae

Aether
 
Caelum
 
Nimbus

Praefectus

Advolare

Dolore magna aliqua

Elit sed diam nonum

Quis nostrud exerci

Duis autem vel

Dignissim qui praese

Augue duis dolore

Rector

Eques

Opifex Operarius

Curator

Artifex Pedisequus

Te feugait nulla facilisi

Select a tab icon, and then drag the
icon on the ruler to set the tab. Or,
drag an existing tab marker into place.

Tip: To remove an unwanted tab, drag the tab marker off the ruler.

When you want to create
multicolumn text, you can use Adobe
Table, or you can set up rows and
columns in a body text placeholder.
On the slide master, you use the text
ruler to set tab stops for each
column.

You can set up to 25 tab stops per
line in any text block just as you can
in a word-processing program. Once
you set tab stops on the slide master,
you can enter multicolumn text either
in the outline or on the slide.
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Checking your spelling

The “Spelling” dialog box

A

C

D

B
E

H

Use the “Spelling…” command on
the Edit menu to find and correct
misspelled words on slides, in the
outline, or on note pages. (Text
created by Adobe Table or Adobe
Chart is not checked.) Changes made
in one view are reflected in other
views. So, if you spell-check the
outline, the placeholder text on the
slides reflects your changes.

You can add special terms, such as
company names, acronyms, or
professional jargon to a user dictio-
nary so that Persuasion prompts you
for misspellings of these terms also.

In the PowerMac version of Persua-
sion you can remove words from the
dictionary with the Dictionary Editor
application found in the Utilities
folder in the Aldus folder in the
System folder. In the same folder, see
“PNDictED” for instructions.

In the 68K version of Persuasion, you
cannot remove words from the
dictionary. Instead, you can make a
backup copy of the user dictionary
(User1) in the Spelling folder in the
Persuasion Support folder before you
add words to it. Then if you enter a
word incorrectly, you can replace the
current dictionary with the backup
copy.

E Does not change the word in the
“Change to” box.

F Stops the spell check.

G Replaces the misspelling with the
word in the “Change to” box and
continues the spell check.

H Displays the dialog box for adding
a word to the user dictionary.

A The misspelled word.

B Enter the correct word here.

C Lists possible alternatives for
misspelled word.

D Parts of the presentation
to spell check.

Adding words to the user dictionary

If you’re running the 68K version
of Persuasion, first back up the
current user dictionary (User1) in
the Spelling folder in the
Persuasion Support folder.

In the “Spelling” dialog box, click
“Add….”

In the “Add word to user
dictionary” dialog box, type the
word, choose the options you
want, and then click “OK.”

G

F
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Outline a presentation to
save time

Rearrange and edit content
quickly. Major text revisions are
quicker and easier to make in the
outline. You can move text around
quickly as you develop ideas. Use
standard Macintosh commands to
cut, copy, paste, insert, and replace.
You can also select text and drag it to
edit your outline.

View only slide titles. You can
collapse part or all of an outline to
view a large number of slides.
Collapsing an outline helps you
organize and edit it because it’s in a
more compact form.

Assign masters and transitions.
Another way to save time is to assign
masters and slide transitions (for on-
screen presentations) directly in the
outline. For example, you can quickly
apply the organization chart master
in the outline as you develop the
chart.

Add speaker notes in the outline.
Notes that you add to the outline do
not appear on the slides, but they can
be printed either with the outline or
on separate note pages.

Import an outline you’ve already
created. If you already have an
outline in a word-processing file, you
can save it as a text-only (ASCII) file,
and then import and use it in your
Persuasion presentation.

Tip: To use the outline, click the
outline icon in the upper-right
corner of the window, or select
“Outline” from the View menu.

Working directly on slides lets you see
how text looks with the other slide
elements. But when you want to
enter and revise presentation text
quickly, the outline is the place to
work.

Your slides must have a slide master
assigned that has the appropriate
placeholders before the outline
content will appear on the slides. For
example, if you add subtitles in the
outline, the slide master must contain
a subtitle placeholder.

For more information
Adding an organization chart ............ 106

Collapsing and expanding an outline ... 70

Creating speaker notes ........................ 74

Importing text to the outline .............. 140
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Outline contents flow through placeholders to slides

     

4    

5    

   

          

     Nimbus

          Caelum Aether

          Iriure dolor in hendrerit

          Velit esse consequat

          Dignissim qui praesent

     Reipublicae forma

          Praefectus

               Rector

               Eques

s

Caelum Aeth
er

Iriure dolo
r in hend

Velit esse 
consequat

i praese

This is a Title Placeholder
This is a Title Placeholder

This is a Subtitle Placeholder
This is a Subtitle Placeholder

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.

                    

•  This is a text placeholder.

     •  Change the font and style

         for each level.

          •  Resize and reposition the box.

               •  Change tabs and indents.

                    

Title PlaceTitle Place

Subtitle PlaceSubtitle Placeh

NimbusNimbus

Caelum aetherCaelum aether

• Iriure dolor in hendrerit

• Velit esse consequat

• Dignissim qui praesent

• Iriure dolor in hendrerit

• Velit esse consequat

• Dignissim qui praesent

Outline contents flow directly through placeholders to individual slides.
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Use the outline to enter text quickly

A

D

E

C
B

F

For more information
Nesting slides under an overview slide ... 68

Picturing Persuasion ............................ 22

“Import text” in Online Help

“Outline menu” in Online Help

Entering text in the outline

A Slide divider icon. Type the presen-
tation title or section name here, or
use it for notes or comments. Slide
divider text does not appear on
slides or on note pages.

B Slide title icon. Each slide title indi-
cates a new slide.

C Slide subtitle icon.

D Body text icon.

E The slide number reflects the order
of the slide in the presentation.

F Nested slides.
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 How to work in the outline

To… Do this…

View the outline. Click the outline icon in the upper-right corner of the window.

Enter subordinate text after the slide title. Press Tab at the start of the line, and then type the text.

Create a new line at the same heading level. Press Return.

Demote an empty line one heading lower (move right). Press Tab.

Promote an empty line one heading higher (move left). Press Delete or Shift + Tab.

Insert a line break within a paragraph. Press Shift + Return.

Delete a heading with an insertion point anywhere in it. Press Command + X.

Demote (move right) a heading with the insertion point Press Command + ].
anywhere in it.

Promote (move left) a heading with the insertion point Press Command + [.
anywhere in it.

Automatically add subtitles to all slides. Choose “Auto subtitles” from the Outline menu.
(The assigned slide master must contain a subtitle placeholder.)
Then, press Return + Tab after a slide title. (Previously typed
entries are not affected.)

Add subtitles to individual slides. Click an insertion point at the end of the slide title. Press Return,
then Tab, and then choose “Set heading as” from the Outline
menu. Choose “Subtitle.”

View your slides. Click the slide sorter icon in the upper-right corner of the window.

View a slide. Click on a number for that slide along the left margin of the outline.

View your notes page. Hold down Option and click on the slide number.
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To move a heading and its subheadings

Click the heading, and then drag the
heading icon to its new position.

Tip: Check that the icon is aligned at
the heading level you want before you
release the mouse button.

Rearrange information in
the outline

To move a heading without moving its subheadings

Click the heading you want to move,
hold down Option, and then drag the
heading icon to its new position.
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To select multiple headings

To select… Do this…

Nonadjacent headings Select a title, subtitle, or body text icon, hold down Shift, and then click additional
heading icons.

Adjacent headings Select an icon at one end of the range, hold down Shift + Option, and then select the
icon at the other end of the range, or drag-select all the headings you want to move.

All text in a heading Select a heading, and then choose “Select all” from the Edit menu.

All titles or all headings at one level Select a title or heading, and then choose “Select all” from the Edit menu twice.

To move multiple headings

Select the headings you want to
move, and then drag them to their
new location. A short vertical bar next
to the heading icon indicates that a
heading is selected.
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Nesting slides under an
overview slide

Create an overview slide

When you nest slides, you create one overview slide that lists the titles of each of the
subordinate slides.

Select the slides you want to nest, and
then drag the slides to the right and
below the overview slide.

Choose “Set heading as” from the
Outline menu, and then choose “Title”
from the submenu.

To nest slides

For more information
Outline your presentation to save time ... 62

“Outline menu” in Online Help

• Lorem ipsum dolor sit
• Elit sed diam nonum
• Tincidunt ut laoreet

• Lorem ipsum dolor sit
• Elit sed diam nonum
• Tincidunt ut laoreet

• Quis nostrud exerci
• Commodo consequat
• Duis autem vel

• Quis nostrud exerci
• Commodo consequat
• Duis autem vel

• Iriure dolor in hendr
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendr
• Velit esse consequat
• Dignissim qui praesent

• Aura levis
• Secundus adversus
• Procella crassus

• Aura levis
• Secundus adversus
• Procella crassus

VentusVentus

Aura levisAura levis

Secundus adversusSecundus adversus

Procella crassusProcella crassus

When you want to create one slide
that lists your presentation agenda,
you can create an overview slide from
a group of subordinate or nested
slides. Or, if you have a slide that has
too many bullet points, you can
divide it into one overview slide and
several nested slides to retain the
hierarchy of the information.
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Assigning masters and
transitions in the outline

To assign a new master to a slide

To add transition effects

Tip: To apply the same effect to
multiple slides, select those slides

before applying the effect.
For more information
Adding and editing sounds ................ 168

Sound transition effects for slides
and slide layers .................................. 166

Transition effects for slides and
slide layers ......................................... 164

Choose “Slide master” from the master menu at the bottom of
the window, and then choose a master to apply.

Select the slide title.

Choose “First visual effect” from the transitions menu at the
bottom of the window, and then choose an effect from the
submenu.

Click an insertion point anywhere on the slide you want the
transition effect to precede.
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Reipublicea forma

      Praefectus

            Rector

            Eques

            Curator

                  Artifex

                  Pedisequus

Advolare

      Feugiat nulla facilisis

      Accumsa et iusto odio

Reipublicea forma

Advolare

Collapsing and expanding
an outline

Collapsed and expanded outlines

Tip: To hide all body text indented
on your slides, select “Hide body

text” from the Outline menu.

For more information
Format your outline for printing
and viewing ........................................ 71

Printing overheads and support
materials ........................................... 202

Rearrange information in the outline ... 66

Expanded Outline

Collapsed Outline

When a heading in the outline is collapsed, its icon is highlighted.

Collapse your outline to move slides
around quickly or to review the
organization of your slides. You can
expand a collapsed outline to view
and/or print the text of your complete
presentation.

How to collapse and expand parts of the outline

To… Do this…

Collapse the whole outline and show Click the icon in the lower-left corner
only the slide titles. of the window. Click again to expand

the outline.

Collapse one outline section. Double-click its icon. Double-click again
to expand the section.

Collapse several headings at once. Select the headings whose sub-headings
you want to collapse, and then choose
“Collapse selection” from the Outline menu.

Collapse all subheadings except Select a heading with two or more
immediately subordinate ones. subordinates, and then choose “Show

subs only” from the Outline menu.

Expand all subordinates in a Select the headings you want to expand,
selected heading. and then choose “Expand subs” from

the Outline menu.
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To format an outline

Format your outline for
printing and viewing

Select the part of the outline you
want to format:

In the “Define outline styles for
selected levels” dialog box, choose the
formatting you want, and then click
“OK.” All text in your outline that is at
the same level of indent as your
selected text takes on the formatting.

For more information
Checking your spelling ........................ 61

Printing overheads and support
materials ........................................... 202

To select all headings at the same
level, click an insertion point in one
heading.

To select the whole outline, click
the first slide title, press Option +
Shift, and then click the last slide title.

Choose “Format outline…” from the
Outline menu.

If you plan to print the outline either
for your own review or as part of
your supplemental material, it helps
to format the text to make it more
readable.

You can format the whole outline at
once, you can format all headings at
the same level, or you can format
selected text or headings.

Formatting that you apply to the
outline does not show up on your
slides except for superscripts and
subscripts.

Tip: To format individual words or
phrases, highlight them using the

text tool, and then choose the
formatting commands from the

Text menu.
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Masters provide the framework for
speaker notes and handouts just as
they do for slides. AutoTemplates
come with a formatted note master
and handout master; if you are
creating a presentation from scratch,
you’ll want to format note and
handout masters as well.

Once you set up a master for speaker
notes, type your notes in the outline
or on the note pages of each slide.
The notes can be printed either with
the outline or as separate note pages.

Add handouts and speaker
notes to a presentation

A presentation is rarely complete
without printed handouts and
speaker notes. Persuasion gives you
several options for creating these
essentials:
• You can create speaker notes,

which contain thumbnails of your
slides along with notes you enter
in the outline.

• You can create handouts, which
contain slide thumbnails along
with any other objects or text you
wish to add (for example, lines for
your viewers to jot notes on).

• Outlines and printed copies of
slides can be used as speaker
notes or as handouts. Add
supplemental information as notes
and in the slide divider.

For more information
Creating handouts .............................. 76

Creating speaker notes ........................ 74

Entering text in the outline .................. 64

Format your outline for
printing and viewing ........................... 71
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Generate notes and handouts for your presentation

You might prefer to print the outline and
use it as your speaker notes.

PennaePennae
Te feugait nulla facilisi

•• Dolore magna aliquam erat

Te feugait nulla facilisi

Dolore magna aliquam erat

1

Lorem ipsum dolor
sit amet
consetetuer
adipiscing leit sed
diam nonummy
nibh euismod
tincidunt

You can also print notes using the note
master. The note master can contain
placeholders for a slide title, note text
from the outline, slide thumbnail, and
page number.

1

If you use the notes in the outline as
audience handouts, you can still generate
speaker notes using the slide dividers,
which only print when you print the outline.

The handout master can contain place-
holders for slide thumbnails, slide titles,
and page number. You can add
independent text and objects (such as
lines for writing) to the master. You add
objects only to the master, not to individual
handout pages
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Creating speaker notes

Choose “Note master” from the View
menu.

This is a Title
Placeholder

Place

Resize, format, or anchor the
placeholders, and then add graphics as
needed.

Select placeholders from the Master
menu as needed.

To add text directly on the note page

Click the note icon in the upper-right
corner of the screen.

With the text tool, select the prompt text
and edit the notes, or add independent
text outside the placeholder.

To reposition any object, select it with
the pointer tool, and then drag it.

PennaePennae
Te feugait nulla facilisi

•• Dolore magna aliquam erat

Te feugait nulla facilisi

Dolore magna aliquam erat

1

Notes Page

• Click here for notes

PennaePennae
Te feugait nulla facilisi

•• Dolore magna aliquam erat

Te feugait nulla facilisi

Dolore magna aliquam erat

1

• Donatio

• DonatioAnchor and resize the box.

1 432

Formatting a note master

For more information
Entering text in the outline .................. 64

Format slide content with placeholders ... 28

Printing overheads and support
materials ........................................... 202

“Add speaker notes to the outline” in
Online Help
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Click the slide title, and then choose
“Add notes” from the Outline menu.

Reipublicea forma

      Praefectus
           

Donatio

Reipublicea forma
      Praefectus

Click an insertion point behind the note
icon and type your note text.

To hide the outline notes, click the
show-notes icon in the lower-left corner
of the screen.

To add notes in the outline



76 ADOBE PERSUASION 3.0 USER MANUAL

Creating handouts

To create handouts

Tip: Using the handout master is
an excellent way to create a

storyboard of your presentation.
Print the handout in “Wide”

orientation. Choose “Handout
master” from the View menu, and

then uncheck “Tall” orientation
from the Master menu.

You create handouts by defining the
contents of the handout master and
then printing the handout pages.
Each handout page can contain up to
eight slide thumbnails at a time,
which you can resize and position like
other graphics. You print the
handouts by selecting “Handouts”
from the print dialog box.

Drag each placeholder where you want
it. Resize to fit the page as desired.

To add slide titles to the handouts, choose
“Add title“ from the Master menu.
Drag the title placeholder into position.

To add page numbers to each
handout, choose “Add page number”
from the Master menu.

Choose “Handout master” from the
View menu.

Choose “Add slide copy” from the
Master menu for each slide placeholder.

For more information
Printing overheads and
support materials .............................. 202

Working with slide masters and
backgrounds ....................................... 26

“Defining the handout master” in
Online Help

Show Name
Slide 1 Title Placeholder.

Slide Title

1

1

2

Slide Title

3

XXXXX

Slide 3 Title Placeholder.
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Working with imported
graphics

ungroup its PICT image. Colors in
imported graphics are displayed as
close as possible to the original
graphic’s colors.

EPS graphics EPS graphics can print
at high resolutions on PostScript
printers and are the best choice for
use in printed presentations. EPS
graphics retain all PostScript color
information, so the graphic will print
to a PostScript printer with the exact
colors of the original.

Most EPS graphics display at 72 dpi,
so their screen representation may
not be as sharp as the final printed
version.

EPS graphics print at 72 dpi on non-
PostScript output devices (such as
most film recorders) unless a
PostScript interpreter is used. So, if
you use a non-PostScript output
device, import your EPS graphic at
400% of the size you plan to use it.
When you shrink it on-screen, you
will refine the resolution.

EPS graphics can be resized and
moved, but not ungrouped and
converted to Persuasion’s format.

Windows Metafiles Windows
metafiles are converted to PICT
graphics as they import, so PICT rules
apply.

Photo CD While you are importing a
Photo CD image, you can adjust the
image’s depth, resolution, and
orientation. You can also flip the
image about its vertical axis or rotate
images in 90-degree increments.
Once you import the image, it is
converted to PICT format and can be
moved and resized but not
ungrouped for more extensive
modifications.

OLE-linked graphics If you want to
ungroup and edit an OLE-linked
object, you must convert it to a
picture and then ungroup it.

For more information
Adding colors and fills ....................... 120

Importing graphics ............................ 136

“Maintain links with other applications”
in Adobe Table Online Help

Persuasion accepts graphics and clip
art in EPS (encapsulated PostScript),
PICT, Windows Metafile and Photo
CD formats.

You can move and resize imported
graphics easily in Persuasion. If you
want to modify them more exten-
sively, you must first convert the
graphics to Persuasion format by
ungrouping them. Note, however,
that some imported formats (de-
scribed here) cannot be ungrouped.

Use PICT graphics if you intend to
edit the graphics extensively once you
bring them into Persuasion. Use EPS
graphics if you plan to use the
graphics without changing them, and
you want to print on high-resolution
PostScript printers and interpreters.

PICT graphics You can ungroup all
PICTs except those that contain
rotated text, bitmap elements (such
as scans), or other objects you cannot
create in Persuasion. Text that is not
rotated can be edited when you

Tip: Large, imported graphics—
particularly color or grayscale scanned

images—take time to  redraw
on-screen. To speed up screen redraw

when you’re  working on a
presentation, choose “Preferences...”
from the File menu, and then check

“Hide big PICTs.”
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To convert a PICT to Persuasion’s format

To convert an OLE-linked graphic to Persuasion format

With the pointer tool, select the graphic you want to ungroup. Choose “Ungroup” from the Draw menu.

Select “Convert to picture” from the popup menu on the OLE
badge. This step will break the OLE link and the graphic’s
badge will disappear, indicating that the graphic can be
ungrouped.

Select the graphic and choose “Badges” from the Show
menu to display the OLE badge, if necessary.



80 ADOBE PERSUASION 3.0 USER MANUAL

Drawing basics

Use Persuasion’s drawing tools and menus to:

a Create and reshape polygons.

b Duplicate your graphic at identical offsets.

c Rotate or flip components of your graphic.

d Create shapes with variable line weights.

e Create customized line ends (endcaps).

b

c

d

a

e

For more information
Create and customize lines
and endcaps ........................................ 83

Create shapes with variable

line widths .......................................... 84

Draw a polygon or freeform shape ...... 82

Duplicate a graphic ............................. 85

“Setting tool attributes before
you draw” in Online Help
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Drawing tools

A Diagonal-line tool. Draws straight lines at any angle.

B Line tool. Draws vertical or horizontal lines.

C Arc tool. Draws curves or arcs.

D Ellipse tool. Draws ovals and circles.

E Rounded-corner tool. Draws rectangles or squares with
rounded corners.

F Square-corner tool. Draws rectangles or squares.

G Freeform tool. Draws freeform shapes or lines.

H Polygon tool. Draws polygons.

I Magnification tools. Reduce or enlarge magnification to
show more detail or more of your slide, or switch back and
forth between views.

C
D

BA

I

G
F

H

E

Constraining shapes as you draw

To draw a line or shape from the
center, hold down Option while
drawing.

To draw a perfect circle, square, or
90-degree arc, hold down Shift while
drawing.

To draw a perfect circle, square, or
90-degree arc from the center, hold
down Shift + Option while drawing.

Tip: Press Shift key to constrain lines and polygons to 45 degrees.
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Draw a polygon or
freeform shape

To reshape a polygon, arc, or freeform shape

To create a polygon

To remove an unwanted point, drag it onto an adjacent
point.

Choose “Reshape” from the Draw menu.Select the object with the pointer tool. Drag the individual points to reshape
the object.

To add a point, click anywhere on the polygon’s lines.

Select the polygon tool. Click an
insertion point where you want the
shape to start, and then click where you
want the first line segment to end.

Continue clicking to add line segments. Double-click the first point you created
to close the shape.
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Create and customize
lines and endcaps

Tools for editing lines

To modify an endcap

Check “Filled” to create a solid-fill
endcap.

Choose “Edit...” from the line palette,
and then click the endcap you want to
modify.

Drag the points in the edit box to reshape
the endcap.

B

A

A Line weights (widths)

B Custom line weights

C Places endcaps that scale with line
weight

D Styles of endcaps

E Modify endcaps

C

D

E
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Create shapes with variable
line weights

Drawing shapes with variable line weights

Choose this tool… And enter these pixel settings in the To create…
“Custom line size” dialog box…

arc 1x15

diagonal line 1x20

ellipse 15x5

rectangle 5x25

polygon 15x1

freeform 20x1

Select the object whose line weights you want to modify, and
then choose “Other…” from the line palette.

In the “Custom line size” dialog box, enter the appropriate
line weights (up to 99), and then click “OK.”

To create variable line weights
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To duplicate an object to create a pattern

Duplicate a graphic

Select the object with the pointer tool,
and then choose “Duplicate” from the
Edit menu.

Without deselecting the new copy,
drag it to the desired position to
create the offset you want to repeat.

Choose “Duplicate” again to
reproduce the object and the offset.

Tip: Copy and paste objects instead of
duplicating them if you want the copy
to appear in exactly the same place as
the original. This is a useful technique
for masking an object on a lower layer
or for moving an object to the same
place on another slide or to the slide
master.

For more information
Modifying complex graphics ................ 86

You can create interesting designs
and custom patterns by duplicating
an exact copy of an object at a
specific offset from the original.

Duplicated objects will look exactly
like the original. Duplicated text from
placeholders becomes independent
text.
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Modifying complex
graphics

Modify one component of a grouped graphic

Subselect an individual component by double-clicking it, and then modify it as though it
were a single object.

Modifying like objects

To make changes to all freestanding (not grouped) objects on a slide drawn with a
specific tool (all ovals and circles, for example), select the tool, and then choose “Select
all” from the Edit menu.

For more information
Working with imported graphics ......... 78

“Grouping and ungrouping objects” in
Online Help

“Layering objects” in Online Help

“Manipulating your drawings on the
slide” in Online Help

Grouping Use the “Group” com-
mand on the Draw menu to move
and resize several objects as one
graphic rather than selecting and
changing each component individu-
ally. Once you’ve grouped graphics
you don’t have to ungroup them
again to modify individual compo-
nents. Instead, you can subselect the
object you want to modify.

Stack ungrouped objects When
you are working with several objects
that overlap but are not grouped, you
can determine the order in which
they overlap.

Tip: Select any object on the slide
and choose “Regroup” from the

Draw menu to automatically
recombine objects you’ve

ungrouped and modified. All the
items that were most recently
ungrouped will be regrouped,

retaining changes you’ve made to
the objects.
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To select an object in a stack

To select an object that is completely
or partly hidden in a stack on the
slide, hold down Option and click the
stack until the object you want is
selected.

To change the stacking order

Select the object whose position
you want to change.

Choose “Send” from the Draw
menu and then choose an option
from the submenu.

Tip: To select everything on the
slide, select the pointer tool and

then choose “Select all” from the
Edit menu.
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Aligning and distributing
objects

Position objects in relation to each other

Tip: Use the arrows or the edit
boxes on the nudge palette to

move objects, text, and shadows
incrementally.

For more information
Use a layout grid for precise
alignment ............................................ 92

”Rotating and flipping objects”
in Online Help

Align, Vertical Bottom

You can align several objects on your
slide with each other, or distribute
them to create an equal amount of
space between them. In Persuasion,
you do both of these automatically,
without selecting and dragging each
object.

When choosing to align or distribute,
you make three decisions. First,
decide whether you want to position
objects in relation to each other on
the vertical or horizontal plane. Then
decide whether to align, distribute, or
both. Finally, choose from among the
specific alignment and distribution
options.

Align, Vertical Top; Distribute Horizontal Center

Distribute, Horizontal Center
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To align objects with each other

Select at least two objects, and then choose
“Align/Distribute...” from the Draw menu.

In the “Align objects” dialog box, check alignment options,
and click “OK.”

Tip: To align an object to the nearest grid intersection, choose “Align to grid” from the Draw menu.

To distribute objects evenly

Select at least three objects, and then choose
“Align/Distribute...” from the Draw menu.

In the “Align objects” dialog box, check distribution options,
and then click “OK.”
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Working with shadows

To apply a shadow to an object

Select the object with the pointer
tool, and then click the fill button
on the color palette.

Click the shadow button on the
color palette.

Click a pattern or fill, and then
click a color swatch.

Tools for applying shadows

A Line button

B Fill button

C Text button

D Shadow button

E Collapses and expands the
color palette

F Changes the foreground or back-
ground of a line, fill, or shadow

G Working set colors

H No fill

I Solid fill

J Graduated fills and (when
expanded) patterns

For more information
Adding colors and fills ....................... 120

Color basics ....................................... 118

“Changing text font, color,
size and style” in Online Help

J

F

C DBA

G

H
I

E

+ + +

You can apply shadows to objects,
text, and text blocks and then change
the color or pattern, or the offset of
the shadow.

You use two buttons on the color
palette to apply shadows: the
shadow button and the button that
represents what you are shadow-
ing— text, line, or object outline, or
object fill.
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Select the text with the pointer tool.

To apply a shadow to a text block

To change the offset of a shadow

Click the shadow button on the color palette, and then click
a color swatch.

Click the shadow button on the color
palette, and then click a color swatch.

Tip: Remove text shadows from
selected text by choosing “Text
format…” from the Text menu, and
then unchecking “Shadow” in the
“Text format” dialog box.

Select the object with the pointer tool,
and then choose “Shadow offset...”
from the Draw menu.

Enter values in the “Below” and “Right”
edit boxes and click “OK.” Enter
negative numbers to move the shadow
above or to the left of the object.

Caelum CaelumCaelum
+

To apply a shadow to text characters

+

CaelumCaelum

Tip: Use the arrows or the edit boxes
on the nudge palette to move objects,
text, and shadows incrementally.

Select the text with the pointer tool, and then click the fill
button on the color palette.
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Use a layout grid for
precise alignment

A key technique for creating a
consistent layout is using a layout
grid. The grid helps you position
objects precisely across all your slides.

Three sets of nonprinting tools for
creating a layout grid and for
positioning and drawing objects on
your slides precisely are available from
the Show menu: grid lines, rulers,
and guides.

You can choose to have objects
“snap to” guides and grid lines, so
that when you position an object
within a few pixels of the grid line or
guide, Persuasion automatically
moves the object to the line.

Set up guides on a background, slide
master, or slide depending on how
often you want them to appear.
Guides on masters or backgrounds
will show up on the slides.

Drawing on the grid

Draw a symmetrical polygon by counting
grid intersections, or points between the
lines, as you draw your segments. Turn on
“Snap to Grid” from “Grid” in the Show
menu to ensure the lines are a consistent
length.

Tools for precise positioning

A

B

C

D

A Click and drag the crosshair to adjust
the position of the zero point.

B Grid lines help you place objects at
specific intervals from one another.

C Click the ruler and drag guides into
position to align objects precisely.

D Use guides to help place objects in
the same place on each slide.

For more information
Aligning and distributing objects ......... 88

“Positioning graphics using rules, guides,
and grids” in Online Help

Tip: Choose “Ruler units” from
Rulers in the Show menu to
change the measuring basis

of grid lines.
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Adding a chart to your
slide

Two ways to position and size your chart
Adobe Chart is an integrated
application that opens automatically
when you click a chart placeholder on
a slide or draw a rectangle with the
chart tool in Persuasion. The chart fills
the space of the chart placeholder or
the rectangle.

With Adobe Chart you can create
and update complex charts while
working in Persuasion. Charts are
OLE-embedded in Persuasion, so you
can update a chart in Adobe Chart
after you have placed it on a
Persuasion slide.

With a Persuasion file open, you can
open Adobe Chart, enter your data,
and format the chart. You’ll find
detailed instructions for creating and
customizing each chart type in Adobe
Chart online Help.

Note: Adobe Chart can OLE-embed
to any application that supports OLE.

Tip: You may find that Adobe Chart runs faster when you close other
unused applications. If you have difficulty running Persuasion and

Adobe Chart simultaneously, open Adobe Chart to create and copy
your chart, and then open Persuasion and choose “Paste special…”

from the Edit menu to add your chart in your presentation.

The position and size of your chart is determined either by Persuasion’s chart
placeholder or by the rectangle you draw with the chart tool.

After you’ve added your chart, you can move and resize it.

AdvolareAdvolare

AdvolareAdvolare

AdvolareAdvolare

For more information
Object linking and embedding (OLE) ... 144

Working with slide masters and
backgrounds ....................................... 26

“Adding a chart to a slide” in Online Help

“Creating a chart slide master” in Online Help

“Moving and resizing charts” in Online Help

“Visual guide to Adobe Chart” in
Adobe Chart Online Help

Click here for titleClick here for title
Click here for subtitleClick here for subtitle

Click here for chartClick here for chart
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To add a chart using the chart tool

To create a chart slide master

Tip: If the prompt text or the chart
placeholder does not appear, choose
“Placeholder” from the Show menu,
and then check “Prompt text” on the
submenu.

In the “New slide master” dialog box,
base your new slide master on an existing
slide master, name your chart master, and
then click “OK.”

Remove any unwanted placeholders
from the chart master, and then
choose “Add chart” from the Master
menu.

Choose “Slide master” from the View
menu, and then choose “New…” from
the submenu.

Select the chart tool from the Persuasion tool palette, and
draw a rectangle on your slide to establish your chart’s
position and size.

In the new chart dialog box, select the chart type you want,
and then double-click a chart template thumbnail to open the
chart.

AdvolareAdvolare

To add a chart using a placeholder

In the new chart dialog box, select the
chart type you want, and then double-
click a thumbnail to open the chart.

Assign a chart slide master to a slide,
and then click the chart placeholder to
open Adobe Chart.

Click here for titleClick here for title
Click here for subtitleClick here for subtitle

Click here for chartClick here for chart
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Entering chart data

A The chart guide shows where sample
data, displayed in E, appears on a
standard chart.

B The row and column intersection for
the highlighted cell.

C Displays data sheet cell(s) assigned to
the chart position named in E.

D Assigns data in highlighted cell(s) to
a chart position in E.

E Chart position names.

F Automatically assigns data in a pre-
set and highlighted cell to a stan-
dard chart position.

G Chart button displays the chart.
From the chart, the data sheet but-
ton displays the data sheet.

H The edit line displays characters as
you edit or type.

Enter data for your chart in the
chart’s data sheet. You can either
enter your data over the sample data,
or clear the sample data and then
enter your own.

The cell to which a piece of data is
assigned in the data sheet determines
its function and position on the chart.
That is, you tell Adobe Chart which
cell corresponds to the title, data
range, or footnote on a chart. If you
enter your data over sample data,
keying your chart title over “Chart
title,” for example, you can set cell
assignments by selecting
“Autoscan.”

If you enter data on a cleared data
sheet, you’ll need to manually set cell
assignments.

Chart data sheet with sample data

EDCB

H
A

F

G

For more information
“Enter your data” in Adobe Chart
Online Help
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To enter data and set cell assignments

If you typed over sample data, click “Autoscan.” If you cleared
sample data, click “Set” to make cell assignments. (Type in all
your data before setting assignments.)

To display the data sheet from Persuasion

Clear any cells that contain only sample data, and then click
“Show” to review your chart assignments.

Click an insertion point in a cell and type your data. Press
Return to enter the data in the cell.

From the Adobe Chart control palette, click the data sheet
button.

Click the Chart badge on the slide to display the Chart menu,
and then choose “Edit.”

AdvolareAdvolare

To set cell assignments, select a cell or a range of cells, and
then choose a chart position name from the popup menu.
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Copy and paste selected data

Bringing in data created in
other applications

If you want to use data created in
another application, you have two
options for bringing it into Adobe
Chart:
• Import the data.
• Copy and paste the data.

You can import any text-only (ASCII)
data that is saved in tab-separated
(Tsv), comma-separated (Csv), or
space-separated (Ssv) format. You
can also import data saved in
Microsoft Excel file format.

Adobe Chart immediately sets
appropriate cell assignments if your
imported or copied data follows the
sample data format for your chart’s
data sheet. Otherwise, after import-
ing or copying data, you need to set
cell assignments manually.

Import an entire file

For more information
Entering chart data .............................. 96

Publish and subscribe ........................ 146

“How to publish and subscribe in
Persuasion” in Online Help

“Setting the cell assignments” in Adobe
Chart Online Help

If you want to use only a portion of the data from another application in Adobe Chart,
copy and paste the data.

If you want to use all the data from another file, import the file into Adobe Chart.

Tip: If you want Adobe Chart data
to update automatically when you

update data in the original
application, publish the original

data as an edition file. Then, open
Adobe Chart as a standalone

application and subscribe to the
edition file.
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To import data from an application

Select the file you want to import, and
then click “Open.”

In the “Import” dialog box, specify a file
type for the data you’re importing.

In the Adobe Chart data sheet, choose
“Import data…” from the File menu.
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Change your chart type

Change the look of a chart

After you create your chart, you may
find that your chart type doesn’t
effectively show the data or that the
arrangement of data conceals
important information.

You can change the way your chart
looks by:
• Changing the chart type.
• Reversing the position of your

data to bring obscured data to the
foreground.

• Resizing your chart.

Each chart type has additional
options for restructuring your data.
Detailed information about each
chart type and its options is available
in Adobe Chart Online Help.

Browse through chart types by choosing individual thumbnails from the Gallery menu.

For more information
“Select a chart type” in Adobe Chart
Online Help

Tip: If you get a warning message after changing your chart
type, you may need to enter additional information or reset

the data range chart assignment for the new chart type.
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Reverse series or categories of data

Resize your chart

After you place a chart in Persuasion, you
can change its size by dragging its resizing
handles. Resizing may distort objects or
text. Choosing “Redraw” from the OLE
badge popup menu can refine your
chart’s resolution.

You can emphasize different parts of
your 3d chart or reveal obscured data.
Experiment with reversing either series
(dependent data, like location) or catego-
ries (independent data, like time of day)
using “Data reversal” from the Adobe
Chart menu.

Tip: To resize a chart to its original
dimensions, choose “Restore to

original size” from the OLE badge
popup menu.
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C D

B DC

G HE F

A

A The pointer tool selects chart ob-
jects, tools, and commands.

B The popup menu tool displays
popup menus on chart objects that
you can use to modify chart objects.

C The eyedropper tool copies and ap-
plies colors, patterns, and fills from
one object to another.

D The data sheet button displays the
data sheet. From the data sheet,
the chart button displays the chart.

E Displays the special effects (SFX)
palette.

F Displays the color palette.

G Displays the text palette.

H Displays the 3d view palette.

A Lists available fonts.

B Lists font sizes.

C The bold, italic, and underline but-
tons determine text style.

D Text alignment buttons.

E The autofit button proportionally
resizes text when you resize a text
block.

The Adobe Chart control palette

Adobe Chart text palette

E

BA

Modifying individual chart
components

Modifying charts in Adobe Chart is
similar to modifying graphics in
Persuasion: select the component you
want to change, and then select the
appropriate tools and options from
the palettes.

When you add your chart to a
Persuasion presentation, the colors in
the Adobe Chart color palette are
those of your presentation’s “Stan-
dard” color model. The Adobe Chart
color palette functions like the
Persuasion color palette. However, to
edit colors on a chart, use the
Persuasion color palette.

Tip: For faster screen redraw in
Adobe Chart, hide all the text and

graphic elements you are not
working on by choosing “Display

status” from the Chart menu.
You can also cancel screen redraw

by pressing Esc.

For more information
Adding colors and fills ....................... 120

“Chart elements” in Adobe Chart
Online Help

“Edit the chart” in Adobe Chart Online
Help
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To proportionally resize text

To show popup menus

With the pointer tool, select the text
block you want to resize.

Click the autofit button on the text
palette, and then drag the handles on a
text block to the size you want.

Tip: Not all chart text can be propor-
tionally resized. If handles—not solid
boxes—appear when the text block is
selected, the text can be resized using
the autofit button.

Reipublicae FormaReipublicae FormaReipublicae Forma

To copy fills from one chart object to another

Select the popup menu button, and
then click and hold a chart object until
the menu appears from which you
can edit the object.

Click with the eyedropper tool on the object you want to fill.

20

0

4

8

10

16

Cumulonimus Cirrus StratusAltostratus

Select the eyedropper tool from the control palette, then click
the object whose color, fill, or graphic you want to copy.
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Special effects and
3d charts

Special effects enhance the look of your chart

To add scans or graphics

Select the chart component to
which you want to add the
graphic, and then click “Pictures”
on the SFX palette.

Choose the graphic you want to
add from the lower popup menu,
and then click the ”Apply effect to
selection“ button on the SFX
palette.

a Add custom gradient fills to chart
backgrounds or components.

b Add graphics to chart backgrounds or
components.

c Determine a viewing angle that em-
phasizes your data.

In addition to Adobe Chart’s tools for
manipulating text and color, you can
use two additional palettes to change
the way your charts look: the special
effects (SFX) palette, for both two or
three dimensional charts, and the 3d
view palette. Display these palettes by
clicking the appropriate button on
the control palette.

Tip: You can add graphics,
including clip art, to charts by

saving them in the “Effects” folder
of the Chart folder. Graphics in this

folder appear in the “Pictures”
popup menu on the SFX palette.

a

b

For more information
Modifing individual chart
components ...................................... 102

“Add special effects to your chart” in
Adobe Chart Online Help

“Emphasize portions of data” in Adobe
Chart Online Help

“Preset viewing angles in 3d charts” in
Adobe Chart Online Help

c
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To apply a gradient fill to a chart object

On the 3d view palette, select the aspect
you want to change, and then click the
arrows in the 3d model to make
incremental changes.

Tip: Expand the SFX palette if you
want to change the start or end color
for your fill.

Select an object, and then click the 3d
view button on the control palette.

Click the “Apply” button on the 3d
view palette to see your changes.

To change the viewing angle on a 3d chart

Select the chart object you want to fill. Select the fill you want from the popup
menu.

Click the special effects button on the
control palette to display the SFX palette,
and then click the ”Gradients“ button.

Click the “Apply effect to selection”
button on the SFX palette to see the
change on your chart.

Choose a direction in which the fill
should flow from the “Direction”
popup menu.
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Adding an organization
chart

To work with your organization chart
as a graphic, ungroup it first. Then
you can make changes in the
connecting lines or change the shape
of individual boxes.

Ungrouped organization charts no
longer reflect changes made in the
outline.

Use organization charts to show a
company’s reporting structure, or to
show other types of hierarchical
information.

You create organization charts in
Persuasion by entering your text in
the outline, and then assigning an
organization chart master to the
slide. Each AutoTemplate that comes
with Persuasion has an “Org Chart”
slide master containing a placeholder
for a three-level organization chart.
Each level holds up to five boxes. If
you chart is more detailed, you can
create a new organization chart
master. Be aware that larger organi-
zation charts can be less readable.

You modify an organization chart by
selecting the part you want to
change and working with the
Persuasion text, color, and line
palettes.

Outline levels correlate with chart levels

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

Reipublicae Forma

Reipublicae forma
   Praefectus
        Rector
        Eques
             Opifex
             Operarius
        Curator
              Artifex
              Pedisequus

a The first level on the outline represents
the slide title.

b The first level of body text represents
the top level in your organization chart.

c Each subordinate heading represents a
lower level on an organization chart.

Tip: Choose “Round corners” from
the Draw menu to turn your boxes

into more round-cornered
 rectangles or ovals.

For more information

Adding colors and fills ....................... 120

Entering text in the outline .................. 64

“Formatting organization charts on slides
and slide masters” in Online Help

“Making an organization chart”
in Online Help

“Setting up an organization chart
placeholder” in Online Help

a

b

c
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To add an organization chart to an AutoTemplate presentation

Create a new slide in the outline, and
then enter the slide title.

Type the levels of your organization chart
as subordinate headings.

Choose “Org Chart” from the master
popup menu at the bottom of the
window.

To modify parts of your organization chart

To modify the entire chart, click the
chart once with the pointer tool and
then select options from the text, line,
or color palette.

To modify a whole level of boxes or
lines, double-click the level with the
pointer tool, and then select options
from the text, line, or color palette.

To modify an individual box or line
on a slide, double-click the box or line
twice with the pointer tool, and then
select options from the text, line, or
color palette.

1 Reipublicae forma
   Praefectus

Reipublicae forma
   Praefectus
        Rector
        Eques
             Opifex
             Operarius
        Curator
             Artifex
             Pedisequus

1

Tip: To modify text in the organization chart, triple-click the text with the pointer tool,
and then edit the content and the format of selected chart text.
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Tailoring your organization
chart

You have two primary ways to modify
the size and shape of your organiza-
tion chart boxes and the space
between them:
• Change the size of the organiza-

tion chart on the slide.
• Create a new organization chart

placeholder with a different
number of boxes and levels.

You establish box and level settings
for an organization chart when you
create it. The settings you choose are
a guide and do not restrict the
number of boxes or levels you can
enter.

For best results, try to estimate as
closely as possible the number of
levels and boxes you’ll need for your
organization chart. When you add
more levels or boxes, the shape of the
boxes will change to accommodate
the data. When you add more levels,
the additional levels take on the
format of the next-to-last level.

Formatting options for the lowest level

A

B
C

A Choose a setting as close as possible
to the number of levels you expect
to use on your slide.

B Enter the maximum number of boxes
you are likely to require on any given
level of your chart.

C Select a display option for the lowest
level of your organization chart.

The “Add org chart…” dialog box

The information in the lowest level of your organization chart can be formatted in three
ways, as a list, a boxed list, or separate boxes, depending on the option chosen in the
“Add org chart…” dialog box.

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

Reipublicae Forma

OperariusOpifex
Opifex

Operarius
Opifex

Operarius

For more information
Model a slide master
after a slide you like ............................. 32

“Setting up an organization chart
placeholder” in Online Help

“Formatting organization charts on slides
and slide masters” in Online Help

ListBoxed listSeparate Boxes
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To modify box size

To make the organization chart boxes deeper, select the
chart with the pointer tool, and then drag either the center
top or bottom handle until the boxes are the depth you want.

To widen the organization chart, select the chart with the
pointer tool, and then click and drag the center left or right
handle until the boxes are the width you want.

Tip: You can proportionally resize your chart by clicking and dragging any corner handle. To change text size in resized boxes,
select the resized chart or chart level with the pointer tool, and choose a new point size from the text palette.

To create an organization chart master

Delete any organization chart or body text placeholder and
then choose “Add org chart…” from the Master menu. (A
single master can hold one organization chart or body text
placeholder, not both.)

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

Reipublicae Forma

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

Reipublicae Forma

Praefectus

Rector CuratorEques

Opifex PedisequusArtifexOperarius

In the “Add org chart… ” dialog box, enter the number of
levels and maximum number of boxes you need on any level.
Select a format for the lowest level and click “OK.”

Choose “Slide master” from the View menu, and then choose
“New…” from the submenu.

In the “New slide master” dialog box, base your new master on
an existing slide master, name it, and then click “OK.”
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C

B
A

D

Adding a table to a slide

Although you can create columns of
text in a body text placeholder, when
you want to add complex tables to
your presentation, use Adobe Table.
Adobe Table is an integrated
application that opens automatically
when you draw a box with the table
tool in Persuasion.

Initially, your table fits into the box
you draw, but you can change its
dimensions any time by selecting the
table and dragging its side handles.

Parts of Adobe Table

A The rulers’ zero point.

B Select-all box.

C Row-select zone.

D Column-select zone.

A B

B Table height and width dimensions
reflect the box size you drew on
your slide.

A Defines the current number of rows
and columns in your table.

“Table format” dialog box

Tip: When you type text into a
table cell and it wraps in the cell,
all the cells in that row become

taller. To create wider cells, move
the cursor to the row-select zone.
When it turns into a double arrow,

click and drag it to the width
you want.

For more information
Creating multicolumn text ................... 60

“Place your table in another application”
in Adobe Table Online Help

“Set the table and text defaults” in Adobe
Table Online Help
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Tip: Choose “Restore to original size” from the table’s OLE badge popup menu
to restore your table to its Adobe Table dimensions.

To create a table

Click in a cell and type your text. Press
Tab to enter your text and move to the
cell on the right. Use the arrow keys to
navigate through cells.

When you finish entering text, choose
“Update” from the File menu.

Choose “Close” or “Quit and return
to” from the File menu to return to
Persuasion.

In Persuasion, display the slide on which
you want to add a table, and select the
table tool from the tool palette.

Click where you want the upper-left
corner of the table to begin, and then
drag the cursor diagonally to create a
rectangle the size of your table.

When Adobe Table opens, choose
“Table format...” from the Edit menu.
In the “Table Format” dialog box, type
the number of rows and columns you
want, and then click “OK.”

AdvolareAdvolare AdvolareAdvolare

AdvolareAdvolare

Operarius

CuratorEques

Opifex

Praefectus Rector
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Using tables from other
applications

If the text you want to use in your
table already exists in another
application, you have two options for
using it in Adobe Table:
• Copy and paste the table text

from the source application into
Adobe Table.

• Import the file.

Text files that you import must have
these characteristics:
• Columns are separated by tab

characters.
• Rows are separated by returns.
• The file is saved in text-only (ASCII)

format.

To import table text

In Adobe Table, create a table and click
an insertion point where you want the
upper-left table entry to appear.

For more information
“Import text from other applications” in
Adobe Table Online Help

“Maintaining links with other
applications” in Adobe Table Online Help

In the dialog box, locate the file you want to import, and click “Open.”

Choose “Import text...” from the File
menu.
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Use the text palette in Adobe Table
to change the text formatting in
your table.

You can modify the contents of a cell,
a row, a column, or the whole table
depending on which cell or zone
you select.

Modify table text

The text palette

Tip: To change the default settings for font, point size, style,
alignment, or character and line space settings, choose “Text

format...” from the Edit menu, and make your changes. Then, in
the “Text format” dialog box, click the “Set default” button.

A G

B C E FD

A Font popup menu

B Type style buttons

C Horizontal-alignment buttons

D Character-spacing buttons

E Line-spacing buttons

F Vertical-alignment buttons

G Point size popup menu

For more information
“Format table text” in Adobe Table
Online Help

“Edit your table” in Adobe Table
Online Help
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Changing table borders and
margins

Use the table palette in Adobe Table
to modify the table borders and
margins. You can change table
borders one row or column at a time
or for the whole table. You can also
change the border of a single cell by
selecting that border. Table margins
can be changed when you click the
select-all box in the upper-left corner
of the table.

Within a table, you can apply a single
color to lines and a single color to
text by using the Persuasion color
palette. Unless a colored object is
placed behind your table, it will
appear transparent and take on the
background fill of your slide.

The table palette

A

B

C
D

A Cell border lines.

B Line weight popup menu.

C Horizontal nudge buttons.

D Vertical nudge buttons.

Tip: To add colors to table lines
or text, click either the line or the
text button on Persuasion’s colors

palette, and then click a color.
To remove colors from your table
and restore it to its original color,

use the no-fill swatch.

For more information
Adding colors and fills ....................... 120

Working with imported graphics ......... 78

“Adding a color to tables” in Online Help

To create a background for a table

AdvolareAdvolare

Operarius

CuratorEques

Opifex

Praefectus Rector

Choose “Send” from the Draw menu, and then choose “Backward” from the
submenu until the shape is positioned behind your table.

AdvolareAdvolare

Operarius

CuratorEques

Opifex

Praefectus Rector

Select a drawing tool, such as the
rounded-corner tool, and then draw
the shape you want.

Click the fill button on the palette, and
then click a color swatch.
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Tip: To make your new table borders and margins the default settings, choose “Table format...” from
the Edit menu. In the “Table format” dialog box, click “Set default.”

To change the width of the table lines

In the “Cell borders” selection box, click the proxy for the cell
line you want to change, and then choose a line weight from
the “Line” popup menu.

Select the lines you want to change by clicking a cell line or
table zone.

To change column or row margins

Click the appropriate horizontal or vertical nudge button on
the table palette.

Click the select-all box in the upper-left corner of the table.

Select the cells you want to merge together. Choose “Merge” from the Edit menu.

To merge table cells
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Color basics

Tools for working with color

A The working set allows quick access
to the colors you use most often.

B The color scheme contains both col-
ors and powerful editing and appli-
cation tools.

C The color spectrum represents colors
from a broad range of both hue and
lightness.

D Lists Persuasions color systems.

E Patterns and graduated fills. You can
color either the foreground and/or
background of a pattern.

Note: Some patterns do not image on
high-resolution film recorders. Check
with your film recorder source before
using them for a 35mm presentation.

A B C

E

The Persuasion color palette consists
of three sections, giving you a wide
range of color choices and making it
easy to access to the colors you use
most often. The three sections are the
working set, the color scheme, and
the color spectrum.

Although there are specific reasons to
use colors from each section, you can
apply color to any text, line, or
graphic from any swatch in any
section on the color palette.

D

For more information
Change color systems for
your output ....................................... 128

“Adding colors, patterns, and shadows to
objects” in Online Help

“Using the color palette” in Online Help
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VenturaeVenturae
VenturaeVenturae

When to use which section of the color palette

The color scheme is a powerful tool
for changing the overall look of a presen-
tation quickly. If you edit or replace a
color swatch in the color scheme, all the
objects in your presentation colored from
that swatch reflect your change.

You can only edit colors in the color
scheme. Copy colors from the working set
or the color spectrum to the color scheme
if you want to edit them.

Since the colors in the color spectrum
do not change automatically when the
color scheme is replaced, use them when
you want to maintain consistent colors for
objects. Even if you import a new color
scheme, colors applied directly from the
color spectrum will remain unchanged.

Use colors from the working set if you
want to access them from the collapsed
color palette. In the AutoTemplates that
come with Persuasion, working set colors
correspond to the first two columns of
the color scheme and are named after
their use, for example “Title” instead of
LB9.

You can copy colors into the working set
from both the color scheme and the color
spectrum.
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Adding colors and fills

The collapsed color palette

A Line button.

B Fill button.

C Text button.

D Shadow button.

E Changes the foreground or back-
ground of a line, fill, or shadow.

F No fill.

G Solid fill.

H Collapses and expands the color
palette.

I Working set colors.

J Graduated fills.

A B DC

E

F
G

I

In Persuasion, you can apply color
and a variety of patterns to objects
drawn in Persuasion, shadows, and
some imported objects. For example,
you can apply color to PICT graphics.
EPS graphics and scanned images
including Photo CD images cannot be
colored by Persuasion.

You can also apply color to text and
text shadows, and use different
colors for the foreground and
background of a pattern. For
example, you can create red bricks
with gray mortar using the brick
pattern.

H

J

For more information
Changing bullet style ........................... 52

Creating a working set of colors ........ 122

Working with imported graphics ......... 78

Working with shadows ........................ 90
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To apply color to a text block

To apply a fill to an object

To apply color to text

With the text tool, select the text and then click the text
button on the color palette.

Caelum Caelum

CaelumCaelum CaelumCaelum

With the pointer tool, select the object
you want to fill, and then click the fill
button on the color palette.

Select a fill from the color palette, and
then select a color from the color palette.

Tip: If you’ve applied a pattern to an
object, you can color the background
by choosing “Fill background” from
the “Fill” popup menu, and then
choosing a color from the color palette.

Select a color from the color palette.

With the pointer tool, select the text block, and then click the
object button on the color palette.

Select a color from the color palette.
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The working set

Tip: When you build a working set
from colors in the color scheme

and map the colors together, if you
change a color scheme color, the

corresponding color in the working
set changes too.

Click here for titleClick here for title
Click here for subtitleClick here for subtitle

• Click here for body text• Click here for body text

The working set is a handy tool
because you can work with it when
the color palette is collapsed. You can
copy colors into the working set from
either the color scheme or the color
spectrum.

When you build a working set from
colors in the color scheme, the colors
are mapped together. That is, if you
change a color scheme color, the
corresponding color in the working
set changes too.

If you’re using Persuasion’s “Stan-
dard” color system, color spectrum
colors placed directly into the
working set will not change if you
bring in a new color scheme.

Creating a working set of
colors

In the AutoTemplates that come with Persuasion, the names of working set colors re-
flect their application and are mapped to the colors in the left two rows of the color
scheme.

The “Edit colors” dialog box

A The working set.

B The color scheme.

C The color spectrum.

D Displays the Color Picker.

E Copy and paste colors between
sections of the color palette and
between presentations.

A B C

H

F Percentages of color present in the
highlighted color swatch.

G Color models you can match colors
in.

H Renames a selected color swatch in
the working set.

G

D

E

F

For more information
Color basics ....................................... 118

Creating a new color scheme ............ 126
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To add a color to the working set

Double-click any color swatch on the color palette to open the
“Edit colors” dialog box.

In the “Edit colors” dialog box, select the color you want to
move into the working set, and then click “Copy.”

To rename a working set color

Double-click any color swatch on the color palette to open the
“Edit colors” dialog box.

In the “Edit colors” dialog box, click the color in the working
set you want to rename, type the new name in the “Rename”
box, and then click “OK.”

To copy from the color spectrum and map the working set
colors to the color scheme, paste a color swatch into the color
scheme, and then copy and paste it into the working set.

To copy from the color scheme, select a working set swatch
to replace, and click “Paste.”
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Tools for matching colors

A The color scheme.

B The new color.

C The color models you can approxi-
mate.

D Color model percentages.

Tip: Only color scheme colors can be
edited in the “Standard” color sys-
tem. In all other color systems, both
color scheme and color spectrum col-
ors can be edited.

C DBA

Matching imported graphics
colors When you import a colored
graphic, its colors do not automati-
cally show up in the color palette,
but you can add them by creating
matching colors. To match a CMY or
HLS color, note the color model and
exact percentage values for the color
you want to match. For example,
note the percentage of cyan,

Matching print colors

magenta, and yellow in a CMY
model. Then, create a matching color
in the color scheme.

The colors will be reproduced in the
closest approximation of the CMY,
HLS, or HSV color possible.

In Persuasion, you may want to
match print colors to reproduce logos
or other colors that have precise color
values. Using the RGB color model,
you can match a print color by edit-
ing any color in the color scheme.

Understanding color models Color
graphics created for commercial
printing presses usually use the CMY,
CMYK, or HLS color models.
Persuasion uses the RGB (red, green,
blue) color model, which is the
standard for all video technology,
including computer monitors,
televisions, video screens, and film
recorders.

RGB defines color in terms of trans-
mitted light, whereas other print-
oriented color models—CMY or
HLS—for example, define color in
terms of reflected light.

For more information
Color basics ....................................... 118

Working with imported graphics ......... 78

“Color and imported graphics” in
Online Help

“Color models” in Online Help



CHAPTER 7: PERSUADE WITH COLOR 125

Double-click any color to open the “Edit colors” dialog box.

To match a color

In the “Edit colors” dialog box, click a color in the color
scheme, and then click “Edit…” to open the Color Picker.

Choose a color from the wheel, or choose a color model and
enter the correct values for your new color, and then click
“OK.”

To name the color, copy the new color into the working set,
rename it, and click “OK.”

Tip: If you need to match a CMYK
color, convert the CMYK values

into a CMY color by increasing the
CMY values by the amount of the

K value.
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Creating a new color
scheme

Copy and paste individual color
swatches You can use any color from
the color spectrum in your color
scheme. You copy colors into the
color spectrum the same way you
copy colors into the working set.

When you’ve created one or two
colors that you want to use in
another presentation, the easiest way
to transfer them is to copy them from
one presentation to another.

Replace a color scheme to change
the overall look of a color presenta-
tion quickly.

When you replace a color scheme, all
the objects colored from any swatch
on the color scheme change to match
the new color. You won’t need to
reapply new colors to each object
and slide individually.

Tip: Make your color scheme
colors accessible from the

collapsed color palette by building
them into the first two columns.

When you bring new colors
into your color scheme or working

set from another color scheme,
your names will remain

unchanged.

When you design a presentation from
scratch, you will want to build your
own color scheme. There are three
ways to do this:
• Copy and paste any of the colors

from the color spectrum into the
color scheme.

• Edit the values of the existing
color swatches in the color
scheme.

• Copy in an entire color scheme.

For more information
Color basics ....................................... 118

Creating a working set of colors ........ 122

“Using the color palette” in Online Help
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To replace a presentation’s color scheme

In the “Edit colors” dialog box, select the color swatch in the
color scheme which you want the new color to replace. Click
“Paste,” and then click “OK.”

To copy and paste individual color swatches

In the presentation you want to copy
from, double-click any color on the color
palette.

In the “Edit colors” dialog box, select
the color you want to copy, click
“Copy,” and then click “OK.”

Open the presentation into which you
want to copy colors, and then open the
presentation from which you want to
copy colors.

Choose “Change design” from the File menu, and then
choose “Copy colors…” from the submenu.

In the dialog box, select the presentation or AutoTemplate
whose colors you want to use, and then click “Open.”

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesentDolore magna

Commodo consequat
Duis autem
Dignissim

Commodo consequat
Duis autem
Dignissim

Select the title bar of the presentation into which you want to
copy, and then double-click any color in the color palette.
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Change color systems for
your output

How color systems affect changes
to colors If you edit a color scheme
color while you’re working in the
“Standard” color system, your edit is
reflected in the color scheme of all
the color systems, which are subsets
of “Standard.” However, if you edit
colors in any of the other color
systems, the change will apply only to
the scheme of the color system you
edit.

Note: You cannot edit color spectrum
colors in the “Standard” color
system, but you can edit color
spectrum colors under all the other
color systems.

Use custom systems 1 or 2 to create
color systems targeted to meet
requirements of your output devices.
For example, every film recorder
reproduces colors with some slight
variations. You could create a custom
color system to accommodate those
variations

You can create and edit colors in
custom system 1 and 2 the same way
you edit colors in the “Standard”
color system.

Persuasion’s color systems let you
easily tailor one presentation for
several output devices. For example,
you may want to produce the same
presentation on black-and-white
overheads, on 35mm slides, and on
videotape. Instead of reassigning
individual colors to the content of
every slide each time you need to
produce your presentation on a
different output device, you can
quickly and easily switch color
systems. Except for the colors, the
presentation itself is not changed.
Note that QuickTime movies always
play using the “Standard” color
system.

You can change color systems from
either the color-system popup menu
on the color palette or by choosing
“Color systems” from the Show
menu.

Tip: Only colors from the
“Standard” color system colors

transfer between Macintosh and
PC environments.

For more information
Printing 35mm slides ......................... 208

Proofing 35mm slides ........................ 206

“Color systems Persuasion supports”
 in Online Help

“Creating a custom color system”
in Online Help
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Color systems and output devices

Use this color system For this output device

Standard Color monitor, projector, film recorder, color laser printer

Grayscale Grayscale monitor or laser printer

Inverse grayscale Laser printer (prints a reversed copy of the entire slide, or of all but selected objects for
proofing)

Black and white Laser printer (black-and-white overheads or proof prints)

NTSC US video and television

PAL European video and television

Custom 1 and 2 Customize to suit your specific film recorder color shifts or other output device

Using color systems effectively

Suppose you create a color presentation
in the “Standard” color system that looks
good on your color monitor. Then you
learn that you need to print black-and-
white overheads. By choosing the gray-
scale or inverse grayscale color system,
you can convert the presentation to look
good in black and white. If necessary, you
edit any gray value applied under the
“Standard” color system.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Standard Inverse Grayscale
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Replacing custom color
systems

Tools for replacing color systems

A When checked, replaces any edited
colors in the color scheme and the
color spectrum. Leave this option un-
checked if you do not want to re-
place colors you have edited.

B List of color systems. A selected
color system replaces its same-
named counterpart. “All” replaces
all the color systems.

If you’ve designed a custom color
system for a specific output device,
such as a film recorder, you can use it
in any presentation by replacing a
color system with the custom one.

You can replace a specific color
system or replace all the color
systems in a presentation at once. For
example, if an international division
will produce your presentation on
video, you may want to replace all
the color systems to ensure your
presentation maintains its look
worldwide.

Color systems replace only their
same-name counterparts. If you
replace “Custom 1” while using
“NTSC,” “NTSC” is not replaced.
Only “Custom 1” is replaced.

A B

For more information
Change color systems for
your output ....................................... 128
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To replace color systems

Find the presentation or AutoTemplate
with the color system you want to use.

Choose “Change design” from the File
menu, and then choose “Copy
colors...” from the submenu.

In the dialog box, select the color
system you want to import from the
“System” popup menu, or choose
“All” and click “Open.”

Tip: Click “Replace color system edits” if you want to override all edits you have
made to the color spectrum of the color system you are replacing.
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Color variations between
computer monitors

Factors that affect color display
When you need the colors on more
than one monitor to match exactly
(for example, if you’re developing a
presentation on one monitor and
presenting it on another), you can
create a controlled environment in
which to view your presentation.

You can invest in color-calibration
hardware, such as the Radius
PrecisionColor Calibrator or the
RasterOps Calibrator, to calibrate
your monitors. You may need to
recalibrate the monitors frequently to
maintain the calibration.

You should also control the lighting
around the monitors. Avoid daylight
settings in favor of artificially lit rooms
with a constant brightness. By
carefully controlling these variables,
you can experiment more accurately
on the screen with the colors in your
presentation.

Some monitors display a green or blue
tint that affects the appearance of colors.

The lighting in a room affects your per-
ception of colors on the monitor.

Adjusting the monitor brightness affects
your perception of color on the monitor.

The age and average temperature of a
monitor affect the way it displays color.



Chapter 8: Moving Things Into and Out of Persuasion

C H A P T E R

8
Moving Things
Into and Out of

Persuasion



134 ADOBE PERSUASION 3.0 USER MANUAL

Methods for moving things
into and out of Persuasion

When you want to include text,
graphics, or spreadsheets that were
created in other presentations or
applications in your Persuasion
presentation, you have four options:
• Copy and paste
• Import
• OLE-embed
• Subscribe to an edition file

When you want to make slides,
outlines, or entire presentations
created in Persuasion accessible to
other applications, you have three
options:
• Copy and paste
• Export
• Publish a slide

For more information
Exporting outlines ............................. 141

Exporting slides ................................. 142

Import presentations from
other applications .............................. 138

Importing graphics ............................ 136

Importing text to the outline .............. 140

Object linking and embedding (OLE) ... 144

Publish and subscribe ........................ 146
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Using information from other applications

Method Advantages Use for

Copying and pasting • Fast and convenient. • Simple PICT graphics
• Most applications have copy • Copying text from a word-processing
and paste commands. application into the outline

Importing • Works with large and small files. • EPS graphics created in graphics programs
• Allows you to use files created in applications or complex scans
you don’t have access to. • Presentations created in other applications

• Text files in ASCII format
• Sounds for use as slide or layer transitions
• Movies

OLE-embedding • From within Persuasion, create and edit • Complex graphics, charts, tables, and
an object using the source application. spreadsheets
• No additional files created.

Subscribing • The Persuasion file reflects changes made • Spreadsheets or graphics that are
in the original application file. updated regularly

Sharing Persuasion information

Method Advantages Use for

Copying and pasting • Fast and convenient. • Copying a slide from one presentation
• Most applications have copy and paste to another or from a Persuasion presentation
commands  to another application

• Copying text, graphics, movies, or sounds
between slides, slide masters, and presentations

Exporting • Puts Persuasion information into a format • Slides you want to use in another other
applications can use. application

• An outline you want to incorporate into a
word-processing file
• 35mm slides made using certain film recorders or
slide service bureaus
• On-screen presentations run on computers
using the Player

Publishing • More than one other application or file can • A slide you want to incorporate in more than
use the same Persuasion edition file. one other application or Persuasion file
• Updates to the slide are reflected in the
applications using the edition file.
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Importing graphics

”Adjust Photo CD image” dialog box

A When “Overview.PCD;1” is selected,
use the scroll bar to browse images.

B Size (in bytes) of the image.

C Flips the image around its vertical
axis.

D Rotates the image in 90-degree in-
crements.

E The greater the depth (bits/pixel) the
finer the color distinctions.

F  The higher the resolution, the larger
the dimensions of the image and the
larger the file size. Choose higher
resolutions for 35mm or overhead
presentations.

A

C

D

E

F

Locate the Photo CD image you want to import

A Folder containing files for each indi-
vidual image.

B Catalog file you can browse for a
specific image.

You can import graphics into
Persuasion from a variety of sources,
including drawing or paint programs
and clip art collections. Persuasion
accepts graphics in PICT, PICT II,
Windows Metafile (WMF), encapsu-
lated PostScript (EPS), QuickTime, and
Photo CD formats.

Import when:
• a graphic is too large to copy to

the Clipboard.
• you want to use a graphic such as

clip art or a scanned image
created in an application you
don’t have access to.

• you want to use an EPS graphic
created in a graphics program
(such as Adobe Illustrator) and you
intend to print your presentation
on a PostScript device.

B
A

B

For more information
About QuickTime video movies ......... 170

Methods for moving things
into and out of Persuasion ................. 134

Working with imported graphics ......... 78
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To import a Photo CD image

Choose “Import” from the File menu,
choose “Graphics…” from the
submenu, and then in the dialog box,
locate and open the Photo CD.

Tip: If a Photo CD includes a QuickTime file called “Slide show,” import the file and
play it for a quick preview of all the images available on the CD.

Select the “Overview.PCD;1” file to
browse all the images (or open the
“Images” folder and select the image you
want to import).

In the “Adjust Photo CD image” dialog
box, if you selected “Overview.PCD;1”
in step 2, locate the image you want to
import, accept the default settings or
adjust the settings as needed, and then
click “OK.”

To import a PICT, PICT II, WMF, or EPS graphic

From the slide, slide master, back-
ground, or note page where you want
the graphic to appear, choose
“Import” from the File menu, and then
choose “Graphics…” from the
submenu.

In the dialog box, locate and select the
graphic you want to import, and then
click “Import.”

Note: Imported graphics appear in the
center of the slide. Reposition by
dragging the graphic; resize propor-
tionally by pressing Shift and dragging
a handle.
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Import presentations from
other applications

On slides to which the newly created
master is applied, text that corre-
sponds to placeholders (title, subtitle,
or body text) appears on the slides
and in the outline. Charts and tables
imported in Scrapbook files are PICTs
that you can’t edit using Adobe Chart
or Adobe Table.

You can import presentations created
in other applications, such as
PowerPoint and DeltaGraph, that
have been saved in Scrapbook
format.

Slides saved in Scrapbook format do
not have slide masters, so when you
import a Scrapbook file into a
Persuasion presentation, you can
create a new slide master modeled
after one of the imported slides, or
you can assign an existing slide
master to the imported slides.

When Persuasion creates a slide
master from a slide, it replicates the
slide’s background fill and pattern on
the slide master, unless you indicate
that the background should be
ignored. You can select graphics and
text from the slide that you want to
place on the slide master and you can
convert the independent text from
the slide into placeholders. Graphics
and independent text that you copy
to the slide master no longer appear
on the slide.

A Displays the selected slide.

B Lists the slides from the imported
and existing presentations (imported
slides appear in roman type, existing
slides in italics, and the model slide
for the slide master is underlined).

C Cancels the new slide master. Use
when you plan to apply slide masters
already in your presentation to the
imported slides.

D Models a placeholder after selected
text.

E Shows what status is assigned to
what objects.

F Prevents a selected object from ap-
pearing on your new slide master.

G Hides objects that won’t appear on
your new slide master.

H Creates a slide master from the
model slide.

I Assigns the new slide master to the
selected slide.

The “Choose master elements” dialog box

For more information
Methods for moving things
into and out of Persuasion ................. 134

Working with slide masters and
backgrounds ....................................... 26

A

B

E

C

D

F

G

H
I
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From a Persuasion presentation, choose
“Import” from the File menu, and then
choose “Graphics…” from the
submenu.

In the dialog box, select a presentation
saved in Scrapbook format, and then click
“Import.”

In the “Choose master elements”
dialog box, select the imported slide
that you want to model a slide master
after, and then click “Create master
from this slide.”

On the displayed slide, select the text you want for the Title
placeholder, and then click “Title.” Repeat for each type of
placeholder you want to add to your slide master.

Select each object you do not want on your slide master, and
click “Ignore.” Ignored objects still appear on the slide.

Tip: If you choose not to assign the newly created slide master
to an imported slide, that slide will have no slide master and it
will keep its original background fill as an object. If you assign
a slide master to the slide, you will need to select and delete
the background fill in order to see the background fill of the
slide master.From the popup menu, select each slide (if any) you do not

want the new slide master assigned to and uncheck “Slide
uses created master,” and then click “OK.”

To import a presentation
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Importing text to the
outline

When you’ve created text in another
application that you want to use in
your Persuasion presentation, you can
import the text into the outline.
Before you import the text, save it in
text-only (ASCII) format, which
retains return and tab characters but
not formatting instructions, such as
font, point size, and text style. You
can reformat the text after you
import it into Persuasion.

To preserve the relationship between
headings of different levels in an out-
line imported from a word-processing
file, tab to indicate subordinate
points. Persuasion translates return
characters without tab characters into
new headings.

Note: You can also import text
directly onto a slide as independent
text. You can select and format it, but
it won’t appear in the outline.

To import text

Click an insertion point in the outline
where you want the imported text to
start, choose “Import” from the File
menu, and then choose “Text…” from
the submenu.

In the import dialog box, locate the file
you want to import, and then click
“Import.”

Note: If you click an insertion point in a heading that includes subordinate
headings, the text is imported after the subordinate headings.

For more information
Methods for moving things
into and out of Persuasion ................. 134

Outline your presentation
to save time ........................................ 62
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Exporting outlines

To export part or all of an outline

In the outline, select the text you
want to export.

Choose “Export…” from the File
menu.

In the “Export” dialog box, select
“Outline selection” or “Entire
outline” from the popup menu,
enter the filename and choose
the format, and then click
“Export.”

 Options for exporting an outline

A The format most word-processing
applications can read.

B Formats for specific outline applica-
tions.

C Export the entire outline or selected
parts of an outline.

C

A

B

For more information
Outline your presentation
to save time ........................................ 62

Rearrange information
in the outline ....................................... 66

Exporting an outline means saving it
in a file format that other programs
can use. Usually, you’ll export outlines
in text-only (ASCII) format since most
word-processing applications can
read text-only files. Persuasion also
gives you the option of exporting in
formats the outline applications Acta
and More can read.
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Options for exporting slides

F Exports a separate slide for each
layer. Each slide includes the current
and all previous layers.

G Puts all movies and sounds in your
presentation into one QuickTime file
(available only with “Slide show” file
format).

H Exports a PICT or Scrapbook file for
use on a 16-color monitor.

Exporting slides

A Saves each slide or layer as a sepa-
rate PICT file, even when you export
all your slides.

B Groups all slides and layers into one
file.

C Format for slides you want to show
using the Player.

D Exports the current slide, all slides, or
all note pages.

E Exports background fill with the
slide. When unchecked, the slides
are transparent.

By exporting one or more of your
slides in PICT format, you can place
them into another application file,
such as a PageMaker document.

If you develop 35mm slide presenta-
tions, you may also need to export
your Persuasion slides in PICT or
Scrapbook format before the slides
can be produced. Ask your service
provider or read the documentation
for your film recorder to determine
the correct format for your files. A

B

C

D

E
F

G
H

For more information
Exporting outlines ............................. 141

Printing 35mm slides ......................... 208

What is the Persuasion Player? .......... 184
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To export one or all slides

To export selected slides

Tip: To export your note pages, follow the procedure for exporting a slide but start on a
note page and choose “Current note” or “All note pages” from the popup menu.

From a slide, choose “Export…” from the File menu. To export
one slide, make sure the slide you want to export is displayed.

In the “Export” dialog box, select “Current slide” or “All
slides” from the popup menu, choose the file format, and
then click “Export.”

In the slide sorter, hold down the shift key and select the slides
you want to export, and then choose “Export…” from the File
menu.

In the “Export” dialog box, choose the appropriate file format
and slide options, and then click “Export.”

Go Fly a Kite

Go Fly a Kite Go Fly a Kite
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Object linking and
embedding (OLE)

When you OLE-embed an object in
Persuasion, the object retains its
connection to the application in
which it was created (the source
application). This means that from
within Persuasion, you can create
and/or edit the object using the
source application.

For example, you can OLE-embed a
graphic created in Adobe IntelliDraw
on a slide. When you edit the
graphic, you open IntelliDraw
without leaving Persuasion. Edits you
make in IntelliDraw appear in the
OLE-embedded graphic on the slide.

You can OLE-embed anything created
in an application that supports OLE.
You can also simultaneously create
and OLE-embed an object by opening
the source application from within
Persuasion. Charts and tables you
develop within Persuasion are OLE-
embedded objects that you create
using Adobe Chart and Adobe Table.

Note: Persuasion 3.0 for the
Macintosh is an OLE client application
that supports OLE-embedding only.

For more information
Adding a chart to your slide ................. 94

Adding a table on a slide ................... 110

Methods for moving things
into and out of Persuasion ................. 134

“How to edit OLE objects in Persuasion”
in Online Help

Tools for creating and editing OLE-embedded objects

A Expands or collapses the tool palette.

B Tools for the applications that sup-
port OLE-embedding.

C Displays the badge popup menu
when selected.

D Opens the source application.

E Redraws charts and tables to elimi-
nate distortion after you resize them.

F Allows you to rename your object.

G Converts the object to a PICT that
you can ungroup.

H Restores the object to its original
size.

I With color system settings of
“Grayscale,” “Inverse Grayscale,” or
“Black and White,” adjusts shading
so you can tell adjacent bars apart
when they’re printed. (This option
only available on Adobe Chart badge
popup menu.)

A

B

H
G

F
E

D

C

I
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To create and OLE-embed an object

To OLE-embed an object you have already created

In the “Paste special” dialog box,
select the format appropriate for the
object’s source application, and then
click “OK.”

In the source application, copy the
object to the Clipboard.

Note: If you choose a format other than the one appropriate for the object’s source application (for example, “Picture” for an
IntelliDraw graphic) the object is pasted rather than OLE-embedded.

Open a Persuasion presentation. From
the slide where you want the object
placed, choose “Paste special…” from
the Edit menu.

AdvolareAdvolareAdvolareAdvolare AdvolareAdvolare

Praesent
Velit
Autem 
Feugiat

Expand the tool palette, select the tool
for the source application, and then click
an insertion point on your slide, or draw a
rectangle the size of the object.

When the source application opens,
create the object, choose “Close” from
the File menu, and then click “Update”
when prompted.

Open a Persuasion presentation, and
display the slide on which you want the
object placed.
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Publish and subscribe

The process of publishing and subscribing
Publishing an object makes an edition
file containing that object available to
other applications. Subscribing allows
an application to use an edition file.
Publish an object when you revise it
frequently and/or when you want to
include it in more than one other
application.

When you publish an edition file, you
can subscribe to it from as many
other files as you want. You can
decide to have modifications you
make in the publishing file automati-
cally appear in the edition file and in
all of its subscribers.

Persuasion can both publish and
subscribe. For example, you can
publish a slide you want to include in
both a PageMaker and a Microsoft
Word document, and you can
subscribe to an Adobe Illustrator
graphic that you want to include in a
Persuasion presentation.

b

a c

a The publishing file contains the object you publish as an edition file.  b The edition
file is a separate file created when you publish an object. c The subscribing file is the
file in which you place the edition file. ddddd The subscriber is the object that appears in the
subscribing file when you subscribe to an edition.

d

For more information
Methods for moving things
into and out of Persuasion ................. 134
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To publish a slide

To subscribe to an edition

From the slide you want to place the edition on, choose
“Editions” from the Edit menu, and then choose “Subscribe
to…” from the submenu.

In the dialog box, locate and select the edition you want to
subscribe to, and then click “Subscribe.”

In the dialog box, decide where to
save the edition file, type its name,
and then click “Publish.”

Save changes to your presentation to
save the slide as an edition file.

From the slide you want to publish,
choose “Editions” from the Edit menu,
and then choose “Create publisher…”
from the submenu.



148 ADOBE PERSUASION 3.0 USER MANUAL

Updating edition files and
subscribers

Options for updating edition files

C Deletes the edition file. Subscribing
files retain unlinked copies of the
edition file.

D Updates the edition file.

A C

DB

A Updates the edition file every time
you save changes in the publishing
file.

B Lets you control when Persuasion
updates the edition file.

After you publish an edition file, you
can decide whether to update it
automatically each time you change
the publishing file or only when you
specify.

After you subscribe to an edition file,
you can decide whether the sub-
scriber will be updated automatically
every time the edition file is updated
or only when you specify. You can
also launch the application that
produced the original file and the
edition file and modify the original
without leaving Persuasion.

Options for updating subscribers

A Updates the subscriber in Persuasion
automatically every time you update
the edition file.

B Lets you control updates to the sub-
scriber.

C Breaks the link between Persuasion
and the edition file.

D Opens the publishing file where you
created and published the original
object.

E Updates the subscriber in
Persuasion.

A

B D
E

C

For more information
Publish and subscribe ........................ 146
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To define when an edition file will be updated

From the slide defined as a publisher,
choose “Editions” from the Edit menu,
and then choose “Publisher op-
tions…” from the submenu.

In the dialog box, select the “Send
Editions” options you want, and then
click “OK.”

To define when a subscriber will be updated

Select the subscriber’s badge, and
then choose “Open publisher” from
the popup menu.

In the publishing file, modify the original
object, choose “Save” from the File
menu, and then choose “Quit” or return
to Persuasion 3.0.

To modify a subscriber

To update an edition file manually,
click “Send Edition Now” in the
publisher-options dialog box.

In the subscriber options dialog box,
select the “Get Editions” options you
want, and then click “OK.”

To update a subscriber manually, click
“Get Edition Now” in the subscriber
options dialog box or choose it from
the popup menu on the badge.

Double-click the subscriber (or click the
badge and choose “Subscriber
options…” from the popup menu).

If you’re updating the subscriber
manually, select the badge on the
object and choose “Get Edition Now”
from the popup menu.
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Transferring files between
Macintosh and Windows

When you need to revise or edit a
presentation or AutoTemplate on
another platform, save it as an
interchange file before you transfer it
between platforms. (If you only want
to play, not edit, a Macintosh
presentation in Windows, export the
presentation as a Player file).

When you transfer Persuasion 3.0
presentations between the Macintosh
and Windows, all masters transfer. By
planning ahead, you can adjust the
few features that change between
platforms.

If you transfer presentations fre-
quently, create compatible
AutoTemplates on each platform that
adjust for feature differences. When
you transfer a presentation created in
a compatible AutoTemplate, open it
in the equivalent AutoTemplate on
the other platform.

To preview how your presentation or
AutoTemplate will look on the new
platform, save it as an interchange
file and then open it on the platform
where you created it. You can then
make adjustments before you
transfer the file.

Adjustments for successful file transfer

Both ways Adjustment

Fonts Since font substitutions occur when
fonts are not available on both
platforms, use fonts known to be
available on both platforms.

Organization charts Organization charts convert to the
destination’s placeholder style, so
reformat them on the destination
platform.

Lines with arrow heads or other Reapply endcaps in the destination
endcaps platform.

Object shadows Reapply shadows in the destination
platform.

Object linking and embedding (OLE) If the same application is not available on
(except for charts and tables created in the destination platform, convert the
Adobe Chart and Adobe Table) OLE-embedded object to a PICT,

ungroup it, and then transfer it.

Transition effects for slides or slide layers Reapply transition effects in the
destination platform.

Movies and sounds Add movies and sounds in the
destination platform.

Animated objects and autojumps Reapply animation and reset autojumps
in the destination platform.

EPS graphics Transfer the graphics to the destination
platform and import them.

For more information
Creating Player files ........................... 186

What is the Persuasion Player? .......... 184

“Creating a pair of compatible
AutoTemplates” in Online Help
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From Macintosh to Windows Adjustment

Multiple backgrounds Only the most frequently used background transfers. The
others are converted to slide masters. So apply “Background” to
all your slides before you transfer.

Different master orientations (wide or tall) Only the most-used orientation transfers, so orient all your slides
the same way before you transfer.

Page number placeholders Reapply page numbers in Windows.

Bullets applied to independent text using Add bullets to independent text by typing Option + 8 before
the “Bullet” command you transfer the file or add bullets in Windows.

Patterned lines Use only solid lines in presentations you intend to transfer.

PICT graphics Transfer separately and then import into Persuasion for Windows.

From Windows to Macintosh Adjustment

Multiple body text placeholders convert to one large body In the Macintosh file, convert the text from the second body text
text placeholder placeholder into independent text, and place it where you want

it on the slide.

Multiple organization chart placeholders convert to one Place the organization charts on separate slides before
organization chart placeholder transferring.

Breaks in the outline become blank lines Delete the blank lines in the Macintosh outline.

TIFF and other bitmaps (such as BMP and PCX) If possible, use other graphics formats; or, export the original
graphic in Windows metafile format (WMF), transfer it to
a Macintosh separately, and then import it into a Persuasion
presentation.

Windows metafile (WMF) graphics Transfer separately and then import into a Persuasion
presentation.

Transferring files between Macintosh and Windows .
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To transfer a Macintosh presentation or AutoTemplate to Windows

Move the interchange file from the Macintosh to Windows
using any linking program, such as Apple File Exchange or a
shared server, and then open the interchange file in
Persuasion 3.0 for Windows.

If the “Interchange master selection” dialog box appears,
choose an AutoTemplate in which you want the interchange
file to open or use masters from the interchange file itself, and
then click “OK.”

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent
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Go Fly a Kite

, Transferring files between Macintosh and Windows

Type a name of no more than eight
characters for your file, add a .prf (for a
presentation) or .atf (for an
AutoTemplate) extension (for example,
BlueOH.atf), and then click “Save.”

In the dialog box, select “Interchange
file” from the “Format” popup menu,
and then select either “Presentation” or
“AutoTemplate.”

Open the presentation or
AutoTemplate, and then choose “Save
as…” from the File menu.
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To transfer a Windows presentation or AutoTemplate to a Macintosh

In Persuasion 3.0 for Windows, create
the presentation or AutoTemplate you
want to transfer, save it as a Persuasion
interchange file, and move it to a
Macintosh using any linking program.

In Persuasion 3.0 for the Macintosh,
choose “Open presentation” from the
startup screen, and then, in the open
dialog box, select the interchange file you
want to open.

If the “Where is the AutoTemplate”
dialog box appears, choose the
AutoTemplate in which you want the
interchange file to open or click “Give
up” to use masters from the inter-
change file, and then click “Open.”

Transferring files between a Macintosh and Windows

Go Fly a Kite
NimbusNimbus

Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
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• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Tip: To use the slide masters from the file you’re transferring, transfer the file as an AutoTemplate. Then Persuasion won’t ask
you to locate an AutoTemplate on the destination platform.
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Layering in Persuasion

Layering slides

Adding layers to your slides is an
effective way to present information.

In Persuasion, you can create up to
30 layers per slide and you can set
transition effects for each layer.

You don’t need to decide immedi-
ately what information goes on each
layer; you can enter all the informa-
tion on one layer and then assign
individual layers to objects and text
later. You can also hide some layers
while you’re working to simplify your
work, and you can set or change
layer assignments at any time.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit• Iriure dolor in hendrerit
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Use layers to present related information sequentially, emphasizing each idea in turn.

For more information
Animating slide objects ..................... 160

Autolayering and highlighting
information ....................................... 158

Transition effects for slides
and slide layers .................................. 164

“Layering slides” in Online Help
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To assign text or graphics to a layer

The Layer menu

A Shows the current drawing layer.

B The first number is the current draw-
ing layer, and the second number (in
brackets) is the layer of the selected
object.

Select the text or graphics you want to move to a specific layer.
Use the text tool to layer individual parts of a text block. Use
the pointer tool to layer the entire text block.

Choose “Set layer” from the Layer menu at the bottom of the
window, and then select a number from the submenu.

A

B
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”Text autolayer” dialog box

A Leaves all text on a single layer.

B Displays single paragraphs of text as
individual layers.

C Displays each first-level head and its
subordinate levels together on the
same layer.

D Displays only the first layer and then
adds each successive layer one at a
time.

E Displays all layers, highlighting one
layer at a time while dimming the
other layers. After the last layer is
highlighted, all layers are high-
lighted.

F Displays only the first highlighted
layer. A highlighted layer is added
one at a time, as the previous layer is
dimmed. After the last layer is high-
lighted, all the layers are high-
lighted.

G Colors for text that is not high-
lighted (dimmed).

Highlighting layered information is an
excellent way to emphasize informa-
tion. It creates a focus for your
audience yet demonstrates the
relationship between several ideas.

With Persuasion, you can automati-
cally layer a bulleted list, a block of
text, a chart, a table, or an organiza-
tion chart. You can also layer an entire
placeholder on a slide master. Then,
every time you use that placeholder
on a slide, each bullet of text, level of
organization chart, or data series in a
chart will be automatically layered.

You can layer text in three ways:
creating a cumulative effect, display-
ing your text all at once, or using a
combination of both effects.

For more information
Layering slides ................................... 156

Running your on-screen presentation ... 180

Transition effects for slides
and slide layers .................................. 164

Autolayering and
highlighting information

A
B
C

D
E
F

G
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To add autolayers and highlights

To see your effects, choose “Slide show”
from the View menu, and then choose
“Preview current slide” from the
submenu. Press Command + . (period) to
end the slide show.

Click “OK” when you have selected the
options you need.

Tip: If your layers do not appear,
choose “Slide show” from the View
menu, and then choose “Show all
slides” from the submenu. In the
“Show all slides” dialog box, check
“Layers.”

If you are creating highlighted layers
for text, select a highlight from the
“Layer effects” option. Select a color
for dimmed layers by clicking “Color
of dimmed items,” and then selecting
a color.

In the autolayer dialog box, select an
option from “Create layers.”

With the pointer tool, select what you
want to highlight and layer, and then
choose “Autolayer...” from the Draw
menu.
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Animating slide objects

Once an object is animated, it is
labeled with an animation badge,
from which you can do basic anima-
tion editing. Animation badges can
be displayed on slides using the Show
menu and can be hidden or displayed
when giving the presentation.

Editing animations using the animation badge

Animation—where an object moves
across the screen—adds action to
your presentation and quickly draws
attention to the animated object.

You can animate text and graphics on
a slide as well as placeholders on slide
masters. If your text block, place-
holder, table, or chart is layered, each
piece will animate in a top-to-bottom
or left-to-right sequence. In an on-
screen presentation, you can use
animation to create a “rolling credits”
effect in your presentation, where
words scroll onto the screen and then
off the screen again. However, the
“rolling credits” effect will not display
using the Persuasion Player since the
Player only shows objects that are
fully on the slide when the slide show
is exported.

You can set animation so that an
object either enters or exits from the
screen. You can also set different
animation speeds, and you can
determine whether the object moves
across the full screen or within a
specific area.

After an object is animated, you can click
its badge and edit the animation from the
popup menu.

For more information
Layering slides ................................... 156

Running your on-screen presentation ... 180

Transition effects for slides
and slide layers .................................. 164
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To animate slide objects

Using the pointer tool, select the object
or placeholder you want to animate.

Choose “Autoanimate...” from the Draw
menu.

In the “Autoanimate” dialog box, select
a direction, speed, and play area for the
animation, and then click “OK.”

To create a “rolling credits” effect

Drag the text block so that the top
touches the bottom edge of the slide.

Choose “Autoanimate…” from the
Draw menu.

In the “Autoanimate” dialog box, set the direction to “Exit to
top,” set the speed to “Slow,” and set the play area to “Full
screen,” and then click “OK.”

To view the animation, choose “Slide show” from the File
menu, and then choose “Preview current slide” from the
submenu. Press Command + . (period) to exit the slide show.

Using the pointer tool, select the text
block you want to animate.
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Jump between slides, Player presentations, or other applications

Creating jumps within a
presentation

When you have reference slides or
material from another application
that may enhance your presentation,
you can display this information by
using autojumps. You can also use
autojumps to create self-paced,
interactive presentations.

You can create jumps to another slide
or slide layer, to another application,
or to a Player file. After the jump,
you can return to the slide from
which you jumped. When you jump
to a Player file, all the slides in that
file are shown unless you create a
return jump.

You can set up jumps in both manual
and automatic slide shows, and you
can create an unlimited number of
jumps on each slide or slide layer. An
autojump object or area is labeled
with an autojump badge from which
you can edit jumps. Badges can be
turned on or off through the Show
menu.

For more information
Run multiple Player files ..................... 196
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Tip: Preview jumps by choosing
“Slide show” from the View menu,

and then selecting “Show all slides.”

You can turn any object or area on a slide or slide layer into a “hotspot” for a jump.
During a slide show, you click the hotspot to jump to another slide or presentation. (The
pointer turns into a hand icon when it passes over the hotspot.) The Persuasion 3.0 tu-
torial uses the Autojump feature extensively.

The “Autojump” dialog box

A Removes an autojump from an ob-
ject or area.

B Enables options to jump to a particu-
lar slide or slide layer.

C Creates a return to the originating
slide after a jump to another slide in
the same presentation is completed.

D Sets up a jump to a Persuasion
Player file.

E Sets up a jump into another applica-
tion or document.

A
B

C
D

E
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With the pointer tool, select an object from which you want to
jump, and then choose “Autojump…” from the Draw menu.

In the “Autojump” dialog box, select the options you want,
and then click “OK.” When you select “First layer,” only the
first layer in that slide will be shown. When you select “Last
layer” all layers are shown.

To create a jump to another slide

In the “Autojump” dialog box, select a
destination, and then click “Choose….”

In the dialog box, select the file you
want, click “Open, ” and then click
“OK.”

To create a jump to a Player file or an application

To create an area on your slide from which to jump

With the pointer tool, select an object
from which you want to jump, and
then choose “Autojump…” from the
Draw menu.

Select the autojump tool from the tool
palette and create a rectangle on the
slide by clicking the upper-left corner
of the proposed hotspot and dragging
diagonally. When you release the
mouse button, the “Autojump”
dialog box will appear. Select desired
options and click “OK.”
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Transition effects for slides
and slide layers

The “Transitions” dialog box for visual effects

A Lists all the slides in the current pre-
sentation and shows the slide num-
ber and display time between each
slide.

B Lists the layers for the currently se-
lected slide and their settings.

C Displays the “Visual effect” menu.

D Indicates the delay time (in seconds)
between each transition.

E Displays the “Layer delay” dialog
box after you have selected a layer
and then selected “Other…” from
the “Delay” popup menu.

Note: An asterisk (*) next to a setting
indicates that it is the default setting.

A

B

C
D

E

Slide transitions determine how a
slide or slide layer opens on the
screen. To create a smooth flow
between slides and add interest to a
presentation, you can add visual and
sound effects to slide transitions. You
can set transition effects for indi-
vidual slides, or you can set default
transition effects for an entire
presentation. You can also set the
time the slide or layer will display.

The “Fade” transition is available
when the color palette is limited to
256 colors (known as 8-bit color
mode). It is not available when the
color palette has access to thousands
of colors (16-bit color mode) or
millions of colors (24-bit color mode).

Tip: To preview transition effects,
choose “Slide show” from the View

menu and then select “Preview
current slide” or “Show all

slides….”

For more information
Adding and editing sounds ................ 168

Autolayering and highlighting
information ....................................... 158

Bringing QuickTime movies
into Persuasion .................................. 172

Layering slides ................................... 156

Sound transition effects for slides
and slide layers .................................. 166
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Select a transition effect from the “Visual effect” popup menu.

To add a visual effect to a slide or slide layer

Choose “Slide show” from the View
menu, and then select “Transitions…”
from the submenu.

In the “Transitions” dialog box, select the
slide you want to apply a transition to
from the slide list box.

To apply the transition to the whole
slide, select Layer 1 in the “Layer” list
box. To apply the transition to another
slide layer, select the layer.

Click the “Delay” popup menu, select the desired delay time
(in seconds) and then click “OK.”
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Sound transition effects for
slides and slide layers

Sound used in slide transitions adds
another dimension to a presentation.
You can create transitions for
individual slides and slide layers, or
you can set default transition effects
that apply to your entire presenta-
tion. Using sounds in Persuasion
requires the System extension
QuickTime 1.6 or later.

You can import any QuickTime movie
with sound to create transitions on
slides or slide layers. You can also
import sounds in AIFF format, System
7 (sfil format) sounds, and audio CDs
(with appropriate equipment), which
Persuasion converts to QuickTime
sound-only movies.

The “Transitions” dialog box for sound effects

C Plays sound completely before the
next layer or transition effect occurs
(“Wait”), or plays sound while other
slides and slide layers are shown
(“Continue”).

Note: An asterisk (*) next to a setting
indicates that it is the default setting.

A Adds sound effects to a slide or
slide layer.

B Determines how the sound transi-
tion affects subsequent layers.

A

B

C

Tip: To set default sound
transitions for the entire

presentation, choose “Slide show”
from the View menu, and then

select “Set default transitions…”
from the submenu.

For more information
Adding and editing sounds ................ 168

Autolayering and highlighting
information ....................................... 158

Bringing QuickTime movies
into Persuasion .................................. 172

Layering slides ................................... 156

Transition effects for slides
and slide layers .................................. 164
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To set a sound effect to a slide or slide layer

To add a sound effect that will play
when the slide opens, select Layer 1 in
the “Layer” list box. To apply a sound
effect to another slide layer, select
that layer.

In the “Transitions” dialog box, select the
slide you want to apply a transition to
from the slide list box.

Choose “Slide show” from the View
menu, and then select “Transitions…”
from the submenu.

Select a sound from the “Sound effect” popup menu, or select
“Import…” to add a sound to this list.

Select an option from the “During sound playback” popup
menu, and click “OK.”
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Adding and editing sounds

To add a sound to a slideYou can use sound as a transition
between slides or slide layers, and
you can place sound directly on the
slide so it will play when the slide or
slide layer becomes active. Persuasion
can directly import QuickTime sound-
only movies. When you import other
sound formats—AIFF, System 7 (sfil
format), or audio CDs (with appropri-
ate equipment)—Persuasion creates a
QuickTime sound-only movie from
the sound.

A QuickTime sound-only movie
added to slides will play when the
layer it is on is displayed. A sound
placed on the first layer of a slide is a
transition sound that will play when
the slide first appears.

After you import sounds, you can
adjust the volume, play time, and
play sequence. You can edit sounds
using the QuickTime playbar and
slider that you use to edit QuickTime
movie sequences.

For more information
About QuickTime video movies ......... 170

Bringing QuickTime movies into
Persuasion ......................................... 172

Transition effects for slides
and slide layers .................................. 164

Select the sound file you want to
import. If the sound is a QuickTime
sound-only movie, click “Import,”
otherwise, click “Convert....”

If the sound is not QuickTime, provide
a name in the import dialog box for
the QuickTime sound-only movie that
will be created referencing the sound
and click “Save.”

Display the slide or slide layer where
you want to place the sound. Choose
“Import” from the File menu, and
then choose “Sounds…” from the
submenu.
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To edit the play sequence of a sound

Choose “Slide show” from the View
menu, and then select “Transitions…”
from the submenu.

In the “Transitions” dialog box, select a
slide from the “Slide” list box, and then
select a layer from the Layer list box that
has a sound assigned to it.

Select “Edit sound….”

In the “Edit sound” dialog box, press
Shift and drag the slider bar over the
section you want to copy or delete.

Tip: You can set the volume for a sound in the “Edit sound” dialog box by clicking the
volume control button on the slider bar and adjusting the volume slider.

To copy the selected section, press
Command + C. Move the slider to the
point where you want to insert, and press
Command + V. To delete the section,
press Command + X.

Click “OK” in both dialog boxes.
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About QuickTime video
movies

Persuasion 3.0 lets you add
QuickTime movies to your slides, slide
masters, and backgrounds.

QuickTime is an extension to the
Apple Macintosh operating system
that lets you put animation, video,
JPEG compressed PICTs, and sound
into your Macintosh files. You must
have the QuickTime extension in your
Extensions folder in your System
folder to use the “movie” (MooV) file
format. Like other graphics, you can
import or paste movie files into
Persuasion. You can also copy movies
between slides within a presentation.

Recommended hardware and software

Item Recommended

Processor 68030 or later

RAM 8MB

Operating system 7.0.1 or later

Memory allocated to Persuasion 3.5 to 6MB

QuickTime software Version 1.6 or later

Add impact to your presentations with QuickTime video movies

Training: Show a video of parts assem-
bly, a product in use, or animated graph-
ics of a complex process.

Marketing: Show a taped message from
a VIP, a video clip of a testimonial, or a
cartoon animation.

Tip: To view information about
movies and sounds in your

presentation, choose “Movie
info…” from the File menu.

For more information
Adding and editing sounds ................ 168

Bringing QuickTime movies into
Persuasion ......................................... 172

Setting up a movie in Persuasion ....... 174

Transition effects for slides
and slide layers .................................. 164
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Parts of a QuickTime movie

”Movie information” dialog box

A The poster frame is the image that
displays when the movie is not run-
ning. It is also the image shown
when the slide is printed.

B The badge labels the movie and
contains a popup menu for editing
or getting information about the
movie.

C The movie frame is the area in
which the movie will play.

A Lists all movies in the presentation,
including sound-only movies.

B Shows the size, duration, and dis-
play size of the movie.

C Displays the file size used by
Persuasion and the total run time of
selected movies.

D Displays the total file size and total
run times for all movies in the pre-
sentation.

A

B

C

C D

A B
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Bringing QuickTime movies
into Persuasion

When you import a QuickTime
movie, you are actually establishing a
link with the movie, not adding the
movie to your presentation. Import-
ing only the reference keeps the
presentation file size smaller, since
movie files can be quite large.

A movie file itself can contain
references to other media files for
audio, video, or animation data.
When you move a presentation from
one computer to another, always run
through your presentation before
giving it.

You will most likely use video movies
directly on a slide, although you can
also use a movie with sound as a slide
or slide layer transition. Movies
placed on backgrounds will play first
when the slide is displayed; movies
placed on masters will play second;
and movies on slides will play third.

Import movie dialog box

A

B

A Displays QuickTime movie files that
can be imported.

B Previews the selected movie.

Tip: Keep movies used in a
presentation in the same folder as

the presentation.For more information
About QuickTime video movies ......... 170

Preparing your on-screen
presentation ...................................... 178

Running your on-screen
presentation ...................................... 180
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To import a QuickTime movie

Display the slide, slide master, or
background on which you want to
place the video movie.

Choose “Import” from the File menu and
then choose “Movies…” from the
submenu.

In the “Import movie” dialog box,
select the movie file to import, and
then click “Import.”

Open your Persuasion presentation and display the slide on
which you want to put the movie.

Choose “Paste” from the Edit menu.

Click the video movie in another application, another
Persuasion presentation, or view the movie in the Scrapbook to
select it.

Choose “Copy” from the Edit menu.

To copy a video movie

NimbusNimbus
Caelum aetherCaelum aether

NimbusNimbus
Caelum aetherCaelum aether
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Setting up a movie in
Persuasion

The movie badge popup menu

A Plays the movie from the current
frame. Once the movie is playing,
click anywhere to stop play.

B Turns the sound on or off for movies
that contain sound.

C Turns the video display on or off for
movies that contain video.

D Displays or hides the playbar.

E Designates the current frame as the
poster frame..

F Displays the frame that is assigned
as the poster frame.

G Returns the movie to its original size
if you have resized it manually or us-
ing the “Adjust graphics” dialog
box.

H Displays information on the movie
selected and information on all mov-
ies in the presentation.

I Allows you to change the name of
the movie as it appears in the
“Movie information” dialog box.
The original movie maintains its
original filename.

A
B
C

D

E
F

G

H
I

For more information
About QuickTime video movies ......... 170

Bringing QuickTime movies into
Persuasion ......................................... 172

In Persuasion, you can specify several
characteristics of your QuickTime
movie. You can adjust the volume,
you can set the poster frame, and
you can decide how big the movie
will be on your slide. You can also
perform basic edits to a QuickTime
video movie and test playback.

Movies are labeled on slides with a
movie badge containing a popup
menu from which you can do basic
movie editing. Use the playbar to edit
the current or selected frames of the
movie. When the playbar is not
visible, edits such as cutting, copying,
or deleting apply to the movie as a
whole. You can choose to display or
hide movie badges.

Tip: To preview a movie,
double-click it. To stop play, click

the movie once again.
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The playbar

To set the poster frame

A Displays the volume slider that controls
the volume of the movie.

B Plays the movie from the current frame.

C Indicates the current frame’s place in
movie.

D Steps backward through the movie one
frame at a time.

E Steps forward through the movie one
frame at a time.

To display the playbar, Choose “Show
playbar” from the movie badge popup
menu.

Advance the movie using the playbar to
find the desired frame.

Choose “Set poster frame” from the
movie badge popup menu.

To adjust the movie sound volume

To display the playbar, choose “Show playbar” from the movie
badge popup menu.

Click the volume control button to display the volume slider,
and then drag the slider to the desired setting.

A B  C D E
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Editing movie frame
sequences

To move QuickTime movie framesYou can cut, rearrange, or duplicate
movie frames in Persuasion. This
allows you to cut a longer movie to
show only the frames you want or to
create a movie clip from a longer
movie. You can paste frames into the
movie from which you cut or copied
them, or you can make a new movie
consisting only of the cut or copied
frames.

Display the playbar by choosing “Show
playbar” from the movie badge popup
menu.

Using the slider or step buttons, go to
the first frame of the sequence you
want to cut or copy.

Hold down Shift and move to the end
of the sequence by either dragging the
slider or clicking the step buttons. To
move just one frame, click a step
button once.

Choose “Copy” or “Cut” from the
Edit menu.

Click the play button on the control bar
to review the result.

Go to the frame after which you want
to append the sequence, and then
choose “Paste” from the Edit menu.

For more information
About QuickTime video movies ......... 170

Bringing QuickTime movies into
Persuasion ......................................... 172

Tip: QuickTime movies in
Persuasion play using the

“Standard” (RGB) color system.
Use a QuickTime editing program
to play a movie using a different

color system.
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To remove a sequence

To create a new movie from a selected sequence

Using the slider or step buttons on the
playbar, go to the first frame of the
sequence you want to delete.

Hold down Shift and go to the end of the
sequence by either dragging the slider or
clicking the step buttons. To remove just
one frame, click a step button once.

Choose “Clear” from the Edit menu or
press Delete.

Using the slider or step buttons on the
playbar, go to the first frame of the
sequence you want to cut or copy.

Hold down Shift and go to the end of the
sequence by either dragging the slider or
clicking the step buttons. To move just
one frame, click a step button once.

Deselect the movie, and then go to the
slide or location where you want to
paste the “new” movie, and choose
“Paste” from the Edit menu.
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Preparing your on-screen
presentation

The “Slide show” dialog box

E

F

G

Before you run an on-screen presen-
tation, preview any special effects
you have created, and fine-tune your
work before showing your presenta-
tion to an audience. You can then
save it so that all you need to do is
double-click the presentation’s icon or
name to start it.

If you are giving your presentation on
a monitor that has a different screen
resolution (such as 1024 x 768) than
the monitor on which you created
the presentation, you need to record
the new screen dimensions in the file
before you present it.

It is a good idea to “package” all the
QuickTime movies in your presenta-
tion. This will create one file that
contains only the movie frames and
sounds your presentation uses. If you
choose not to package your movies,
you must bring all movies and sounds
along with your presentation, and
store them in the same folder.

A Lists options for the end of your au-
tomatic slide show.

B Manually advances each slide or runs
your presentation automatically.

C Displays the slide show centered on
the screen and reduced to the player
size (640 x 480 pixels).

D Features that will be displayed or en-
abled during your slide show.

E Shows your presentation using the
settings you have chosen.

F Saves the settings and closes the dia-
log box.

G Movies can be played in “Auto-
matic” or “Manual” mode when
“Slide advance” is set to “Manual.”

For more information
About QuickTime video movies ......... 170

Animating slide objects ..................... 160

Creating jumps within
a presentation ................................... 162

Layering slides ................................... 156

Transition effects for slides
and slide layers .................................. 164

A

B

C

D
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To change the slide size to match a different monitor

Choose “Slide show” from the View
menu, and then choose “Show all
slides….”

Select the options that you want, and
then select “Save.”

Choose “Save as...” from the File
menu.

To prepare a presentation to open in slide show

In the save as dialog box, select a folder
and type a name for your slide show.

Check “Package movies” to put the
sounds or QuickTime movies in your
presentation into one file.

Check “Open in slide show,” and
then click “Save.”

In the “Adjust graphics” dialog box,
select “Slides,” and then select either
“Move objects” for small adjustments
or “Scale objects” for large adjust-
ments. Click “OK.”

In the “Presentation setup” dialog box,
choose “Custom,” and then enter the
appropriate screen dimensions, and
click “OK.”

Choose “Page setup...” from the File
menu, and then click “OK” in the
“Page setup” dialog box.
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The control bar is a simple navigation tool*

A Moves to the first slide or the first
layer of the first slide.

B Moves to the previous slide or the
last layer of the previous slide. Press-
ing Shift + clicking the button moves
to the previous layer.

C Pauses the presentation when it is in
automatic mode.

Running your on-screen
presentation

Once you have correctly prepared
your presentation, and have saved it
to open as a slide show, running it is
easy. You simply double-click the
presentation icon or the filename in
the file folder. All of your multimedia
effects, such as sound transitions,
animation, QuickTime movies,
autojumps, and highlighted text, will
play according to the settings you
last saved.

You can navigate manually through
your presentation using either
keyboard commands and the mouse,
the menu bar, or the control bar. The
menu bar gives you flexibility in
manipulating your presentation, but
it can be intrusive and is best used for
informal presentations.

The control bar is much less intrusive
and provides controls if you are giving
the presentation away from the
computer. Keyboard commands are
handy if you are giving the presenta-
tion while sitting in front of a
keyboard.

Using the menu bar with an on-screen presentation

A These menu items allow you to
change transitions in your presenta-
tion.

B These menu items allow you to navi-
gate through your presentation.

A

B

A B C D E  F

D Plays the presentation. In automatic
mode, it starts or restarts your pre-
sentation.

E Moves to the next layer or next slide.
Pressing Shift + clicking the button
moves to the last layer of the current
slide.

F Moves to the last slide or the last
layer of the last slide.

* Pressing Shift + Command + c displays
the control bar.For more information

Creating Player files ........................... 186

Preparing your on-screen
presentation ...................................... 178

Run multiple Player files ..................... 196
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 Keyboard commands when running an on-screen presentation

To… Do this…

Display or hide the menu bar Press Command + m

Display or hide the control bar Press Shift + Command + c

Display the next slide or layer Click the slide or press the right arrow or press n

Display the previous slide Double-click the mouse or press the left arrow or press p

Display the previous layer Press Shift + left arrow or press Shift + p

Go to the first slide Press Home or press h

Go to the last slide Press End or press e

Go to the first layer of the first slide Press Shift + h or press Shift + Home

Go to the first layer of the last slide Press Shift + e or press Shift + End

Go to a specific slide Type a slide number and press Return

Go to the first layer of a specific slide Type a slide number and press Shift + Return

Stop or resume a slide show set to automatic advance Press the spacebar

Turn the cursor on or off Press a

Switch between manual and automatic advance Press =

Turn the blank screen on or off Press b or press , (comma)

Turn the screen black Press Shift + b or press . (period)

Exit the slide show Press Command + . (period)

Exit from the slide show and quit Press Command + q
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What is the Persuasion
Player?

To run a slide show using the Player,
first create your presentation as an
on-screen slide show in Persuasion,
then export it as a Player file. Since
Player files are snapshots of
Persuasion slides, you can’t edit
them. You can annotate them,
however, with notes and sketches.
The annotations don’t change slide
content and can be saved with the
Player file for future reference.

The Persuasion Player is a portable
version of Persuasion that allows you
to run on-screen slide shows on
computers that don’t have Persuasion
installed. With the Player, you have
the option of distributing your
presentations to people who don’t
own Persuasion.

Included with your Persuasion 3.0
software is a high-density disk
containing the Macintosh Player and
another containing the Windows
Player. Using the appropriate Player,
you can run a slide show on either
platform, regardless of where it was
created.

The Player supports transition sounds,
visual effects, autojumps between
slides, slide shows, or applications,
animation, sounds, and movies.

Recommended system requirements for running Player files

Component Macintosh PC

Processor 68020 (Mac II or higher) 80386

Memory (RAM) 4 MB 4 MB

Operating system System 6.0.7 Windows 3.1

Monitor 13 inches (640 x 480 pixels) VGA, 256 colors*
256 colors*

*On black-and-white or 16-color monitors, colors and patterns will be less smooth;
on monitors smaller than 13 inches (640 x 480 pixels), Player slides displayed at full
screen may be cropped.

For more information
Add notes to Player files .................... 194

Creating Player files ........................... 186

Preparing your on-screen
presentation ...................................... 178

Run a Player slide show ..................... 190

Testing Player files on-site .................. 188
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Taking a presentation on the road

Use the Player to run an on-screen slide
show on any Macintosh or Windows
computer that meets the recommended
system requirements, regardless of where
the slide show was created.
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Creating Player files

Before you can run an on-screen
presentation using the Player, you
need to create a Player file. You
create a Player file by exporting slides
from Persuasion in slide show format.
You can export single slides, selected
slides, or entire presentations.

From within Persuasion, you can save
settings for how your slide show will
run as a Player file before you export
it. For example, you can decide
whether slides will advance automati-
cally or manually. If you choose
manual slide advance, you can pause
and restart the slide show as you
deliver your message and you can
activate special effects, such as movies
or jumps between nonconsecutive
slides, at specific times. You have the
option of modifying the settings as
needed from within the Player.

Save settings running a Player file

B
A

C

D

E

A Options for ending a slide show set
to advance automatically.

B You control when slides and layers
advance, or the Player advances
them automatically.

C How your slide show displays on
your screen.

D Options you can choose to operate
or display in your slide show.

E You control when movies play or
they play automatically when a slide
is displayed.

F When checked, error messages dis-
play when objects can’t be found or
played.

F

Tip: Since Player files are snapshots of slides with content you
can’t modify, preview your slide show in Persuasion before you
create the Player file. In the “Slide show” dialog box, select the

“Player preview” option and then click “Play.” Exit the slide show
at any time by pressing Command + period.

For more information
Cross-platform support for QuickTime
movies and sounds ............................ 198

Run a Player slide show ..................... 190

Testing Player files on-site .................. 188

What is the Persuasion Player? .......... 184
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Decide how your presentation exports

To create a Player file

A Export your entire presentation, one
slide, or selected slides.

B Exports separate slide layers; don’t
check if the computer you’ll use has
less than 4MB of memory.

C Packages movies and sounds into a
QuickTime file.

D The Player can only use “Slide show”
format.

Open a presentation, choose “Slide
show” from the View menu, and then
choose “Show all slides…”

Select an option from the “Export”
popup menu, and then select “Slide
show” from the “File format” scroll box.

Choose “Export…” from the File menu
to open the “Export” dialog box.

Check the options you want, name your
Player file (add a .ppf extension to run
the file in Windows), and click “OK.”

In the “Slide show” dialog box, select
settings as needed, and then click “Save.”

To export one slide or selected slides,
display the slide sorter and select the
slides you want.

B
C

D

A

Go Fly a Kite Go Fly a Kite

Go Fly a Kite Go Fly a Kite

Go Fly a Kite
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Testing Player files on-site

Since you may be running your Player
slide show on unfamiliar equipment
in an unfamiliar setting, try running it
before you deliver your presentation.
You may find you need to change the
way the slide show is displayed on
the screen, the speed at which it
runs, and other settings.

You can run the Player file in full
screen or window display depending
upon monitor size. Because Player
files are bitmaps, patterns may
change when you switch from one
display to another.

If you use a projection device to
project your Player slide show, it will
look exactly like it does on the
monitor.

You can control your slide show from
one monitor (where the menu and
dialog boxes display) and present it
from another. Set your Player file to
display in a window and drag the
window to the second monitor.

If you set your slide show to run
automatically, you can control the
speed at which it runs. Unless you

modify the timing settings, slides
advance according to the delays you
set for transitions between slides and
layers. (The default settings are two
second delays between slides and
one second delays between layers.)

Choosing the best display option

Tip: To modify settings while the
Player file is running: Press

Command + T to display the
“Settings” dialog box, modify the
relevant settings, and then click

“Restart” or “Continue.”
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For more information
Creating Player files ........................... 186

Run a Player slide show ..................... 190

Transition effects for slides
and slide layers .................................. 164

What is the Persuasion Player? .......... 184

Full-screen display Regardless of moni-
tor size, Player files display at 640 x 480
pixels (the approximate size of a 13-inch
monitor). On larger monitors, Player files
appear in the center of the screen sur-
rounded by black. On smaller monitors,
the edges of the slides extend beyond the
edges of the screen and slides will be
cropped.

Window display If necessary, slide im-
ages are scaled to fit in the window. On
smaller monitors (such as a Macintosh SE
or a Powerbook), choosing window dis-
play scales slides to fit under the menu
bar and within the bounds of the screen.
Text scales as a bitmap so it may appear
jagged in smaller windows.
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Controlling the speed of your Player slide show

A When a Player file that is set to ad-
vance automatically first opens, the
slider is deactivated, and the slide
show plays at normal speed.

B Moving the slider left makes the pre-
sentation run slower (minimum
speed is four times slower than nor-
mal speed).

C Activates the slider and allows you to
change slide show speed.

D Moving the slider right makes the
presentation run faster (at maximum
speed, the slide show runs as if all
delays are set to None).

To change settings for running a Player file

A

B

C

D

In the “Settings” dialog box, choose
the display, timing, and other options
you want to change, and then click
“Play.”

In the open dialog box, select the file you
want to open, check “Show settings”,
and then click “Open.”

Double-click the Player application icon
to open the Player.
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Run a Player slide show

For best performance, copy your
Player files to the hard disk before
you run your slide show.

To run a Player slide show, simply
double-click the icon of the file you
want to run. The slide show will run
according to the settings that were
last saved.

Navigate through your Player file
using either the keyboard, the control
bar, or the Slide show menu.

Note: If you plan to run multiple
Player slide shows consecutively,
create a show list file on the com-
puter where you’ll be running your
presentation.

Before you take your Player slide show on the road,
answer these questions:

• Did you test your presentation on your own computer first?

• Have you exported your presentations as Player files in slide show
format?

• What kind of computer (Macintosh or Windows) will you be using
for your presentation?

• Does the computer meet the recommended system and hardware
requirements?

• Did you take the appropriate Player application (Macintosh or
Windows)?

• Have you saved your Player files and packaged movie and sound
files onto a disk formatted for the computer you’ll be using?

• If you’ll be running a slide show in Windows that you created on a
Macintosh (or vice versa), does your slide show include movies or
sounds that won’t play on the other platform?

• If you’ll be running a slide show in Windows, does your Player file
name have eight or fewer characters and a .ppf extension (for
example, 3QSales.ppf)?

Tip: Before you run your slide
show, disable screen savers, mail,
or any other program that might

interrupt your presentation.

For more information
Creating Player files ........................... 186

Cross-platform support for QuickTime
movies and sounds ............................ 198

Run multiple Player files ..................... 196

Testing Player files on-site .................. 188

What is the Persuasion Player? .......... 184
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Navigate using the control bar*

A Moves to the first slide or the first
layer of the first slide.

B Moves to the previous slide or the
last layer of the previous slide. Press-
ing Shift + clicking on the button
moves to the previous layer.

C Pauses the slide show and/or any
running movie, sound, or animation
effect.

D Starts or resumes the slide show
from the current slide.

E Moves to the next layer or next slide.
Pressing Shift + clicking on the but-
ton moves to the last layer of the
current slide.

F Moves to the last slide or the last
layer of the last slide.

*Pressing Shift + Command + C on
a Macintosh or Shift + Ctrl + C in
Windows displays the control bar.

A B C D E F

Run a Player slide show .
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Navigate using the keyboard

To… Do this…*

Display or hide the menu bar Press Command + m

Display or hide the control bar Press Shift + Command + c

Display the “Settings” dialog box Press Command + t

Go to the next slide or layer Click the mouse, or press the Right arrow, or press n

Go to the previous slide Double-click the mouse, or press the Left arrow, or press p

Go to the previous layer Press Shift + the Left arrow, or press Shift + p

Go to a specific slide Type the slide number and press Return

Go to the first layer on a specific slide Type the slide number and press Shift + Return

Go to the first slide Press h or Home

Go to the first layer of the first slide Press Shift + h or press Shift + Home

Go to the last slide Press e or End

Go to the first layer of the last slide Press Shift + e or press Shift + End

Pause or resume a slide show set to automatic advance Press the Space bar

Toggle the cursor on or off Press a

Switch between manual and automatic advance Press =

Switch between the current slide and a blank screen Press b or press , (comma)

Switch between the current slide and a black screen Press Shift + b or press . (period)

Exit from the slide show Press Command + period (Macintosh) or press Esc (Windows)

Exit from the slide show and quit Press Command + q (Macintosh only)

*If you’re running your Player slide show on a PC, press Ctrl instead of Command.

, Run a Player slide show
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To run a Player slide show on a Macintosh computer

To run a Player slide show in Windows

Copy the Player application, your Player
files, and any movies and sounds into
the same folder on the hard drive.

If necessary, change the settings by
pressing Command + t.

Make sure Windows is running, and
then insert the floppy disk into the
disk drive.

In the Program Manager, open the
“Main” group, double-click the File
Manager icon, and then choose “Copy”
from the File menu.

In the File Manager, click the icon for
the “c” drive. Double-click the “c:\”
directory to view the icons for your
Player files.

Double-click the Player application icon
(called “playerw.exe”) and in the
“Open” dialog box, select the Player file
you want to run.

Tip: In the “Open” dialog box, check
“Show settings” to view or change the
settings for how your slide show will run.

Type “a:\*.*” for “From” and type
“c:\” for “To.” (If you’re using disk
drives other than “a” and “c,” type
those letters instead).

+

Run a Player slide show

Double-click the Player application icon.
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Annotation options

Add notes to Player files

In the same way that you use a
marker to make notes on transparen-
cies, you can use the keyboard and
mouse to make notes and sketches
on slides during a Player presentation.

Using the Player annotation tools,
you can add comments and sugges-
tions directly to slides that need to be
changed. After your presentation,
you can open both an annotated
Player file and a Persuasion file and
easily incorporate revisions into your
original presentation.

By choosing not to display annota-
tions, you can present a Player file
slide show even after you have made
notes on the slides. Although you
can’t print annotations, you can save
them with the Player file.

For more information
Creating Player files ........................... 186

Run a Player slide show ..................... 190

Testing Player files on-site .................. 188

What is the Persuasion Player? .......... 184

A Displays or hides the annotation
tools. Showing the tools when anno-
tations are not displayed also shows
the annotations.

B Displays or hides annotations. Dis-
playing annotations displays all the
layers on a slide; you can’t annotate
individual layers.

C Deletes the annotations on the
current slide.

D Deletes all annotations in the
Player file.

A
B

C
D
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A Pointer tool.

B Text tool. Click on any location on
the slide to enter text.

C Marker tool. Make freehand draw-
ings on your slide.

D Eraser tool. Erase any or all of your
annotations. Double-click to erase all
annotations on a slide.

E Color tool. Choose one of nine col-
ors for your annotation text and
sketches.

F Tools expand (when you click and
hold) to offer you a range of sizes
and colors.

Annotation tools

To add notes and sketches to a Player file

A

B

C

D

F

E

When you’re finished annotating your
file, choose “Save” from the File menu
to save the annotations with your
Player file.

On the annotations tool palette, press
and hold the tool you want to use, select
the size or color you want, and then
annotate the slide.

Display the menu bar by pressing
Command + m and then choose
“Show annotation tools” from the
Annotations menu.
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Run multiple Player files

Use autojump when you want to
move back and forth between Player
files. Set the options for running each
Player file individually.

To create a show-list file

When one presentation consists of
multiple Player files, you have two
ways to run them: you can jump from
one Player file to another using
autojump, or you can create a show-
list file. A show-list file is an ordered
list of Player file names.

Create a show-list file when you
want to run Player files in sequence.
Because a show-list file consists of
pointers to the Player files you want
to run, you must create it on the
computer on which you run the
Player files. If you decide to change
the order in which the Player files run,
simply create a new show-list file.

Run a show-list file just as you run a
single Player file (double-click a show-
list file icon). Options you set for
running a show-list file apply to all
the slide shows in the show list.

In the “Create show list” dialog box,
select each Player file from the top list
in the order you want them to run and
click “Add” after each selection.

Launch the Player and choose “Create
show list…” from the File menu.

For more information
Creating jumps within
a presentation ................................... 162

Creating Player files ........................... 186

Run a Player slide show ..................... 190

What is the Persuasion Player? .......... 184

When all the Player files are added, click
“Save.” In the save as dialog box, type
a name for the show list file and click
“Save.”

In the “Create show list” dialog box,
click “Done.”



CHAPTER 10: ON THE ROAD WITH PERSUASION 197

To create jumps between two Player files

Within Persuasion, in Presentation B (not Player File B), create
an autojump to Player File A.

Export Presentation B again as a Player file, naming it exactly
the same as you did before.

Run the Player slide show. On the appropriate slide, move the
cursor over the object or area to which you’ve assigned the
autojump, and click when the cursor becomes a pointing hand.

From the file you jumped to, return to the first file by clicking
on a return autojump, if you created one, or by displaying the
menu bar and then choosing “Return to…” from the
Slideshow menu.

Export the presentation you want to
jump to as a Player file (called File B
here).

Within Persuasion, in the presentation you
want to jump from (called Presentation
A), create an autojump to Player file B.

Export Presentation A as a Player file
(File A).

To jump from one Player file to another

Presentation
A

Presentation
A

Presentation
B

Presentation
B

Presentation
A

Presentation
A

Presentation
B

Presentation
B

Presentation
A

Presentation
A

Presentation
B

Presentation
B
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Cross-platform support for
QuickTime movies and
sounds

The Player for the Macintosh has
been updated to transfer QuickTime
movies and sounds from the
Macintosh to Windows. QuickTime
and QuickTime for Windows must be
installed on their respective platforms.

After you create a Player file, package
your movies and sounds into a
QuickTime file. Then, you can run
presentations with movies and
sounds on a Macintosh, or in
Windows with the appropriate Player
application.

To package QuickTime movies and sounds for Windows

Export your presentation as a Player file, but do not check “Package movies” in the
“Export” dialog box.

Open your Player file, display the menu
bar (Command + m), and then choose
“Save as…” from the File menu.

In the “Save presentation as” dialog
box, check “Package movies” and “All
Persuasion Players,” and then click “OK.”

For more information
Creating Player files ........................... 186

Transferring files between Macintosh
and Windows .................................... 150

What is the Persuasion Player? .......... 184
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Printing in Persuasion

Printing in Persuasion
Persuasion gives you a variety of
options for printing 35mm slides,
overheads, support materials, and
outlines.
• Print slides without separate layers

or background fills for proofing.
• Print slide layers as separate slides.
• Print an on-screen presentation

with badges to become familiar
with the autojump hot spots.

• Create a PostScript file for 35mm
slides.

• Print parts of your presentation
independent of other compo-
nents. For example, print just the
outline without the slides or notes
to review your presentation
content.

• Print color slides on a black-and-
white printer without changing
your presentation.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Nimbus
NimbusCaelum aether

Caelum aether
• Iriure dolor in hendrerit

• Velit esse consequat

• Dignissim qui praesent

• Iriure dolor in hendrerit

• Velit esse consequat

• Dignissim qui praesent

• Iriure dolor in hendre

• Velit esse consequat

• Dignissim qui praesent

Caelum aetherNimbus
Nimbus

Caelum aether

Caelum aether• Iriure dolor in hendrerit

• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit

• Velit esse consequat
• Dignissim qui praesent

Caelum aether• Iriure dolor in hendrer
• Velit esse consequat

• Dignissim qui praesent

NimbusNimbus
Caelum aether
Caelum aether

• Iriure dolor in hendrerit• Velit esse consequat• Dignissim qui praesent

• Iriure dolor in hendrerit• Velit esse consequat• Dignissim qui praesent

• Iriure dolor in he• Velit esse conseq• Dignissim qui praNimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit• Velit esse consequat
• Dignissim qui praesent

Lorem ipsum dolor sit

 amet. Diam nonmum-

 my nibh euismod

  tincidunt

Nimbus

Lorem ipsum dolor sit

 amet. Diam nonmum-

 my nibh euismod

  tincidunt

Nimbus

Lorem ipsum dolor sit

 amet. Diam nonmum-

 my nibh euismod

  tincidunt

Nimbus

Lorem ipsum dolor sit

 amet. Diam nonmum-

 my nibh euismod

  tincidunt

Nimbus

Donatio

     Pennae

          Te feugait nulla facilisi

          D
olore magna aliquam erat

     Aether

          Lorem ipsum dolor sit

          E
lit sed diam nonum

          Tindidunt ut laoreet

     Caelum

          Q
uis nostrud exerci

          C
ommodo consequat

          D
uis autem vei

     Nimbus

          Iriure dolor in hendrerit

          Velit esse consequat

          Dignissim qui praisent

     Republicae forma

          Praefectus

               Rector

               Eques

                    Opifex

                    Operarius

               Curator

                    Artifex

                    Pedisequus

Donatio

     Pennae

          Te feugait nulla facilisi

          Dolore magna aliquam erat

     Aether

          Lorem ipsum dolor sit

          Elit sed diam nonum

          Tindidunt ut laoreet

     Caelum

          Quis nostrud exerci

          Commodo consequat

          Duis autem vei

     Nimbus
          Iriure dolor in hendrerit          Velit esse consequat          Dignissim qui praisent     Republicae forma

          Praefectus
               Rector
               Eques
                    Opifex
                    Operarius
               Curator
                    Artifex
                    Pedisequus

Donatio
     Pennae
          Te feugait nulla facilisi
          Dolore magna aliquam erat
     Aether
          Lorem ipsum dolor sit
          Elit sed diam nonum          Tindidunt ut laoreet     Caelum

          Quis nostrud exerci          Commodo consequat
          Duis autem vei

Notes

35mm slides
Overheads

Outlines

Handouts

For more information
Add handouts and speaker notes to a
presentation ........................................ 72

Creating jumps within a
presentation ...................................... 162

Outline your presentation
to save time ........................................ 62

Any part of your presentation—slides, outline, notes or handouts—can be printed sepa-
rately without printing all the presentation components.
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Persuasion’s printing options

A Prints the parts of the presentation
that are checked.

B Prints one page for each additional
slide layer.

C Prints badges for all charts, movies,
sounds, jumps, and animation in an
on-screen presentation.

D Does not print collapsed or hidden
text.

E Prints the outline without subtitles or
body text.

F Prints slide title and heading level icons
along with text.

G Prints slides with their background fills.
Uncheck to print slides without back-
ground fills.

H Prints only the selected heading and its
subordinates.

I Prints the outline without notes.

J Prints page numbers at the bottom
of each outline page.

K Prints the presentation title at the
top of each outline page.

Note: The look of the print dialog box
depends on the printer driver currently
active. However, all of the options de-
scribed here are available with all
printer drivers.

B

F

A

C

E

D

G

H
I

J
K
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Printing overheads and
support materials

More legible thumbnails

To print overheads, outlines, notes, or handouts

Before you print speaker notes and handouts that include thumbnails of slides with
darker or more complex color schemes, change the color system so that slide thumb-
nails are more legible.

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

NimbusNimbus
Caelum aetherCaelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Nimbus
Caelum aether

• Iriure dolor in hendrerit
• Velit esse consequat
• Dignissim qui praesent

Inverse grayscale
Black and white

Grayscale

Tip: To change your color system
to black and white before you print
support materials, choose “Color

system” from the Show menu and
then choose either “Black and

white” or “Inverse grayscale” from
the submenu.

Tip: If your presentation has a dark color scheme, change the color system to “In-
verse grayscale” or “Black and white” before printing proofs on a laser printer.

In the print dialog box, select the options you need. Uncheck the parts of the
presentation you don’t want to print, and then click “Print.”

Choose “Print...” from the File menu.

For more information
Add handouts and speaker
notes to a presentation ....................... 72

Proof and save .................................... 18

The best way to produce clear, crisp
overheads, outlines, speaker notes,
and handouts is with a high-
resolution black-and-white or color
laser printer.

When you print overhead transparen-
cies, be sure to use the transparency
product recommended for your
printer. You can also print overheads
on paper and then use a copier to
transfer images to transparencies.

Some limitations exist in the range of
colors available on color printers. If
you want to print color overheads,
refer to your printer documentation
to review your printer’s color
capabilities.
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Converting presentations
to 35mm format

”Adjust graphics” dialog box

D
B

C

A

E

A Adjusts slides.

B Moves objects toward the center of
the new slide shape, retaining size.

C Scales objects to fit proportionally in
the new slide shape.

D Scales text sizes to fit proportionally
in the new slide shape.

E Scales all objects and maintains their
proportions.

To convert a presentation to 35mm format

In the “Presentation setup” dialog box, select “35mm slide.” If you are using
custom dimensions instead of a device driver, click “Custom,” enter those
dimensions, and then click “OK.”

In the Chooser, select your film recorder
device. If using custom dimensions,
select any device, then click “OK” in
response to the Alert message.

Choose “Page setup...” from the File
˙menu, and then click “OK.”

Tip: Before converting your
presentation from one slide shape

to another, save it under a new
name. You can then compare the

converted slides to the original
slides, which can help you make
placement and sizing decisions.

For more information
Choose your final output and design ... 15

Proofing 35mm slides ........................ 206

“Adjust graphics dialog box” in Online
Help

“Overview: Transferring files across
platforms” in Online Help

When you convert a presentation
designed for on-screen display or
overheads to 35mm format, and vice
versa, the dimensions and shape of
your slide will change. In Persuasion,
you can move or adjust graphics and
text automatically on both slide
masters and slides to accommodate
a larger or smaller slide.
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Setting up for 35mm
output

Questions to ask a slide service bureauBefore you make 35mm slides using
either an in-house film recorder or a
slide service bureau, you need to
select the correct output device from
the Chooser, and define your slide
shape.

Your film-recorder documentation or
your slide service bureau will specify a
device driver or give you a set of slide
dimensions to work with. When you
select the device driver from the
Chooser, your slides will be sized
accurately. Without the device driver,
you must enter the slide dimensions
provided by your service bureau.

Adobe Authorized Service Providers
have the latest technical updates and
tips to help you save time and money.
Call Adobe Customer Service at
800.628.2320 in the U.S. and
Canada to find one near you.

What services do you offer
• Do you use Persuasion 3.0 for the Macintosh?
• What resolution in lines or dots per inch do you offer?
• Can I get PostScript slide output?
• Do you have Persuasion color test slides produced from your

35mm devices?
• Which fonts do you have?
• Will fill patterns print on your equipment?

How should I set up my presentation
• Do you have a film recorder driver or queueing software that you

want me to use?
• What slide dimensions does your film recorder require?
• Do you have size or orientation limitations?
• What do I need to do if I want separate slides for slide layers?

How should I send my file
• Should I save my presentation as a Persuasion file, an export file,

or a PostScript file?
• Should I send my presentation by modem or on disk?
• How should I transport my presentation if it is too big for a floppy

disk?
• Do you recommend any file-compression software?

For more information
Converting presentations
to 35mm format ............................... 203

Proofing 35mm slides ........................ 206

“Produce slides using an in-house film
recorder” in Online Help

“Produce slides using a slide service
bureau” in Online Help
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Setting up for 35mm slides

To… Do this…

Produce 35mm slides with a device driver installed 1. In the Chooser, select a film-recorder device driver or the
on your computer film-recorder’s conversion software as specified in your

documentation.
2. In the “Presentation setup” dialog box, select “35mm” as

the slide shape.

Produce 35mm slides through a slide service bureau 1. In the Chooser, select any printer.
supplying slide dimensions (but no device driver) 2. In the “Presentation setup” dialog box, select “Custom”

and enter the service bureau’s slide dimensions.

Produce a PostScript file 1. In the Chooser, select the LaserWriter driver.
2. Consult the slide service bureau or your film-recorder

documentation for any special settings required in the
“Presentation setup” dialog box.

Proof 35mm slides on printer paper (when the on-screen 1. In the Chooser, select a printer.
page size is larger than letter-size paper) 2. Choose “Page setup...” from the File menu, and then

reduce the page size to 70%. You can vary the reduction if
needed. (Return this value to 100% before printing your
final 35mm slides.)

To use the “Presentation setup” dialog box

Choose “Page setup….” from the File menu, and then
click “OK.”

In the “Presentation setup” dialog box, select “35mm slide” or
enter your slide shape, and then click “OK.”
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Proofing 35mm slides

You can add edited colors into the
“Custom 1” or “Custom 2” color
system so that when you use the
same film recorder again, you can use
a tested color palette.

Proof for fonts and text flow Film
recorders that are compatible with
Adobe Type Manager can print any
font you send smoothly at any size.
Without Adobe Type Manager, use
your test slide to verify that your
fonts print properly.

Test print graphics on a desktop
printer Print slides containing
complex PICT and EPS graphics on a
desktop printer first. If your printer
cannot process the slides, it is
possible the film recorder will also
have difficulty.

You can ensure your 35mm slides
print as expected by proofing them
before you print the whole presenta-
tion. The three variables you should
proof are color, text, and graphics.
Proof colors and text on 35mm film,
and proof graphics using a desktop
printer.

Proof with a test slide Create a test
slide to determine how the colors,
fonts, and fill patterns will image on
the film recorder you intend to use.

Run test slides by following the
procedures for setting up and
printing 35mm slides.

Test for color variances Each 35mm
film recorder translates colors in a
slightly different way. Therefore, you
may find that your test slide colors
are slightly different than you those
you want. You can edit your colors to
compensate for film recorder color
shifts before you print the whole
presentation. Tip: If you create your presentation in

“Fit in window” view, remember that
“Actual size” is the most accurate
view for seeing text and graphic

placement. You may want to print a
set of proofing slides on a laser printer

to review all text and graphic
placement in your presentation.

For more information
Creating a new color scheme ............ 126

Printing 35mm slides ......................... 208

Replacing custom color systems ......... 130

Setting up for 35mm output ............. 204

“Editing on slides” in online Help
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To proof complex graphics on a black-and-white laser printer

Choose “Color system” from the Show
menu, and then choose either “Inverse
grayscale” or “Grayscale” from the
submenu.

Choose “Print…” from the File menu.

In the print dialog box, select “Color/Grayscale” and deselect “Outline,” “Notes,”
and “Handouts,” and then choose “Print.”
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Printing 35mm slides

To create an export file

Choose “Export…” from the File menu.

In the “Export” dialog box, select “All slides” or “Current slide” from the “Export”
popup menu, and PICT or Scrapbook as the file format.

Tip: Check “Separate layers” to print individual slides for each slide layer.

Select the slide options you want to include, name the file, and then click “Export.”

There are three ways to send a
Persuasion file to a film recorder:
• Send a Persuasion file directly.
• Create an export file (your slides

become PICT or Scrapbook
images).

• Create a PostScript file.

Your film-recorder documentation or
slide service bureau will specify which
method to use.

Note: Some PostScript interpreters
require special page settings for
output. And some film recorders
require you to use their software to
process your presentation before it
prints. Read your film recorder
documentation, or contact your slide
service bureau for instructions.

For more information
Replacing custom color systems ......... 130

Setting up for 35mm output ............. 204

“Test before producing in color”
in Online Help
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To create a PostScript file

Tip: To print 35mm slides from
your computer, choose “Print…”
from the File menu. In the print

dialog box, check the options you
want, and then click “Print.”

In the “Save Disk File As:” box, type in a name for your file,
and then click “Save.”

Check “Background fill,” and then click “Save.”

Choose “Print…” from the File menu. Select “Slides” and deselect other print
choices. Check “Separate layers” to
print individual slide layers.

In the print dialog box, select “Color/
Grayscale,” and “PostScript® File” as the
destination.
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General

To… Press…

Open a new presentation Command + n

Close a presentation Command + w

Design an AutoTemplate Shift + Command + n

Display or hide the tool palette Option + Command + 1

Display or hide the color palette Option + Command + 2

Display or hide the text palette Option + Command + 3

Display or hide the line palette Option + Command + 4

Display or hide the nudge palette Option + Command + 5

Cancel a dialog box Command + . (period)

Working in the outline

To… Press…

Create a new heading at the same level Return

Create a new heading at the next higher level Shift + Command + l

Create a new heading at the next lower level Shift + Command + r

Move an empty heading right Tab

Move an empty heading left Shift + Tab

Move a heading with text right Command + ]

Move a heading with text left Command + [

Start a new line within the same heading Shift + Return

Delete a heading (and all its subheadings) Command + x

Set heading as a title Option + Command + t

Set heading as a subtitle Option + Command + s

Set heading as body text Option + Command + b

Add notes Option + Command + n

Collapse selection Command + k

Expand selection Command + e

Collapse entire outline Shift + Command + k

Expand entire outline Shift + Command + e

Keyboard Shortcuts
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Formatting

To… Press…

Format text Command + t

Change line and paragraph spacing Command + m

Style type bold Shift + Command + b

Style type italic Shift + Command + i

Style type underline Shift + Command + u

Style type outline Shift + Command + o

Style type shadow Shift + Command + s

Style type plain Shift + Command + Spacebar

Align text left Shift + Command + l

Align text center Shift + Command + c

Align text right Shift + Command + r

Align text justified Shift + Command + j

Editing

To… Press…

Select all Command + a

Copy Command + c

Duplicate Command + d

Paste Command + v

Cut Command + x

Undo/Redo Command + z

Find Command + f

Find again Command + g

Change Command + h

Change then find Shift + Command + h

Check spelling Command + l

For more information
Run a Player slide show ..................... 190

Running your on-screen presentation ... 180

“Keyboard Shortcuts” in Adobe Chart
Online Help

“Keyboard Shortcuts” in Adobe Table
Online Help
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Viewing

To… Press…

Go to slide Shift + Command + g

Move from slide to slide master Option + click the slide icon

Move from slide to slide in Edit view Command + right arrow or left arrow (forward or backward)

Move from slide or slide master to background Option + Command + click the slide icon

Toggle between slide, outline, slide sorter, and note Command + the up/down arrow

Open the Gallery to choose a slide master Option + Command + m

Preview current slide Shift + Command + p

25% magnification Command + 0

50% magnification Command + 5

75% magnification Command + 7

100% magnification Command + 1

200% magnification Command + 2

400% magnification Command + 4

Fit in window Shift + Command + w

Working with objects

To… Press…

Display or hide rulers Command + r

Display or hide guides Command + j

Snap to grid Command + y

Snap to guides Command + u

Display or hide badges Command + b

Send to front Option + Command + f

Send forward Shift + Command + ]

Send to back Option + Command + b

Send backward Shift + Command + [

Align/distribute Shift + Command + a

Group Option + Command + g

Ungroup Option + Command + u



Index

Index



216 ADOBE PERSUASION 3.0 USER MANUAL

patterns to objects   120
slide masters   31
slide masters from other presentations

30
words to user dictionary   61

"Adjust graphics" dialog box   26, 30,
36, 45, 179, 203

"Adjust Photo CD image" dialog box
136

Adjusting
objects for different output devices

203
Photo CD images   136

Adobe Authorized Slide Service Bureaus
204

Adobe Chart   94–105
control palette   102
data sheet   96
features   3
importing data from other

applications   98
online Help   94
opening   94
showing popup menus   103
text palette   102
tools   94, 104

Adobe Chart Effects folder   104
Adobe Illustrator, subscribing to   146
Adobe IntelliDraw, editing OLE-embedded

graphics from   144
"Adobe Persuasion AutoTemplate

installation" dialog box   9
Adobe Table. See Tables
Adobe Type Manager, film-recorder

compatibility   206
Advancing in Player presentations   186
Agenda, showing on an overview slide

68
AIFF sounds, importing   168
Aldus folder   6
"Align objects" dialog box   89
"Align to grid" command   89
"Align/Distribute…" command   89

Aligning objects   88, 92
Alignment tools   92
"Anchor content to placeholder" dialog

box   59
Anchor point, specifying   59
Anchoring text   58–59
Animated objects, transferring between

platforms   150
Animating

graphics   160
placeholders   160
slide objects   160

example   161
text   160

Animation
badge   160
direction   160
"Roll credits"   160
sequence   160
speed, setting   160

Annotations
in Persuasion presentations   72–76
in Player files   184, 194

Applications
exchanging information with 134–153
importing data into charts   98
importing presentations from   138
importing text from   48
importing text into tables   112
jumping to automatically   162, 163

"Apply effect to selection" command
(SFX palette)   104
"Apply format" option on text palette

54–55
Applying a fill to an object   121
Arc

90-degree, drawing   81
reshaping   82

Arc tool   81
using to draw shapes with variable line

widths   84
Arrowheads   83

transferring between platforms   150

Index

SYMBOLS

chart tool   17

data sheet button   17

Note icon   75

outline icon   16

Persuasion 3.0 icon   15

show-notes icon   75

slide divider icon   64
.ppf file extension   187, 190
.psl file extension   196
35mm slides

as output   204
converting   203
designing AutoTemplates for   44
exporting   141, 208
preparing to print   205–207
printing   208
production issues   204
proof prints, on printer paper   205
proofing   204-205
requirements for printing   204
setting up for production

using a film recorder   205
using a PostScript file   205
using a service bureau   205

testing color   206
3d charts   104–105
3d view palette in Adobe Chart   102

"Add masters…" command   30
"Add notes" command   75
"Add org chart" command   109
"Add org chart" dialog box   108
"Add page number"   76
"Add slide copy"   76
"Add title" command   76
Adding

a chart to your presentation   94–105
a slide to your presentation   16
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ASCII text files
importing   62, 135, 140

Assigning
background fill   34
backgrounds to slide masters   26
masters in the outline   69
slide masters to slides   25, 39
transitions in the outline   69
transitions in the slide sorter   39

Attributes, assigning to text blocks   54
Audio tracks, of QuickTime movies

turning on and off   174
"Autoanimate" dialog box   161
"Autoanimate…" command   161
Autojump badges   162
"Autojump" dialog box   162
Autojumping. See Jumping automatically
Autojumps, transferring between

platforms   150
autolayer dialog box   159
"Autolayer…" command   159
Automatic slide advance   178

in Player presentations   186
"Autoscan" button, in Adobe Chart   96
AutoTemplates

and final output   15
and output device   42–43
converting from earlier versions

of Persuasion   10, 40
creating from scratch   40
default

modifying   43
replacing   43
when upgrading to Persuasion
   version 3.0   6

definition   40
designing   44
for 35mm slides   44
for custom-sized slides   44
for on-screen slide shows   44
for overhead transparencies   44
handout master   72
installing   40
modifying   45

note master   72
opening   41
saving presentations as   40
setting up for output device   42–43
sources of   40
transferring between platforms   150

AutoTemplates folder   15

Backdrop, for slides. See Backgrounds
"Background" command   26, 34, 37
Background command   34
Background fill, assigning   34
Backgrounds

adjustments when transferring between
platforms   151

assigning to slide masters   26, 35
creating   34
designing   26
for tables   114
making a copy of   34
modifying   34
orientation   26, 36
removing   27
renaming   27

Backup copies of installation disks   4
Badges

animation   160
autojump   162
chart   97, 101
printing   201
QuickTime movie   171, 178

menu commands   174
showing and hiding   162
table   111

"Badges" command   79
"Based on" popup menu   37
Basic installation   8
Black-and-white color system   129
Black-and-white printer, using to proof

graphics   206
Blends. See Gradient fills
Body text placeholders   28, 49

anchoring   59

Borders, of tables   114
Boxes in organization charts   106–109
Build Slides. See Layering slides;

"Autolayer…" command; Highlighting
layered information

"Build Stand-Alone…" command.
    See Player files: creating
Bulleted list, highlighting   158
Bullets

adjustments when transferring between
platforms   151

changing color   53
changing style   52–53
displaying and hiding   51–53
special characters   52

Calibration, color. See Color: calibration
hardware

CD images. See Photo CD images
Cell assignments in Adobe Chart   97

for imported data   98
Cells, in Adobe Table

changing shape of   110
merging   115

Cells in Adobe Chart
assigning in data sheets   96

"Change design" command
30, 127, 131

Changing slide orientation   36, 76
Chart. See Adobe Chart
Chart button   96
Chart data sheet   96
Chart objects

applying gradient fills   105
copying fills between   103
modifying   102

Chart OLE badges   101
Chart placeholders   28, 94
Chart slide master, creating   95
Chart tool   17, 104

using to add a chart   95
Chart types, changing   100
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Charts
2d special effects   104
3d special effects   104

changing viewing angle   105
adding graphics   104
adding scans   104
adding to slides   17, 94
converting from earlier versions of
   Persuasion   10
data formats   98
entering data   96
formatting   100

text   102
highlighting   158
importing   138

data   98
modifying components   102
organization. See Organization charts
resizing   100

text in   103
reversing data series or
   categories   101
special effects   104

"Choose master elements" dialog
   box   32, 138
Chooser

using to select a printer   205
using to select an output device   15
using to specify a film recorder   205

Circle, drawing   81
Clip art, importing   136
CMY color model   124
CMYK color model   124
Collapsing outlines   70
Color

applying
to a text block   121
to objects   120, 121
to tables   114
to text   121
to the background of a pattern   120
to the foreground of a pattern   120

calibration hardware
Radius PrecisionColor   132

RasterOps Calibrator   132
copying in Adobe Chart   103
custom, creating   124
editing values to create custom
   colors   124
effect of output medium   129
factors that affect display   132
in Adobe Persuasion   118–132
in charts   102
of bullets, changing   53
of placeholders, changing   29
proofing on 35mm slides   206
reproducing and printing in
   overheads   202
solid

applying to shadows   120
applying to text   120

testing for 35mm slides   204
variations among monitors   132

Color annotation tool   194–195
Color models

changing   124
CMY   124
CMYK   124
HLS   124
HSV   124
RGB   124

Color picker   125
Color scheme   118

creating
by editing the color-scheme
   grid   126
using copy and paste   126

naming working set colors from   126
replacing swatches in   127
when to use   119

Color spectrum
overview   118
when to use   119

Color swatches
on the color palette   90, 119
replacing individual   127

Color system
Black and white   129

Custom systems 1 and 2   129
editing   128
Grayscale   129
Inverse grayscale   129
NTSC   129
overview   128
PAL   129
replacing   130
Standard   129

Color scheme
overview   118
replacing   126
using to create custom colors   124
when to use   119

Colors palette   114, 118
collapsed   120
in Adobe Chart   102
overview   118

Column margins in tables   115
Columns

in chart data sheets   96
of text   60

Comma-separated value (Csv) data
   format   98
Complete installation   8
Computer

needed to run Persuasion 3.0   4
needed to run Player files   184

Constraining shapes when drawing   81
Content

proofing   19
editing in the outline   62

Control bar
displaying and hiding   181
in Player   180
navigating in Player files   191

Control palette, in Adobe Chart   102
"Convert sound" dialog box   168
Converting

a presentation to 35mm slides   203
OLE-linked graphic files to Persuasion

format   79
Persuasion 3.0 files from earlier versions

of Persuasion   10
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Persuasion 3.0 files to an earlier version
of Persuasion   11

PICT files to Persuasion format   79
Copy and paste

using to import chart data   98
using to import table data   112
using to share Persuasion

information   134
"Copy colors…" command   127, 131
Copying

backgrounds   34
between applications, advantages
   of   135
fills between chart objects   103
objects between presentations   135
objects between slide masters   135
objects between slides   135
QuickTime video movies   173
slide masters   34
slides between presentations   135
slides in the slide sorter   38–39

"Create presentation" command   42
"Create publisher…" command   147
"Create show list" dialog box   196
"Create show list…" command   196
Creating

a chart slide master   95
a PostScript file   208
a presentation   14, 40
a slide master from a slide   30, 33
an agenda slide   68
an export file   208
graphics   81
handouts   76
multicolumn text   60
new backgrounds   34
new slide masters   34
organization charts   106–109
Player files   186
tables   111
tall slides   34, 36
text formats   54

Csv data format   98
Cursor, turning on and off   181

Custom 1 and 2 color systems   129
Custom colors, creating   124
Custom installation   8
"Custom line size" dialog box   84
Custom line weights   83
Custom-sized slides, designing

AutoTemplates for   44

Data
in charts

changing position of   100
entering   96

reversing series or categories   101
Data formats, for charts   98
Data page. See Data sheet
Data ranges in charts, specifying   96
"Data reversal" command   101
Data sheet button   17, 97
Data sheet, in Adobe Chart   96
Default AutoTemplate

modifying   43
replacing   43
when upgrading to version 3.0   6

"Default AutoTemplate" file   7, 42
"Default AutoTemplate Selection" dialog

box   9
"Define bullets" dialog box   52
"Define formats…" command   55
"Define masters" command   27
"Define masters" dialog box   27
"Define outline styles for selected levels"

dialog box   71
"Define text formats" dialog box   55
Delay between slides in Player files   188
"Delay" popup menu   164
Deleting a heading in the outline   65
DeltaGraph, importing presentations

from   138
Demoting a level in the outline   65
Depth

of organization chart boxes,
modifying   109

of table cells   110
Design. See Presentation design

proofing   38
"Design AutoTemplate" command   44
Designing

AutoTemplates   44
presentations   40–45

Desktop printer, using to proof 35mm
slides   206

Dialog boxes
"Add org chart placeholder"   108
"Adjust graphics"   26, 30, 36, 45,

179, 203
"Adjust Photo CD image"   136
"Align objects"   89
"Anchor content to placeholder"   59
"Autoanimate"   161
"Autojump"   162
autolayer   159
"AutoTemplate selection…"   9
"Choose master elements"   32, 138
"Convert sound"   168
"Create show list"   196
"Custom line size"   84
"Default AutoTemplate Selection"   9
"Define bullets"   52
"Define masters"   27
"Define outline styles for selected
   levels"   71
"Define text formats"   55
"Edit colors"   122, 124
"Export"   141, 187, 208
import   99, 112, 139
"Import CD"   136
"Import movie"   172
"Install Files"   9
"Interchange master selection"   152
"Layer delay"   164
"Default AutoTemplate Selection"   9
"Movie information"   171
"New background"   34–35, 37
new chart   17, 95
"New slide master"   33–35, 37, 109
open   15, 41
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"Page setup"   179, 205
"Paste special"   145
"Personalization"   9
"Presentation setup"

41, 45, 179, 205
Print   201, 207, 209
"Publisher to"   148
save as   10, 179
"Select options to be installed"   9
"Set slide background fill"   34
"Settings"   189
"Slide show"   178, 186
"Spelling"   61
"Subscriber to"   148
"Table format"   110
"Text autolayer"   158
"Text format"   113
"Transitions"   164, 166, 169

Dictionary
spelling, replacing when upgrading   6
user1   61

Dimensions, specifying custom   203
Display options

for Player files   188
Distributing objects   88, 92
Drawing

a polygon   82
adding points   82
constraining shapes when   81
shapes from the center   81
shapes with variable line widths   84
tools for   81

Drawing programs, importing graphics
from   136

"Duplicate" command   85
Duplicating

an object to create a pattern   85
graphics   85
text   85

Earlier versions of Persuasion
removing   6
upgrading from   6

"Edit colors" dialog box   122, 124
"Edit sound…" option   169
Editing

OLE-embedded objects   144
presentations using the slide
  sorter   38
text formats   55
text in the outline   62

Edition file
breaking the link with the
   subscriber   148
opening application of   147
publishing   146
saving   147
subscribing to   146

to import chart data   98
"Editions" command   99, 147
Effects, multimedia, playing   180
Ellipse tool   81

using to draw shapes with variable line
widths   84

Emphasizing information
using animation   160
using autojumps   162
using color   120
using highlighting   158
using multimedia effects   3
using QuickTime movies   170
using slide layers   156
using sound effects   164, 166

Endcaps
tools for editing   83
transferring between platforms   150

Entering
chart data   96
text in the outline   16, 64

EPS graphics
displaying on-screen   78
importing   78, 135, 137
proofing   206
transferring between platforms   150

Eraser annotation tool   194–195
Exiting slide shows   186
Expanding outlines   70

"Export" dialog
   box   141–143, 187, 208
Export file

creating   208
"Export…" command   141, 187, 208
Exporting

a slide show as a Player
   file   184, 187, 197
advantages of   135
note pages   143
outlines   141
PICT images   208
Scrapbook images   208
slides   134, 142

Extensions, turning off when
   installing   4
Eyedropper tool in Adobe Chart   102

Features, new for Persuasion 3.0   2
File extensions for Windows Player files

.ppf   187, 190

.psl   196
File formats

conversion examples   78
EPS   78
for importing outline text   62
for Player files   187
OLE-linked   78
Photo CD   78
PICT   78

File-compression software   204
Files

converting from earlier versions
of Persuasion   10

Player, creating   187
saving 3.0 files as earlier versions   11
sending to film recorder

by creating an export file   208
directly   208

transferring between Macintosh and
Windows   150

"Fill background" command on color
   palette   121



INDEX 221

Fill button on color palette   90
Fill patterns, printing   204
Fills

applying to objects   121
background, assigning   34
copying between chart objects   103
gradient, applying to chart
   objects   105

Film recorder
listing in the Chooser   15
required slide dimensions for   204
sending files to

by creating an export file   208
directly   208

specifying device in Chooser   205
using to make 35mm slides   204

"First sound effect" command   39, 157
"First visual effect" command   39, 69
Flow of text, changing direction of   58
Font size, selecting from text palette   50
Font popup menu   51
Fonts

proofing for 35mm slides   206
selecting from text palette   50
transferring between platforms   150

Foot (unit) marks, displaying   51
Footnotes in charts, specifying   96
"Format outline…" command   71
Formats

converting between   203
text, defining   54–55

Formatting
charts   100
note master   74
outlines for printing and viewing   71
presentations   40–45
slides   28
text   50

attributes retained when
   importing   140

Frame, QuickTime movie   171
Frame sequences of QuickTime movies,

changing   176
Freeform shape, reshaping   82

Freeform tool   81
using to draw shapes with variable line

widths   84
Full-screen display of Player files   188

"Gallery…" command   26
Gradient fills, applying to chart
   objects   105
"GradLn35" AutoTemplate   42
"GradLnOH" AutoTemplate   42
"GradLnSC" AutoTemplate   42
Graph. See Adobe Chart
Graphics

adding to a slide   17
adding to charts   104
animating   160
arcs   82
assigning to a slide layer   157
choosing a file format   78
converting to Persuasion format   79
creating in Persuasion   81
duplicating   85
EPS   78

proofing   206
transferring between platforms   150

file formats for importing   78
freeform   82
grouping   86
importing   78, 136

color issues   124
repositioning   137
resizing   137

modifying
complex   86
imported   78

moving
imported   78
several   86

offsetting   85
OLE-embedded   144
OLE-linked   78
Photo CD images   78, 136

PICT   78
proofing   206
transferring between platforms   151

polygons   82
proofing

on 35mm slides   206
using a desktop printer   206

resizing
imported   78
several   86

subscribing to   135
Windows Metafile   78, 151
working with several at once   86

"Graphics…" command   17
Graphing tool. See Chart tool
Graphs, creating. See also Adobe Chart
Grayscale color system   129
Grid lines   92
Group command   86
Grouping objects   86
Guides   92
"Guides" command   34

Handout master   72
defining contents   76

"Handout master" command   76
Handouts

creating   76
print options   202
printing   76

Handouts print option   76
Hardware

needed to run Persuasion 3.0   4
needed to run the Player   184

Heading icon in outline   66
Headings

indicating when importing text   140
moving in the outline   66–67
selecting in the outline   67

Hidden graphics   86
"Hide big PICTs" command   78
Hiding slide layers   156
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Hierarchy, creating in organization
charts   108

Highlighting layered
   information   158–159
HLS color model   124
Hotspot

for autojumping   162
recognizing position of   162

HSV color model   124

Images, Photo CD
importing   137
previewing   137

"Import" command   17, 139–
140, 168, 173

"Import data…" command   99
import dialog box   99, 112, 139
"Import movie" dialog box   172
"Import text…" command   112
Importing

advantages of   135
data from other applications into

charts   98, 112
EPS graphics   78, 137
from other applications   134
graphics   78, 136

into Adobe Chart   104
repositioning   137
resizing   137
ungrouping   78

outlines   62
Photo CD images   136
PICT graphics   136
PICT II graphics   136
presentations   138
QuickTime movies   172
slide masters   30
text   48, 140
WMF graphics   136

Inch marks, displaying   51
Indent levels, bullet options   52
Independent text   48

"Install Files" dialog box   9
Installation options

basic   8
complete   8
custom   8

Installer/Utility, Persuasion 3. See Persua-
sion 3 Installer/Utility

Installing
AutoTemplates   9, 40
Persuasion 3.0   4, 8
preparations for   4

Interchange format
saving files in   150
for Macintosh to Windows
   transfer   152

"Interchange master selection" dialog
box   152

Inverse grayscale color system   129

Jumping automatically
between Player files   196
specifying destinations   162
to other applications   163
to Player presentations   163
to slides   163

Jumps. See Jumping automatically

"Key caps" command   52
Keyboard shortcuts   212–214

for on-screen presentations   181
for running Player presentations   192

Layer assignments. See Slide layers
"Layer delay" dialog box   164
"Layer" list box   167
Layer menu   157
Layering slides   156–159
Layers. See Slide layers
Layout grid, using   92

Leading options on text palette   51
Levels, in organization charts,
   changing   108
Lighting, how it affects color
   display   132
Line button on color palette   90
Line ends, modifying   83
Line palette   83
Line spacing, specifying   50
"Line spacing…" command   50
Line tool   81
Line weights, modifying   83–84
Lines

adjusting when transferring between
platforms   151

modifying in tables   114
tools for editing   83

"Link/No Link/Unlink" command. See
Charts, importing data

Looping a slide show   178

Macintosh
files, transferring to Windows   150
running Player on   184, 193

Magnification tool   81
Magnifying glass tool. See Magnification

tool
Manual slide advance   178

in Player presentations   186
Margins, of tables   114
Marker annotation tool   194–195
Master. See Slide masters
Master slides. See Slide masters
Master title. See Title placeholder
Master Title object. See Title placeholder
Masters

Handout   72
Note   72

Media
and presentation design   15
selecting   9, 15
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Memory (RAM)
needed to run Persuasion 3.0   4
needed to run Player files   184
recommended for running QuickTime

movies   170
Menu bar

displaying and hiding in an on-screen
presentation   181

in the Player   192
using for navigation in an on-screen

presentation   180
"Merge" command   115
Merging table cells   115
Microsoft PowerPoint, importing

presentations from   138
Microsoft Word, publishing a slide
    in   146
Misspelled words, correcting   61
Modeling a slide master after another

slide   32
Modifying

AutoTemplates   45
default   43

chart components   102
complex graphics   86
like objects   86
line weights   84–86
organization charts   106
placeholders on slide masters   29

Monitors
changing slide size to match   179
displaying Player files on   188
needed to run Player files   184
showing on-screen presentations on
   different sizes   178
specifying dimensions of   178
using two to present a Player

presentation   188
variations in how they display color   132

MooV file format   170
Movie formats, considerations using

Player   184
Movie frames   171. See also QuickTime

movies

"Movie info…" command   174
"Movie information" dialog
   box   171, 174
Movies. See QuickTime movies
"Movies" command   173
Moving

headings in the outline   66, 174
multiple graphics   86
objects on and off slides   161
objects on slides   36
things in and out of a
   presentation   134–153

Multicolumn text   60
Multimedia effects, playing   3, 180
Multisided shapes, creating   82

Navigating
in a Persuasion on-screen
   presentation   180
in Player   190–193
through a presentation   180

Nesting slides under an overview
   slide   68
"New background" dialog box   34, 37
New chart dialog box   17, 95
New features for Persuasion 3.0   2–3
New slide button   16
"New slide master" dialog
   box   33–34, 37, 95, 109
"No Link/Link/Unlink" command. See

Charts, importing data
"No-fill" swatch on color palette   90
Nonprinting guides, rulers, and grid

lines   92
Note master   72

formatting   74
"Note master" command   74
Notes

adding text to   74
creating   74
exporting   143
printing   202

NTSC color system   129
Nudge palette   25, 88, 91

Object linking and embedding. See OLE
Object shadows, transferring between

platforms   150
Objects

adding color   120
aligning   32, 88
animating   161
applying a fill to   120
assigning to slide layers   156
distributing   88
grouping   86
highlighting   158
in charts applying gradient fills to   105
modifying similar   86
moving on and off slides   161
moving on slides. See "Adjust graphics"

dialog box
OLE-embedding   144
OLE-linked   78
positioning relative to each other   88
scaling

on slides   36
to fit new slide shape   31

selecting within a stack   87
stacking   86

Offset between graphics   85
OLE (object linking and
   embedding)   144
OLE badge popup menu   144
OLE badges

for charts   101
for tables   111

OLE-embedded objects
creating   144
editing   144

OLE-embedding   144
advantages of   135
an existing object   145
charts in Persuasion   94
when creating an object   145
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OLE-linked graphics   78
converting to Persuasion format   79

OLE-linking between Adobe Table and
   Persuasion   110
On-screen presentations

converting to 35mm slides   203
designing AutoTemplates for   44
preparing   178
presenting using the Player   190–192
previewing   19
printing badges for   201
running   180

Open dialog box   15, 41
"Open presentation…"
   button   15, 41, 43
Opening

Adobe Chart   94
Adobe Table   111
AutoTemplates   41
Persuasion   15

Operating system
needed to run Persuasion   4
needed to run QuickTime video
   movies   170
needed to run the Player   184

Options for printing   200
"Org chart" command   107
Organization chart

placeholders   106
slide masters   106

creating   109
Organization charts   106–109

adding to AutoTemplates   107
creating   106–107
customizing   108
highlighting   158
in outline   106
levels of   106
modifying   106–107
placeholders   28
resizing   108
transferring between platforms   150
ungrouping   106

Organization of a presentation,
   proofing   19
Orientation

of backgrounds   26, 36
of slide masters   26
of slides   36

Other applications. See Applications
Outline   62–71

adding notes to   62, 73
adjustments when transferring between

platforms   151
assigning slide masters in   69
assigning transitions in   69
collapsing   62, 70
editing   62, 66
entering text   64
expanding   70
exporting   141
formatting for printing and
   viewing   71
headings, moving   65–66
importing   62
importing text   140
moving text in   65–67
organization charts in   106
printing   201
rearranging information   66–67
selecting parts of   67
using as handouts   72
using to enter text   16
viewing   62, 65

Output
35mm slides   135, 204
designing AutoTemplates for   44
Player presentations   135
slides

for use in another application   135
to PostScript devices

importing graphics when
   using   78, 136

Output device
changing   203
selecting   15

selecting color system for   129
selecting file format for   78

Oval tool. See Ellipse tool
Overhead transparencies

color   202
converting to 35mm slides   203
designing AutoTemplates for   44
printing   202

Overlapping graphics, changing the
stacking order   87

Overview slide
creating   68
nesting slides under   68

Package movies
for an on-screen presentation   178
for Player files   187, 193

Page number placeholders   28
"Page setup" dialog box   179, 205
"Page setup…" command

45, 179, 205
PageMaker, publishing a slide in   146
Paint programs, importing graphics

from   136
PAL color system   129
Palettes

3d view   104
color. See Color palette
in Adobe Table

table   114
text   113

line   84
nudge   25, 88, 91
SFX   104
special effects   104
text   50–51

Paragraph alignment   51
Paragraph anchoring   58
Paragraph spacing, setting using text
   palette   51
Parts of a slide   25
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Paste. See Copy and paste
"Paste special" dialog box   145
"Paste special…" command   94, 145
Pasting QuickTime movies   173
Patterns

adding to objects   120
applying color to background   120
applying color to foreground   120
creating by duplicating objects   85

Pausing
in an on-screen presentation   180
in Player presentations   191

"Personalization" dialog box   9
Perspective

changing in 3d charts   105
Persuasion

drawing in   80
hardware and software

requirements   4
installing   8–9
moving things in and out of   134–153
new features for release 3.0   2–3
opening   15
printing in   200–208
saving 3.0 files as earlier versions   11
starting   15
startup screen   42
ungrouping imported graphics   78
upgrading   6
using color in   118–132
working with imported graphics   78

Persuasion 3 Installer/Utility   8, 40
Persuasion Player   184–197

definition   184
keyboard shortcuts   192
navigating in   190–192
presentation, running   190–193
slide show speed, setting   189

"Persuasion Prefs" file   7
Persuasion startup screen   42
Persuasion support folder   42

user dictionary   61
Photo CD images

adjusting depth of   136
adjusting resolution of   136

importing   78, 136
rotating   136
viewing   137

PICT graphics   78, 136
and OLE-embedding   144
converting to Persuasion format   79
importing   135, 137
proofing   206
transferring between platforms
   150–153

PICT II graphics   78
importing   136

"Pictures" command   104
"Placeholder prompt text"   95
Placeholder prompt text   16, 28
Placeholders

adding to slide masters   28
adjustments when transferring between

platforms   151
anchors on, changing   58–59
animating   160
assigning to slide masters   29, 35
body text   28

making tables in   60
changing

color of   29
text attributes   29

chart   28, 95
copying   29
entering text in   48–49
highlighting   158
on handout master   73
on note master   73
on slide masters

adding text to   28, 49
modifying   29

organization chart   106
overriding style with text formats   54
page number   28
repositioning   29
resizing   29
text   49
title   28
using to format slides   28

Platforms, transferring
   between   3, 150–153
"Play" (movie) command   174
Play sequence, of sounds

editing   169
Playbar, for QuickTime movies   175
Player. See Persuasion Player
Player files

annotating   194
changing settings for   188
creating   186
definition   186
file format for   187
jumping to automatically   162, 196
naming   187
previewing   186, 188
running   190–193
running multiple   196
setting the speed of   189
setting up jumps to   197
settings for running   186
testing   188

Player presentations
controlling the speed of   189
pausing in   186, 191
preparing   190–193
restarting   186
running   190–193

on two monitors   188
Point size option on text palette   51
Pointer tool   81
Points on graphics   82
Polygon

creating   82
reshaping   82
tool   81

using to draw shapes with variable line
widths   84

Portable presentations   184–197
Portrait slides   34, 36
Positioning objects

relative to one another   88
using a layout grid   92
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publishing   147
running on-screen   180
save reminder   18
saving   18

as an AutoTemplate   41
setting up   15
slide   26–28
steps in developing   14–18
transferring

from Macintosh to Windows   152
from Windows to Macintosh   153

"Preview current slide" command
159, 161

Previewing
an on-screen presentation   19
special effects   178

Previewing QuickTime movies   174
Print dialog box   201, 207, 209
"Print…" command   207, 209
Printers

black-and-white
using to print overheads   202
using to proof graphics   207

color
for overheads   202

desktop
using to proof 35mm slides   206
using to proof graphics   206

selecting using the Chooser   205
Printing   200–208

35mm slides   208
a PostScript file   209
badges   201
cover pages for an outline   201
fill patterns   204
handouts   76
notes   202
overheads   202
overview   200
presentation title on outline
   pages   201
slides with background fills   201
test slides   206

thumbnails on handouts   76
transparencies   202

Processor
needed to run Persuasion   4
needed to run QuickTime video
   movies   170
needed to run the Player   184

Progressive disclosure slide. See Layering
slides; "Autolayer…" command;
Highlighting layered information

Promoting a text level on the outline   65
Prompt text   49

in placeholders   26
Proof print   129
Proofing

35mm slides   205
color   206
fonts   206
graphics   206
on a desktop printer   206
text   206

design   38
organization   19
presentation   18
presentation content   19
text flow   206
using test slides   206
using the slide sorter   38

psl file extension   196
Publish and Subscribe in Adobe
   Chart   98
"Publish" command   147
"Publisher to" dialog box   148
Publishing

a slide   149
to other applications   134, 146

advantages of   135
Publishing file   146

Poster frame
for QuickTime movies

designating   174
setting   175

PostScript file, creating   208
PostScript file format. See Encapsulated

PostScript file format
PostScript interpreters   208
PostScript slide output   204
PowerBook, setting up Player files
   for   188
PowerPoint. See Microsoft PowerPoint
PowerPoint viewer. See Persuasion Player
ppf file extension   187, 190
PrecisionColor Calibrator   132
"Preferences…" command   78
Preparing 35mm slides   204–208
Presentation agenda, showing on an
   overview slide   68
Presentation design

proofing   18
relative to output device   15

"Presentation setup" dialog
   box   15, 41, 45, 179, 205
Presentations

adding speaker notes   72
changing slide masters   27
converting to 35mm format   203
created using the Player   184–197
creating an edition file from   148
creating efficiently   24
creating supplemental material for   72
designing   40–45
editing using the slide sorter   38
formatting   40–45
importing from other applications

138
moving to Persuasion from other

applications   135
navigating through   180
portable   184–197
previewing   178

as Player files   186
printing   200–208
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QuickTime movie badge
menu commands   171

QuickTime movies   170–177
advancing   175
changing frame sequences of   176
controls, turning on and off   174
copying   173
editing   174
frames   191
importing   172
in Player files   186, 190–197
packaging   187
parts of   171
pasting   173
playbar   175

turning on and off   174
poster frame for, setting   175
previewing   174
recommended configuration for   170
selecting a sequence to create a new

movie   177
sequence of play   170
sequences, removing   177
sound-only   168

displaying on a different
   computer   178

transferring between platforms   150
using to preview Photo CD
    images   137

Quitting a slide show   186, 192

Radius PrecisionColor Calibrator   132
RasterOps Calibrator   132
"Re-create from slide…" command   33
Re-orienting slides   36
Rearranging slides using the slide
   sorter   38
Rectangle tool. See Square-corner tool
"Redraw" command   101
"Regroup" command   86
Rehearsing a slide show   178

Removing
backgrounds   27
earlier versions of Persuasion   6
slide masters   27

Renaming
backgrounds   27
slide masters   27

Repetitive patterns, creating   85
Replacing

color schemes   126
color systems   130
default AutoTemplates   43
one slide master   31
slide masters   30

Replacing color system edits"
   command   130
Repositioning

imported graphics   137
placeholders   29

"Reshape" command   82
Resizing

charts   100
imported graphics   137
placeholders   29
text in charts   103

Resolution, of 35mm slides   204
Restarting

Player presentations   186
"Restore original size" command   174
Reversing data series or groups   101
RGB color model   124
"Roll credits" animation   161
Rounded-corner tool   81
Row margins in tables   115
Rows, in charts   96
Rule tool   81

using to draw shapes with variable line
widths   84

Ruler on text placeholders. See Text ruler
"Ruler units" command   92
Rulers   92
Rules   83
"Run Show" command. See "Slide

show" command

Running
an on-screen presentation   180
multiple Player files   196
Player presentations   188, 190–193

Running an on-screen presentation   180

Save as dialog box   11, 179
"Save Reminder" command   18
Saving

a presentation   18
files for 35mm output   204
presentations as AutoTemplates   41

Scaling
object text when converting presenta-

tions   203
objects on slides   36
to fit new slide shapes   31
when changing slide orientation   36

Scanned images, importing   136
Scans, adding to charts   104
Scrapbook format, importing presenta-

tions in   138
Screen display for Player files   188
"Select all" command   86
"Select options to be installed"
   dialog box   9
Selecting like objects   86
Selection tool. See Pointer tool
"Send" command   87
Sequence, movie frame. See QuickTime

movies
Serial number

finding and recording   4
when upgrading   6

Service provider
slide   204
using to produce 35mm slides   205

"Set layer" command   157
Set name…" command   174
"Set poster frame" command   174–175
"Set slide background fill" dialog
   box   34
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"Settings" dialog box   189
SFX palette   102–105
Shadow button on color palette   90
Shadow offset, changing   91
"Shadow offset..." command   91
Shadows

applying to a text block   91
applying to an object   90
applying to text   91
changing offset of   91
moving   91
tools for   90
transferring between platforms   150

Sharing information with other applica-
tions   135

Shortcuts, keyboard   212–214
for on-screen presentations   181

"Show all slides…" command   187
"Show guides" command   34
Show notes icon   75
"Show playbar" command   174–176
"Show poster frame" command   174
Show-list file, creating   196
Sketches, adding to Player files   195
Slide advance options in Player   186
"Slide background fill…" command   35
Slide dimensions

changing   36
for film recorders   204

Slide divider icon, in outline   64
"Slide Draw Delay…" command. See

Slide layers; Transition effects; "Slide
show" command

Slide layers
applying transition effects to   165
assigning graphics to   157
assigning text to   157
displaying all   181
displaying text on   158
exporting   187
hiding   156
highlighting information on   158
how to use   156–159
jumping to automatically   162

moving between in Player   191
removing in Player files   187
setting sound transition effects
   for   167
transition effects for   156, 164, 166

"Slide master" command   26, 33–
34, 37, 95

Slide masters
adding   30

one   31
placeholders to   29

adjustments when transferring between
platforms   151

assigning   39
backgrounds to   22, 26, 35
placeholders to   28, 35

assigning in the outline   62
chart   26

creating   95
creating

a copy of   34
from a slide   30–33
from scratch   34

importing from other
   presentations   30
modeling from a slide   32
modifying   26, 34
new

assigning to a slide   27
creating   34–35
displaying   26

new, assigning to a slide   69
organization chart   106, 109
removing   27
renaming   27
replacing   30

one   31
text   26

formatting   50
title   26
using to create a slide   32

Slide order, proofing   18
Slide presentations   24–28

created using Player   184–197

Slide service bureaus   204
Adobe Authorized   204
preparing files for   204–208
requirements of   204

Slide shapes
and output devices   44
converting   203

Slide show
ending   178
exiting   181

"Slide show" command
161, 165, 187

"Slide show" dialog box   178, 186
"Slide show" file, used to preview Photo

CD images   137
Slide show file format

for Player files   187
Slide show mode

Automatic   178
Manual   178

Slide sorter
assigning slide masters in   31
copying slides in   31
using to edit presentations   38

"Slide sorter" command   31
Slide thumbnails

on handouts   72, 76
on speaker notes   72

Slide titles, viewing in outline   62
Slides

adding charts to   17, 94
adding graphics to   17
adding to a presentation   16
applying transition effects to   165
assigning backgrounds to   26
composition of   22
copying from another
   presentation   39
entering text   16, 48
exporting   142
formatting   28
importing text to   140
jumping between automatically   162
layering   156–159
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names of slide elements   24
nesting under an overview slide   68
parts of   25
printing with background fills   201
publishing   146
rearranging using the slide sorter   38
setting sound transition effects
   for   167
size, changing   179
text   50
transition effects for   164, 166
using to create a slide master   32
viewing using slide sorter   38

"Snap to Grid" command   92
Software, requirements for
    Persuasion 3.0   4
"Sound effect" popup menu   167
"Sound on" command   174
Sounds

adding to slide presentations   164
importing from other
   applications   135
play sequence, editing   169
transferring between platforms   150

"Sounds…" command   168
Space-separated (Ssv) data format   98
Speaker notes

adding to outline   62
creating   74

Special characters   52
Special effects

in charts   104
in Player presentations   186
previewing   178

Special effects palette   104
Speed of Player presentations   189
Spell checker. See "Spelling…" command
"Spelling" dialog box   61
Spelling dictionaries, replacing when
   upgrading   6
"Spelling…" command   61
Spreadsheets, subscribing to in
   Persuasion   135
Square, drawing   81

Square-corner tool
using to draw shapes with variable line

widths   84
Ssv format   98
Stacked objects

changing stacking order of   87
selecting   87

Stacking ungrouped objects   86
Stand-alone show. See Persuasion Player
Standard color system   129
Starting an on-screen presentation   180
Startup screen   15, 42
Stopping a presentation   180
Storyboard, creating using Handout
    master   76
Stylesheets. See Text formats
"Subscribe to…" command   99, 147
"Subscriber to" dialog box   148
Subscribing

to an edition   98, 147
to files from other
  applications   135, 146

advantages of   135
Subscribing file   146

updating   149
Subselecting an object in a complex

graphic   86
Subtitles, adding to slides   62, 64
Supplemental material, creating   72
Support folder   7
Symbols, changing color of   53
System 7.0 sounds   168
Systems, color. See Color systems

Tab-separated (Tsv) data format   98
Table badge   111
Table columns

aligning using the text ruler   60
"Table format" dialog box   110
"Table format…" command   111
Table palette   114
Table tool   111

Tables   110–114
applying color to   114
borders, changing   114
bringing in from other
   applications   112
converting from earlier versions of
   Persuasion   10
creating   111

on slides   60
dimensions of   110
features   3
importing data   112
lines, modifying   114
margins, changing   114
merging cells   115
parts of   110
sizing   110
text in, modifying   113

Tabs on text ruler, using to create
   tables   60
Tall slides, creating   36
Templates. See also AutoTemplates;
   Masters
Test slides, using to proof 35mm slides

206
Testing Player files on-site   188
Text

adding to a slide   16, 48
adding to note pages   74
adding to placeholders on slide
   masters   28
adjusting for new slide dimensions   34
aligning   51
animating   160
applying color to   121
assigning slide layers to   156
assigning to a slide layer   157
editing in the outline   62
entering

in placeholders   48–49
in the outline   16, 48, 64
outside placeholders   48–49

format for importing   140
formatting   48, 50, 55
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highlighting and dimming   158
importing   140

to outline   140
in charts

modifying   102
resizing   103

in tables, modifying   113
independent   48
multicolumn   60
placeholder prompt text   49
proofing

on 35mm slides   206
special characters   52

Text attributes
defining using placeholders   28

"Text autolayer" dialog box   158
Text blocks

applying color to   121
assigning attributes   54
highlighting   158
manipulating   48

Text button on color palette   90
Text files, importing as tables   112
Text flow

controlling direction using anchor
points   58–59

proofing for 35mm slides   206
"Text format" dialog box   113
"Text format…" command   113
Text formats

applying   55
defining   54–55
editing   55
using on several slide masters   54

Text justification   51
Text page. See Outline
Text palette   51

in Adobe Chart   102, 113
Text placeholders. See Body text

placeholders
Text ruler   49

hiding   49
on text placeholders   49
using tabs to create text columns   60

Text tool   81
Thumbnails

on handouts   72
on speaker notes   72
printing on handouts   76
viewing   26

TIFF graphics, transferring between
Macintosh and Windows   151

Timing of Player presentations   189
Title object. See Title placeholder
Title placeholders   28
Titles

in charts, specifying   96
on slides   26

Tool palette   25
Tools

chart   102
drawing   81

arc   81
ellipse   81
freeform   81
line   81
pointer   81
polygon   81
rounded-corner   81
square-corner   81

for applying shadows   90
for editing lines and endcaps   83
for working in Adobe Chart   102–103
magnification   81
pointer   81
table   111
text   81

Tool palette   144
Transferring between platforms

adjustments in presentations  150–153
Macintosh to Windows   151–153
methods   135
Windows to Macintosh   151, 153

Transition effects
assigning in the outline   62
assigning in the slide sorter   39
for slides and slide layers   156,
   164–166

sound
applying to slides and slide layers

167–168
transferring between platforms   150

Transitions
assigning in the outline   69

"Transitions" dialog box   169
for sound effects   166–169
for visual effects   164

"Transitions…" command   165, 169
Transparencies

printing   202
Tsv data format   98
Type styles options on text palette   51
Typographer's quotes   51

"Ungroup" command   79
Ungrouping

imported graphics   78
organization charts   106

"Unlink/Link/No Link" command. See
Charts, importing data

Updating the subscriber   149
Upgrading to Persuasion 3.0   4, 6
"Use typographer's quotes"
   command   51
User dictionary (user1)   61
User1 user dictionary   61

Variable line weights   84
Version, of Persuasion

converting from 3.0 to earlier   11
converting from earlier to 3.0   10

Vertical information, displaying using tall
slides   36

Video display, of QuickTime movies
turning on and off   174

Video movies. See QuickTime movies
"Video on" command   174
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Viewing
only slide titles   62
slides in the slide sorter   31
thumbnails   26, 31

Viewing angle of 3d charts,
  changing   105
Virus-protection utilities, turning off when

installing   4
Visual effect menu   164–166
Visual effects   164
Volume, of QuickTime movies,
   controlling   175

Wide slide orientation   26, 36
Width

of organization chart boxes,
   modifying   109
of table cells   110
of table lines, changing   115

Window display of Player files   188
Windows

files, transferring to Macintosh   150
running Player in   184, 193

Windows Metafile file format   78
WMF graphics

importing   137
Word-processing files

exporting elements to   141
importing to the outline   62, 135
sharing information with   135

Working palette. See Working set
Working set

adding colors to
from the color scheme   122
from the color spectrum   122

creating   122
renaming colors on   122
when to use   119

Working with imported graphics   78

Zero point on layout grid   92
Zoom in/out buttons. See Magnification

tool
Zooming   81


